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1 Introduction XE "Introduction" 
1.1 Purpose XE "Purpose"  
The purpose of this document is to provide NUMI users with a comprehensive overview of the application, as well as navigation steps for using the various features of each screen. Throughout the guide are tips and additional information for the reader. This information appears in gray highlighted text with the [image: image2.png]


 icon. 
1.2 Scope XE "Scope"  
This document represents a guided tour of the NUMI application. Users are presented with step-by-step navigation instructions and comprehensive information about the many features of the NUMI application, its options and its screens in a ‘one stop shopping’ format. This guide is organized into the following sections:

· Chapter 1: Introduction 

· Chapter 2: User Instructions 
· Chapter 3: The Patient Selection Screen
· Chapter 3 : The CERMe Screen
· Chapter 5 : The Primary Review Screen
· Chapter 5: The Physician UM Advisor Worklist
· Chapter 7: The Tools Menu

· Chapter 8: The Reports Menu

· Chapter 9: Unlocking and Deleting Reviews
· Chapter 10: Copying Reviews
· Chapter 10: The Admin Menu
· Chapter 12: Logging Out of the NUMI Application
· Chapter 13: Additional NUMI Information
· Chapter 14: The Online Help Menu
· Chapter 15: Glossary
· Appendix A: NUMI Screen Flow
· Appendix B: NUMI Tips for Success

· Appendix C: NUMI Terminology

· Appendix D: UM Admission Reason Codes

· Appendix E : UM Continued Stay Reason Codes

· Appendix F : FAQs (a list of Frequently Asked Questions about NUMI)

· Appendix G : Screens Encountered During NUMI Reviews
1.3 Target Audience XE "Target Audience"  
This guide is intended for users of different degrees of knowledge and experience with the NUMI application. It is particularly geared towards:
· VHA Utilization Management Staff

· VHA Utilization Review Staff

· NUMI Site POC/Administrators (these are UM staff members)
1.4 Overview XE "Overview" 
The National Utilization Management Integration (NUMI) application is a web-based solution that automates utilization review assessment and outcomes. The Utilization Management (UM) Process is a tool used to help ensure that patients are receiving the right care, at the right time, and in the right place. UM is both a quality and efficiency tool, as it is used to move patients efficiently through the VA system to maximize use of resources. UM reviewers assess patient admissions and hospital stay days using standardized objective evidence-based clinical criteria to determine whether patients meet criteria for acute hospital care.

The NUMI project was established to meet a specific business need. The Office of Quality and Performance (OQP) has a need to provide automation support to field Utilization Management nurses that perform reviews of clinical care activities. These reviews are considered core procedures to support both quality improvement and business/compliance functions central to VA’s mission. National UM policy includes review of all admissions and all hospital bed days of care, with a mandate that all review information be entered into the NUMI application.
The NUMI application standardizes UM review methodology and documentation at the facility level and creates a national VHA utilization information database. In NUMI, patient movement data is obtained from read-only VistA access to pre-populate a patient stay database, eliminating redundancy and errors from manually re-entering patient data.  A Commercial Off-the-Shelf (COTS) product, McKesson Care Enhanced Review Management Enterprise (CERME), is integrated into NUMI to provide access to the InterQual® standardized clinical appropriateness criteria and algorithms. The CERME functionality is used to determine whether patient admissions and hospital days meet clinical appropriateness criteria for acute care hospital care. The national NUMI database is built in SQL and will enable facility, VISN, and national reporting of UM review outcomes.
The NUMI system provides critical functionality to help UM reviewers to organize UM review workload, document UM review outcomes, and generate reports to help identify system constraints and barriers to providing the appropriate services at the appropriate level of care. NUMI users can perform the following functions:

· Pre-populate patient stay information from VistA into a NUMI SQL database which records patient stay information. UM review outcomes, reasons, and recommended levels of care are saved in the NUMI database

· Generate a list of patient admissions and hospital days that need to be reviewed to assist UM reviewers in organizing their workload
· For newly admitted patients, collect patient and treatment information to determine whether patients meet clinical criteria for inpatient admission

· Following admission, collect treatment information for each hospital day to determine whether patients meet continued stay criteria
· Standardize documentation of a) reasons for inpatient admissions or continued stays that do not meet clinical criteria for inpatient care, and b) recommended levels of care for admissions and continued stay days not meeting criteria
· Provide  Physician UM Advisors with an automated UM review list to access reviews, document agreement or disagreement with current levels of care, and add comments and recommendations regarding patients not meeting criteria
· Generate summary reports of UM outcomes to provide insight into system constraints and barriers and identify quality improvement opportunities

· Assign specific reason codes for reviews that do not meet criteria. The VA-specific reason code structure will enable UM staff to aggregate and analyze the most prevalent reasons why patients are not meeting criteria at their current level of care.  This information provides insight to help identify quality and access improvement opportunities.
· Display a list of patient stays and review information, with filters and search features to assist in organizing individual reviewer workloads
The importance of implementing a national automated Utilization Management Program is specifically addressed in The Office of Inspector General (OIG) Report:  Healthcare Inspection:  Evaluation of Quality Management, Veterans Health Administration (VHA) Facilities Fiscal Year 2006 (Project No. 2006-00014-HI-0003, WebCIMS 371342).  NUMI was developed to address the Utilization Management data needs of the VHA and to provide the UM staff with a web-based solution for capturing patient information in compliance with VHA Directive 2005-040 (Utilization Management Policy). 
2 User Instructions XE "User Instructions" 
Once you have been authorized to use the NUMI application and have completed NUMI training, at the end of the training session you will be given the NUMI URL address. This chapter discusses some things to consider before you login for the first time. Subsequent chapters (please see the breakdown in Section 1.2) will explain the NUMI screens and provide step-by-step navigation instructions for using the various features. Note: if you are unable to change the settings on your computer, please contact your local IRM support team for assistance.  Tips to help you make the most out of using the NUMI application can be found in Appendix B.
2.1 Getting Started XE "Getting Started" 
2.1.1 Allowing Pop-Ups XE "Allowing Pop-Ups"  for the Site 
The NUMI application uses pop-up windows, so it is important that your computer is set up to allow for these.  If your computer currently has a pop-up blocker, this must be disabled in order to use NUMI effectively. (Symptoms you may see that indicate pop-ups are blocked may include: a pop-up blocker bar displaying and indicating pop-ups are blocked; the CERMe screen doesn’t open properly; clicking on a review hyperlink in a reviews table doesn’t display the review screen). If you do not have permission to change your pop-up blocker settings, please contact your local IRM for assistance. If you do have permission, here is how to double check your pop-up window settings: 

1. Open a new browser (if you have several browser windows open, close all but one).

2. Select Tools>Pop-Up Blocker>Turn Off Pop-up Blocker. (Figure 1) Note: if the pop up blocker is turned off, Steps 3 and 4 are irrelevant. In order to execute those steps,  select Tools>Pop Up Blocker>Pop Up Blocker Settings and then you can proceed to Step 3).
3. When the Pop Up Blocker Settings screen displays, type the address of the web site into the Address of Web site to allow field. 
4. Click the <Add> button.

5. Click <Close> to exit the screen. 
6. To apply the changes you just made, close your browser and then reopen it. 
[image: image3.emf]
Figure 1: Pop-up Blocker Settings

2.1.2 Making NUMI a Trusted Site XE "Making NUMI a Trusted Site" 
1. From your internet browser, select Tools>Internet Options
2. Click the Security tab. 
3. Click on Trusted Sites. 
4. Type in the NUMI URL. (The URL will be provided to you after you have completed NUMI training).
5. Click the Apply button.

6. Click the OK button.
2.1.3 Enabling 3rd Party Browsing Extensions XE "Enabling 3rd Party Browsing Extensions" 
You will need to ensure that the ‘Enable 3rd Party Browsing Extensions’ Internet Option on your browser is selected. 

1. Select Tools/Internet Options

2. Click on Advanced Tab. 

3. Look for 'Enable third-party browser extensions*' under Browsing. 

4. Click the checkbox if it is not already checked. (Figure 2)
5. Click the Apply button. 

6. Click the OK button.

7. Close the browser and reopen it to apply the change.

[image: image4.emf]
Figure 2: Enable third-party browser extensions
2.1.4 Allowing ActiveX Controls XE "Allowing ActiveX Controls"  for the Site
If you need to install ActiveX controls you will see the message bar: “This site might require the following ActiveX control:” right below the address line of your browser window. Follow these steps to install ActiveX controls:
1. Click on the message bar to reveal the dropdown menu. 
2. Click on “Install ActiveX Control”.  (Figure 3)
3. When the Security Warning window displays, as illustrated in Figure 4, click the <Install> button. Note: You will only need to install ActiveX controls once.
[image: image5.emf]
Figure 3: Install ActiveX Control dropdown
[image: image6.emf]
Figure 4: Internet Explorer Security Warning window

2.1.5 Setting your screen resolution XE "Setting your screen resolution"  to 1024 x 768 or higher 
To minimize the need for scrolling while doing your reviews, the recommended screen solution when using NUMI is 1024 x 768. The screen resolution is changed on the Settings screen. Here are some different ways to navigate to the Setting screen:

8. From your desktop, select Start>Control Panel>Display>Settings OR

9. From your desktop, select Start>Control Panel>Appearances & Themes>Display>Settings OR

10. From your desktop, right-click and select Properties>Settings.

11. Click and drag the Screen Resolution bar to 1024x768 or higher. (Figure 5)
12. Click the <OK> button.
[image: image7.png]


  Depending on which operating system your computer uses, your Settings screen may look different than Figure 5.  

[image: image8.emf]
Figure 5: Screen Resolution settings

2.1.6 Making Sure you have a VistA Account

You must have a VistA account in order to login to NUMI. If you are using CPRS, you already have an active VistA account. Your IRM contact at your facility will be able to assist with VistA account issues, or your NUMI POC may be able to help.  (Please see Section 2.1.10 for more information about finding out who the NUMI POC at your facility is). Once you have a VistA account, your access to sites within NUMI will be set up by a NUMI Administrator. (If you will have multi-site access in NUMI, please be aware that the access is completely independent from access to other applications at other facilities including: CPRS, VistA and VistAWeb. Please follow your usual procedure for requesting access to applications outside of NUMI).
2.1.7 Setting up your Internet Browser XE "Setting up your Internet Browser" 
Make sure that the browser you are using is Internet Explorer 6.0 or higher. This is the only browser that will let you access the NUMI application. If you do not have it installed on your computer, please contact your local IRM support team for assistance.
2.1.8 Creating a NUMI Icon on your Desktop XE "Creating a NUMI Icon on your Desktop" 
It is highly recommended that you create an icon for the NUMI application on your desktop so that you can access it quickly.

To create a desktop icon for NUMI
You can create an icon for NUMI using the Create Shortcut Wizard. Just follow these steps:

13. Right-click on your desktop and select <New>.
14. Select <Shortcut>.

15. The Create Shortcut Wizard window will open, as shown in Figure 6.
16. Type the NUMI URL address into the Type the location of the item field. Click the <Next> button.

17. The Select a Title for the Program window will open, as shown in Figure 7.

18. Enter a name for the shortcut in the Type a name for this shortcut field.

19. Click the <Finish> button. 

20. The wizard will close and the icon you just created will appear on your desktop. You should now be able to access NUMI by double-clicking on the icon, or by right-clicking it and selecting the “Open” option.
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Figure 6: Create Shortcut Wizard with NUMI URL
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Figure 7: Select a Title for the Program window

2.1.9 Launching NUMI from your Internet Browser XE "Launching NUMI from your Internet Browser" 
In addition to being able to access NUMI through an icon on your desktop, you can also launch the application via your internet browser.

To launch NUMI using your internet browser 

21. Open your internet browser.

22. Type the NUMI URL into your browser’s address line.

23. Press the <Enter> key on your keyboard and the Select VISN, then Site screen will display.

[image: image11.png]


 You can have other VistA applications and NUMI open at the same time. Please note, however, that NUMI will not follow the active patient in other applications such as CPRS, and vice versa. So please be sure you are looking at the same patient for whom you are performing a review. 
[image: image12.png]


  After launching NUMI for the first time, it is recommended that you add the site to your list of browser Favorites.
[image: image13.png]


  NUMI uses a secured website, identified by the prefix https:// in your browser’s address line. It is likely you will see a dialog box similar to the one illustrated in Figure 8 the first time you use the site. If you do, click the <Yes> button to proceed.
[image: image14.emf]
Figure 8: Windows Security Alert dialog box

2.1.10 Locating your NUMI Point of Contact (POC) XE "NUMI Point of Contact (POC)" 
As mentioned earlier in this chapter, you will be given the URL to the NUMI application after you have completed NUMI training. You will also be given information about your NUMI Facility Site POC/Administrator. That individual is a member of the UM staff and should be contacted if you need assistance while using the NUMI application. (Note: the NUMI POC/Administrator is not the same as an IRM representative. The NUMI POC/Administrator  manages the NUMI account, while IRM takes care of VistA and other software and hardware issues). Additional NUMI assistance may be found through NUMI Online Help. To access that, click the Help dropdown (located at the top of all main NUMI screens) and select the User Guide option.  
2.1.11 Using NUMI Search Filters XE "Search Filters" 
Many NUMI screens offer a variety of filters that you can use to search for patients and other information. You can select multiple filters if you wish to refine your search to a more detailed level. Here are general instructions for using filters: 

1. First, activate the filter you wish to use by clicking on the checkbox in the filter header. Then…

2. If the filter is for a beginning and ending date range (e.g.,  Reminder Date), or for other date fields such as Admission, Discharge, or Review, choose a date by clicking on the calendar icon, or by manually typing a date in. When manually typing a date in, be sure to use the format mm/dd/yyyy.

3. If the filter is for a Dropdown box, choose an option from the dropdown by clicking on it.

4. If the filter is for List of items, single click on an item in the list. In some cases you may be able to control-click to select or deselect multiple independent items, or shift-click to select a range of items. This will depend on the particular field.

5. If the filter is for a Text Entry field, type the information you wish to search for into the text entry field. The format in which you can enter data in these fields will depend on the field.

6. If the filter contains other checkboxes, click on one or more checkboxes.

7. If the filter contains radio buttons you may select one of the options. 

8. In most cases, at the bottom of the filter bank you will need to click the <Find> button to see any changes in the information that is displayed – although in some cases the page will be updated immediately.

Note: After performing a search (on the Patient Selection screen), if you click on the <Reset> button, your filter selections will be cleared and when the screen is re-loaded, the Reminder Date checkbox will once again be selected and display default information. For more information about NUMI filters, see Section 3.1.
2.1.12 Using NUMI Hyperlinks XE "Hyperlinks" 
NUMI offers a variety of hyperlinks
 that will quickly redirect you to other screens and information. Hyperlinks can be found in NUMI data displayed in table format. Some tables will be closed when the screen first displays, and must be opened (e.g.,  the Show Reviews button on the History screen will open the Reviews table). Here are general instructions for using hyperlinks:
24. While viewing a table, click on the hyperlink beside the desired patient or information. For example, clicking on this hyperlink would automatically take you to the Patient Selection screen  [image: image15.png]indows Internet Explorer
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25. The link will take you to another location in the NUMI application.  (e.g.,  clicking on a Review hyperlink in the Patient Selection table will take you to the History screen).

26. Depending on the hyperlink, it may perform different functions depending on the status of a patient or review, and on your privileges.

2.1.13 Sorting Information XE "Sorting Information"  in NUMI Tables

NUMI offers the ability to sort information in the tables on the application. The sort only applies to the currently displayed page. If the content of the page is changed by resetting the page size or clicking the Next, Previous, Last Page or First Page hyperlinks, the sort will need to be re-done. Here are general instructions for using the sort feature:
27. Click on an underscored column header in the table (e.g.,  Patient Name on the Patient Selection screen).

28. The screen will refresh and the information will be sorted in ascending order.

29. Click on the header again to refresh the screen and change the display to descending order.

2.1.14 Using NUMI Buttons XE "Buttons" 
NUMI displays a series of buttons that, when clicked, will display additional information. Here are the different ways in which clicking a button feature works:
30. Takes you to another screen (e.g.,  the Export To Excel button on any of the report screens opens the report in the Excel application).

31. Displays a pop-up window (the Patient Worksheet button on the History screen opens a window containing Stay information for a patient).
32. Displays informational text (e.g.,  the Notes icon button [image: image16.emf]  on the CERMe screen displays read-only InterQual® Notes information).

33. Expands and Collapses fields (e.g.,  the + and – Stay ‘toggle’ buttons on the Primary Review screen expand and collapse the list of Stay Reasons).
2.1.14.1 Using NUMI Radio Buttons XE "Using NUMI Radio Buttons" 
Some NUMI screens contain ‘radio’ buttons. [image: image17.emf]. Here are general instructions for using those:

34. Click on the desired radio button to select that option.

2.1.15 Using NUMI Screen ‘Tabs’ XE "Screen ‘Tabs’" 
Some NUMI screens contain tabs [image: image18.emf]  that, when clicked, will take you to other NUMI screens. Certain buttons may be grayed out, depending on which screen you are working on. Here are general instructions for using tabs:
35. While on a screen that displays tabs (e.g.,  the History screen), click on a tab.

36. You will be redirected to the screen that the tab corresponds to. 

2.1.16 NUMI Menus XE "Menus" 
NUMI provides menus which are accessible from the major NUMI screens. These menus provide access to various features of the NUMI application. 

2.1.16.1 Admin Menu

The Admin Menu is only available to NUMI Administrator users. Non-administrator users will not see this menu option on the UI. If Administrator users have problems using this menu or its features, validate that their profile indicates they have the appropriate access privileges. Please see Chapter 10 for more information about this menu.

2.1.16.2 Reports Menu

The Reports Menu is available to all NUMI users. These reports are generated on-demand. All reports generate in Portrait orientation by default, except those marked (L), which generate in Landscape orientation. Please see Chapter 8 for more information about this menu.

2.1.16.3 Tools Menu

The Tools Menu is accessible to all NUMI users. However, the accessibility of certain options is based on individual access privileges. Please see Chapter 7 for more information about this menu.

2.1.16.4 Help Menu

Online help for NUMI functionality consists of a Help Menu option on the major NUMI screens. The only option under this menu is User Guide. Selecting the option redirects users to the main Office of Quality and Performance (OQP) web page, where they will have hyperlinked access to view the latest version of the NUMI User Guide. Please see Chapter 14 for more information about this menu.

2.1.17 Using Screen ‘Bars’ XE "Screen ‘Bars’" 
Some NUMI screens contain gold-colored bars [image: image19.emf] that, when clicked, will display or hide the information in the NUMI tables on that screen. Here are general instructions for using bars:

1. While on a screen that displays bars (e.g.,  History screen), click on a bar.

2. The corresponding table for that bar will either display or be hidden, depending on whether the “Show” or “Hide” bar was selected.

2.1.17.1 Using Sidebars XE "Sidebars" 
Some screens contain sidebars. The sidebar on the CERMe screen in NUMI (as shown in Figure 9) is a good example of one. A sidebar is an auxiliary box of information, appearing next to the main information on a screen that may contain functional rows or items that can be clicked or selected. 
[image: image20.emf]
Figure 9: Sidebar
2.1.17.2 Using Scrollbars XE "Scrollbars" 
Throughout the NUMI application, you will find scrollbars. (Figure 10 shows an image of the scrollbar that appears on the right hand side of the CERMe screen). A scrollbar is a long rectangular area containing a bar that can be dragged to scroll up, down, left or right. Depending on the screen, the scrollbar can be horizontal or vertical.  

[image: image21.emf]
Figure 10: Scrollbar

2.1.18 Printing NUMI Reports XE "Printing NUMI Reports" 
After generating a report, right-click on the report and the Print option will be displayed in a small menu. Click <Print> to print out a hardcopy report on your local printer. Detailed information about generating and printing reports can be found in Chapter 8.  Note: information can also be printed out from the Review Selection screen. The Print Preview button on the Review Selection screen works the same way that it does for reports. See Section 7.2.1 for more information.
2.1.19 Exporting NUMI Reports XE "Exporting NUMI Reports"  to an Excel Spreadsheet
All NUMI reports have an Export to Excel feature. After generating a report request, click the <Export to Excel> button to export the report to an Excel spreadsheet format. Use Excel’s print feature to print the spreadsheet out. Detailed information about generating and exporting reports can be found in Chapter 8. Note: information can also be exported to Excel from the Review Selection screen. The Export to Excel button on the Review Selection screen works the same way that it does for reports. See Section 7.2.2 for more information.
[image: image22.png]


  While working in NUMI, if you use the BACK button on your browser instead of one of the screen tabs (shown in Section 2.1.15) or the Tools menu, you may get an error message. Always navigate around NUMI using the tabs or the Tools menu and you will avoid error messages and delays.
2.1.20 Using NUMI Dropdown Boxes XE "Dropdown Boxes" 
Some NUMI screens display dropdown boxes that contain selectable options, similar to this example: [image: image23.emf]    To choose an option from a dropdown, click on the down arrow to display the list of options. Select the desired option by clicking on it.  

2.1.21 Using NUMI Paging Features XE "Using NUMI Paging Features" 
The Patient Selection, Dismissed Patient Selection and Review Selection screens contain paging features that allow you to navigate thru lists of information in the tables. When these screens first open and you use NUMI’s filters (see Section 2.1.11) to search for information, the results table will display the first 30 rows of results. You can navigate thru each screen of results by selecting the Next, Last Page, Previous and First Page pagination hyperlinks. If you wish to see more than 30 rows of results at a time, just type in a different value and click the reset page size button. As long as the screen remains open, the system will continue to display the number of rows in the result table that you specified. However, once you close the screen and reopen it, your search results will once again display the first 30 rows of results. The sections below explain how to use each paging feature. 
2.1.21.1 Using the Next and Previous Page Paging Features

When you open a screen that contains paging features, Next and Last Page hyperlinks will display within the table grid. If you are already on the first page, you will not see a Previous link. Likewise, if you are already on the last page, you will not see a Next link. (Figure 11 illustrates the screen with all paging links displayed).  
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Figure 11: NUMI Paging Hyperlinks
To use the Next and Previous Page features

1. From any page but the last page, click the Next hyperlink.

2. The next page of results will display and a Previous hyperlink will become visible at the top and bottom of the table. 

3. Click the Previous hyperlink
4. The previous page of results will display.

2.1.21.2 Using the First and Last Page Paging Features

If you are already on the first page, the First Page link will be grayed out. Likewise, if you are already on the last page, the Last Page link will be grayed out.

To use the First Page and Last Page features

1. From any page but the first page, click the First Page hyperlink.

2. The first page of results will display. OR

3. Click the Last Page hyperlink.

4. The last page of results will display.

2.1.21.3 Using the Row Results Display Paging Feature 

To specify how many result rows you want to see in the table

1. Type the number of result rows you want to see in the Page Size field. (Note: the default is 30)

2. Click the <Reset Page size> button.
3. The screen will refresh and display the number of rows you specified for each page in the table, and the total number of pages in the listing will change according to the change size you specified.
2.1.22 Adobe Flash Player (for CERME 2011)
CERME 2011 InterQual® criteria are loaded into NUMI. CERME 2011 requires the use of a Flash Player and expects that your desktop has Flash Player installed. (It is likely that you already have Flash Player installed, because it is part of the standard desktop package for VA employees. If you are not certain whether you have Flash Player, please contact your local IRM representative or your NUMI POC for assistance). If your desktop does not have Flash Player, a  reminder screen will display when you try to access CERME, as illustrated in Figure 12.  This message cannot be disabled, as it is part of the McKesson CERME 2011 core package. Just click the OK button to close this message and proceed into CERME to complete your review.  (Flash Player is used for a CERME insurance screen that NUMI does not utilize, so you will be able to use CERME without a problem). 
[image: image25.emf]
Figure 12: Adobe Flash Player Dialog Box

2.2 SELECT VISN, THEN SITE Screen XE "SELECT VISN, THEN SITE Screen" 
This chapter describes the Select VISN, then Site screen. This screen is considered the ‘start page’, and is the first of two screens in the login process. (Figure 13) This is where you will choose a specific VISN and Site. The features of this screen are listed in Table 1.
Table 1: Select VISN, then Site screen features

	FEATURES

	Select VISN

	Select Site


[image: image26.emf]
Figure 13: Select VISN, then Site
2.2.1 Selecting VISN and Site XE "Selecting VISN and Site" 
To select VISN and Site information

37. Click on the Select VISN dropdown. Choose a VISN from the list by clicking on it.  NOTE: Depending on your UM role, you may have access to several sites.  However, you must always log onto NUMI using your home VISN and the facility associated with your VistA Access and Verify Codes. After you are logged into NUMI with your home location, you can then select a different site. XE "Select Site" 
38. Click the Select Site dropdown. Choose a Site from the list by clicking on it.
39. Click the <Submit> button and the Access NUMI System screen will display. 

[image: image27.png]


  If VISN and/or Site information is not selected from the dropdowns, you will see the messages: “Please select a VISN” and/or “Please select your hospital site”.
2.3 ACCESS NUMI SYSTEM - Login Screen XE "Login Screen" 
This chapter describes the Access NUMI System screen. (Figure 14) This screen displays a welcome message, and you will be able to provide your VistA Access and Verify Codes and login to the NUMI application. The features of this screen are listed in Table 2.

Table 2: Access NUMI System screen features

	FEATURES

	Login to NUMI with VistA Access and Verify Codes

	Update Network Account Name

	Hide / Show Welcome Message

	Switch Login Site


[image: image28.emf]
Figure 14: Access NUMI System
2.3.1 Entering Access and Verify Codes XE "Access and Verify Codes" 
As with other VistA applications, you must enter a valid Access Code and Verify Code in order to login to NUMI.
To enter your Access and Verify Codes and login to NUMI
40. Type your VistA Access Code into the Access Code field and press the <Tab> key on your keyboard.
41. Type your VistA Verify Code into the Verify Code field.
42. Click the <Access NUMI System> button and the Patient Selection screen will display. 

[image: image29.png]


  If you enter an invalid Access or Verify Code, the messages “You must enter a valid access code” or “You must enter a valid verify code” will display.
[image: image30.png]


  If you receive an error message like this one: “This account does not exist in NUMI”, ask your local NUMI POC/Administrator to set up a NUMI profile for you.
[image: image31.png]


  The maximum number of login attempts permitted is determined by the local VistA. If you exceed the maximum number, VistA will lock you out of the application for 20 minutes. You may see an error message similar to this: “Unable to login to VistA. The error was: Device IP address is locked due to too many invalid signon attempts”. After 20 minutes, VistA will clear your login restriction and you can try to login again.  
[image: image32.png]


Occasionally, after you’ve entered your correct Access and Verify Codes you may see an error message similar to the one shown in Figure 15.  If this happens, close down your Internet browser and restart the login process. Doing this resets your browser and you will then be able to log in successfully.

[image: image33.emf]
Figure 15: VistA Login Error Message
2.3.1.1 How your login credentials are authenticated XE "How your login credentials are authenticated" 
When you login to NUMI, your NUMI credentials will be compared against your Windows credentials.  (Note: the purpose of this comparison is to control the new Enhanced Reporting content - not to authenticate your access to the NUMI application.  For more information about Enhanced Reporting, please see Section 8.13). 

The system authenticates and tracks users when communication to the system is first established. You must prove your identity to the NUMI web site by supplying a valid VistA Access and Verify Code combination in order to establish this communication. Rather than passing your confidential credentials back and forth with each transaction, the system generates a unique "Session ID" (i.e.,  Windows session credentials) to identify your session as authenticated. Subsequent communication between you and the web site will be tagged with the Session ID as "proof" of the authenticated session. 
For example, when you visit a retailer’s website you want to collect articles in a ‘shopping cart’ and then go to the checkout page to place your order. A Session ID enables the system to keep track of your cart’s status. 
There are 3 possible credential comparison scenarios:

The Login Credentials Match

If your NUMI login credentials match your Windows credentials, you will be logged in without  seeing any dialog or pop-up boxes. 

The Login Credentials are Blank

If your NUMI login credentials are blank (e.g.,  new NUMI user), the system will apply the current credentials you are using and proceed with logging you in. 

The Login Credentials do not Match

When you login to NUMI, if your Windows credentials do not match the credentials saved in NUMI, you will see a Security Warning message similar to the one illustrated in Figure 16. (One reason for a credential mismatch would be if you logged in to NUMI from someone else’s computer). You will be given the opportunity to either update your network account name or logout of NUMI and log back in using your own credentials, as described in Section 2.3.2.
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Figure 16: Login Security Warning
2.3.2 Updating Your Network Account Name (at Login) XE "Updating Your Network Account Name (at Login)" 
If you wish to update your network account name
1. With the Security Warning message displayed, click on the Update My Network Account name in NUMI hyperlink.
2. The system will update your network account name in the NUMIUser table. This update will not be visible to you.
3. The Patient Selection screen will display.

If you wish to logout without updating your network account name

1. With the Security Warning message displayed, click on the Logout hyperlink.

2. The system will not update your network account name in the NUMIUser table and you will be logged out. You will then able to login to NUMI as you normally would, using your own credentials.

If you wish to continue on without updating your network account name

1. With the Security Warning message dispayed, click on the Click here to continue to the Patient Selection screen hyperlink.

2. The Patient Selection screen will display.
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  Hovering your mouse pointer over the hyperlinked text on the Security Warning screen will display handy tooltips.

2.3.3 Hiding / Showing the Welcome Message XE "Welcome Message" 
As a convenience, NUMI gives you the option to cosmetically hide the Welcome Message on the login screen.

To hide/show the Welcome Message
43. Click the gold <Click to hide Welcome Message> bar at the top of the screen.
44. The message will be hidden and the text display on the bar will change to <Click to view Welcome Message>.  

45. Click it to redisplay the Welcome Message.  
2.3.4 Switching the Login Site XE "Switching the Login Site" 
After you login, NUMI gives you an option to change your VISN and/or Site dropdown selections (and view information for other sites that you are permitted to look at), at the click of a hyperlink. This feature is handy in a situation where you accidentally chose a VISN or Site dropdown item, but meant to choose something else.    

To switch to a different Login Site
46. Click on the Switch Login Site hyperlink on the Select VISN, then Site screen. 
47. The screen will be refreshed, and you can choose another VISN and/or Site before clicking the <Access NUMI System> button and logging in.
3 PATIENT SELECTION Screen (Worklist) XE "PATIENT SELECTION Screen (Work List)" 
This chapter describes the Patient Selection screen worklist. (Figure 20) This is the first screen that will appear after you successfully complete the login process. The top section of the screen will show a drop-down list of sites to which you have access. This screen is where UM Reviewers will search for patient stays, select patients for review, assign and reassign reviewers, and view patient information for different sites (if they have permission to visit multiple sites).  The features of this screen are listed in Table 3.
When the screen first opens you will see the search filters, but no patient data rows will automatically display. You will see instructions for using the filters to obtain search results, as shown in Figure 20, and the Date filter will be pre-selected and pre-populated with a 34-day default date range. (You may click the <Find> button to display the last 34 days of stays in the table, or enter different or additional filtering criteria, then click the <Find> button. Results will be displayed in the format illustrated in Figure 21.  Search criteria that is different from the default criteria will not remain effective, once you leave the Patient Selection screen and return to it.   To select a patient for review, click on their hyperlinked name. (The Review hyperlink and column have been removed from the screen). The <Find> and <Reset> buttons have been moved to the righthand side of the screen.
The table will display an “X” column, and clicking any boxes in the column will flag those stays for dismissal. The Patient Selection screen has been enhanced with functionality that lets you distinguish dismissed stays for patients in non-reviewable specialties. Please see Section 3.2.1 for more information.

The table also will display an “M” column, which contains the last movement type synchronized with VistA. The paging functions will display in the table and offer the ability to navigate to Next, Previous, First Page and Last Page and limit the number of rows that display in the table. (see Section 2.1.21 for more information on pagination). 
The system now maintains the sort order for the patient stays listed on the Patient Selection worklist. The sort order will remain continuous across all pages. 

· Links: When an active link is selected (e.g.,  a Patient Name hyperlink is clicked) and you leave the Patient Selection worklist and then return to it, the original sort order will be retained and you will be returned to the original page display of the worklist (i.e.,  Page 1)

· Other Pages in NUMI: When you leave the Patient Selection screen to view another screen, link or report (e.g.,  the Report menu is clicked) and you return to the Patient Selection screen, the sort order will be retained on the worklist and you will be returned to the first page displayed in the worklist (i.e.,  Page 1)
· Pagination: When the filter selections are made and displayed on the worklist and multiple pages exist, you will still be able to click on the First Page, Next, Previous and Last Page hyperlinks to navigate thru the results. After navigating to different pages in the worklist, when you return to the first page (i.e.,  Page 1) the sort order will be retained and displayed
Depending on how refined your search is, it may take a few seconds for the bottom part of this screen to load, showing the patient stays for the site. Please be patient to allow this screen to load completely before changing sites or clicking on filters.  

IMPORTANT: Each row in the patient selection table represents a patient/admission. The patient stay row will have several information fields including admit date, discharge date, date of last review, whether that review met criteria, and reviewer. All patient stays will remain on the patient selection list (even after discharge) until stays are dismissed from this active patient stay list. To make it easier to see the individual rows in the table, the background of each row alternates in color between white and shaded. The table will also show you last Specialty, Ward and Attending for each patient. 
The Patient Selection worklist has been enhanced to display information in each row on one line only. If the text in a field exceeds a predetermined length, the displayed text field will be truncated and end with an ellipsis (“…”). This indicates that there is additional text that is not displayed. When you hover your mouse pointer over a field with an ellipsis, the full text will display as depicted in Figure 17. 
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Figure 17: Truncated Text Example
NUMI obtains Admissions, Ward transfers, and Discharge movements from VistA on an hourly basis during the daytime (i.e.,  at the top of each hour) and resynchronizes other movements at Midnight (local time) each night. Therefore, it is possible that some stays may not be in NUMI yet, or have not been updated yet. Reviewers may also see stays that have Transfers and Discharges, even though they have not had a chance to do an Admission review yet. After the midnight synchronizer information feed occurs, stays that were dismissed the previous day will not display again in the worklist.
Stays will be updated by the synchronizer when it detects that a stay has changed. This includes stays that have been dismissed or that have had continuing stay reminders set by the reviewer. (The purpose of this is to alert a reviewer that there has been a movement. Whether or not it is of sufficient clinical significance to warrant a review before the scheduled reminder is at the discretion of the reviewer). There will be one line per patient on the Patient Selection screen until the reviews are done and the stay is dismissed, unless the patient has been admitted more than once and reviews are needed for multiple admissions/stays.
For situations where a patient is not in the NUMI database and needs to be loaded manually, please see Section 7.6, which describes how to use the Sync With VistA feature to manually synchronize information from VistA into the NUMI Patient Selection worklist.
The NUMI system detects:
· Case 1: Stays deleted in VistA but still in NUMI  

When a stay is invalidated - meaning it is not in VistA but is still in NUMI - and the stay is selected for review, the system will move it to the Dismissed Patient Select screen and the Patient Stay Admin screen.  If you select the stay from the Dismissed Patient Select screen it will not be restored and moved back to Patient Selection screen. It will only be restored if the stay was an unintentional dismissal by a NUMI reviewer.
For the Case 1 scenario, this is the message that will display when a user selects a stay that has been deleted in VistA but is still in NUMI: “The patient stay you have selected appears to have been deleted from VistA.  Stay ID: <stay number> Patient Name: <patient name>. This patient stay has been moved to the Dismissed Patient Selection and Patient Stay Admin screens”. (Note: if you wish to delete the stay from NUMI, a NUMI Administrator will need to perform that activity from the Patient Stay Admin screen. Please see Section 7.7 for more information).
· Case 2: Stays not retrieved from VistA for one of the 3 reasons below. Should you get one of these messages, you may need to contact your local IRM to find out if there is a problem with VistA connectivity or local network issues.
· MDWS timed out before it returned the stays from VistA
· MDWS service is unavailable
· MDWS could not connect to VistA because the VistA node is unavailable
For the Case 2 scenario, this is the message that will display if MDWS times out before returning stays from VistA:  “Stay <stay number> for patient <patient name> cannot be retrieved from VistA as the server is busy at this time. Please try again”.
For the Case 2 scenario, this is the message that will display if the MDWS service is unavailable:  “An error has occurred. The MDWS service is unavailable at this time. The error has been recorded and tech support has been notified. We apologize for the inconvenience and will fix the error as soon as possible”. 

For the Case 2 scenario, this is the message that will display if the VistA node is unavailable:  “An error has occurred. The <site name> VistA node is unavailable at this time. The error has been recorded and tech support has been notified. We apologize for the inconvenience and will fix the error as soon as possible”. 
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  While working on the screen, you may see a message in red text advising there was a problem loading the webpage (Figure 18). Refreshing your browser will reload the webpage and display the NUMI screen.   

[image: image38.emf]
Figure 18: Page load error message
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 If a patient stay has been dismissed, please use the Dismissed Patient Stay screen to find the stay. (See Section 7.7 for more information). Dismissed stays will not appear on the Patient Selection screen, even if they meet other criteria.
[image: image40.png]


  When search results display on the Patient Selection screen, locked reviews will display a blue Patient Name hyperlink, while reviews that have been unlocked for editing will display a red Patient Name hyperlink. If a locked review is unlocked for editing, the blue link will turn red. Similarly, if a review that was unlocked for editing is save/locked back to the database, the red link will turn blue.  Figure 19 depicts these colorized links. 
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Figure 19: Patient Selection screen colorized hyperlinks
Table 3: Patient Selection Worklist Features

	FEATURES

	Use Filters and Paging Features

	Dismiss a Reminder for a Patient Stay

	Select a Patient for Review

	View Patient Information for Different Sites

	Assign/Reassign Reviewers to Patient Stays

	Distinguish Stay Dismissals
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Figure 20: Patient Selection screen with 34-day default
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Figure 21: Patient Selection screen with search results
3.1 Using Filters and Paging Features XE "Filters" 
NUMI offers filters and paging features (see Section 2.1.21) so you can navigate thru the list of patients quickly and conveniently.  Additionally, all columns in the list can be sorted in ascending or descending order by clicking on the column headers. 
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  The filters on NUMI screens are additive. This means you can select several filters in order to get very specific search results. After performing a search, if you click on the <Reset> button, your filter selections will be cleared and when the screen is re-loaded the  Reminder Date checkbox selected and default information redisplayed. While additive filters can be helpful if you need to, for example, look at a specific set of Reminder Dates for a specific Ward in a specific Date range, it is possible to create such precise (and even mutually exclusive) criteria that no records will be found in NUMI. This is something to be aware of when using multiple filters. For more information about using NUMI filters, please see Section 2.1.11.
3.1.1 Finding patients using the Reminder Date filter XE "Reminder Date filter" 
As mentioned in the screen introduction above, when the Patient Selection screen first opens the Reminder Date checkbox will be pre-selected, as will the Start Date and End Date checkboxes, and a 34 day range will be pre-populated, as illustrated in Figure 20. The default Start and End dates will always appear as the last 34 days, but each time they appear on the screen, you can edit them as desired.  (See Section 5.11 for more information about Review Reminder Dates). Use this filter to search for patients based on review reminder dates. 
To find patients by reminder date 
48. Click on the Reminder Date checkbox to activate the filter, if it is not already selected.  (Figure 22) 

49. Click on the Start Date checkbox.

50. Click in the Start Date textbox and type the desired Start Date in mm/dd/yyyy format, or scroll through the calendar and click the desired Start Date in the calendar. 
51. Click on the End Date checkbox.

52. Click in the End Date textbox and type the desired End Date in mm/dd/yyyy format, or scroll through the calendar and click the desired End Date in the calendar.
53. Click the <Find> button. A list of patients for the date range you specified will display. The results will include all movement types (e.g.,  Admissions, Discharges, etc).
[image: image45.emf]
Figure 22: Reminder Date filter
3.1.2 Finding patients using the Ward filter
Use this filter (Figure 23) to search for patients by specific Ward location.
[image: image46.emf]
Figure 23: Ward filter
To find patients by single Ward
54. Click the Ward checkbox to activate the filter.

55. Click on the desired Ward.
56. Click the <Find> button.
To find patients by multiple Wards
57. Click the Ward checkbox to activate the filter.

58. Click on the first Ward. Press and hold the <Ctrl> key down on your keyboard and click on the other Wards you are interested in. You may also press and hold the <Shift> key down and select a block of Wards, or click <All> to choose all Wards.
59. Click the <Find> button.
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  There may be instances where you may expect to see a particular ward in the Ward dropdown, but it does not display. Ward lists are populated as movements for those wards occur. For example, a patient you are looking for has been in a bed for awhile and has not had any movements. While you cannot manually add a ward to the dropdown, you can use the Sync With VistA feature (see Section 7.6 for more information) to search for a patient that you know is in a particular ward. Once their information has been synchronized and pulled into NUMI, that ward will display in the Wards dropdown.
3.1.3 Finding patients using the Patient Search filter
The Patient Search selection filter is illustrated in Figure 24. NUMI uses VistA’s search capabilities to look for a patient. A list of possible matches will be shown in the lower window. The reviewer selects one of those patients and NUMI searches its database to see if there are any stays for that site/selection combination. Use this filter to search for patients by Name or Social Security Number. 
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  Because twins and other patients can have the same or similar names, it is strongly recommended that you search for patients using their full Social Security Number. This will confirm the identity of the patient. 
[image: image49.emf]
Figure 24: Patient Search filter
To find patients by Full SSN

60. Click the Patient Search checkbox to activate the filter.

61. Type the patient’s full SSN in the Find Patient field (in xxx-xx-xxxx OR xxxxxxxxx format).

62. Click the <Find Patient> button.

63. When the patient whose SSN matches your search criteria displays in the result window, click on the patient’s name and the stays stored in NUMI for that patient will be displayed in the table, unless they have been dismissed. Dismissed stays can be found on the Dismissed Patient Select screen. (See Section 7.3 for more information).
To find patients by Last Name
64. Click the Patient Search checkbox to activate the filter.

65. Type the patient’s Last Name in the Find Patient field. (You can further refine your search by entering the patient’s First and Last Name). 
66. Click the <Find Patient> button.
67. When the list of patients displays in the result window, click on a patient name and their information will be populated in the table on the screen. 
To find patients by First Letter of Last Name and Last four digits of the patient SSN
68. Click the Patient Search checkbox to activate the filter.

69. Type the first initial of the patient’s last name, followed by the last 4 digits of their SSN (e.g.,  W0000) in the Find Patient field.
70. Click the <Find Patient> button and the patient information will display in a table. Finding patients this way may initially bring back a list of names because this lookup method is not necessarily unique.
3.1.4 Filtering by Movement
Use this filter (Figure 25) to search for patients by Movement type. This refers to any movement that the patient has undergone while at the hospital and includes Admissions, Continued Stays, Discharges and Transfers.
To filter by Movement Type

71. Click on the Movement checkbox to activate the filter (this checkbox refers to the “M” column on the Patient Selection screen).
72. Click on the desired Movement checkboxes.

73. Click the <Find> button.
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Figure 25: Movement filter
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  If you click the Movement filter  but you don’t select any movement types, NUMI will not retrieve anything because it won’t know which types of movements to include when it does the search.
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  Note: If you wish to find missing hospital admission review records (i.e.,  stays with no reviews) you can either sort by the Date of Last Review column, or search by selecting the “Unassigned” option in the Reviewer filter dropdown". 
3.1.5 Filtering by Service or Treating Specialty
Use this filter to search for patients by a particular Service or Treating Specialty, or a combination of both (e.g.,  Service = Medicine and Treating Specialty = NHCU [ECU]). You may also search for patients that have no specified Treating Specialty.
To filter by Service or Treating Specialty
74. Click on the Treating Specialty and Service checkbox to activate the filter (Figure 26).

75. Select options from the Treating Specialty window by clicking on them, then click the <Find> button.  OR

76. Click the <All> option, then <Find>,  to search by all Treating Specialties). OR

77. Click the <None Listed> option (as shown in Figure 27), then <Find>, to search for patients that have no Treating Specialty specified. 
78. Select options from the Service dropdown by clicking on them.

79. Click the <Find> button.
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Figure 26: Service or Treating Specialty filter
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Figure 27: Treating Specialty filter with "None Listed" option selected
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  To select multiple specialty dropdown options, click on the first option, then press and hold the Ctrl key down on your keyboard and click on the other options you are interested in. You may also press and hold the Shift key down and select a block of options.
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  If you want to filter by a specific Treating Specialty only, select the specialty but leave the Service filter set to “All”, and vice versa.  For example, if you choose a Psychiatry Service and a General Surgery Treating Specialty, you will probably not get any results back.   

3.1.6 Filtering by Reviewer 
When the reviewer checkbox is selected, the Patient Selection screen will populate the reviewer filter with the current user’s login name in the Reviewer drop-down section of the screen.  

But you can use this filter to search for patients by another specific reviewer name, by ‘all’ reviewers, or by reviews that do not have a reviewer assigned to them..  
To filter by Reviewer

80. Click on the Reviewer checkbox to activate the filter. 
81. Select the defaulted reviewer name (example shown in Figure 28), and click the <Find> button. OR

82. Select another reviewer in the dropdown by clicking on their name, and click <Find>.  OR

83. Click on <Unassigned> in the dropdown (Figure 29), and then <Find>, to view only stays that have not been assigned to a reviewer. 
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Figure 28: Reviewer filter
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Figure 29: Reviewer filter with Unassigned option selected
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  To select multiple reviewer dropdown options, click on the first option, then press and hold the Ctrl key down on your keyboard and click on the other options you are interested in. You may also press and hold the Shift key down and select a block of options.
3.1.7 Reset Button

After obtaining search results on the Patient Selection screen, when you click on the Reset button the system will restore all fields to their default values.  The fields and default values are:
· Reminder Date – Checkbox selected and defaults with a 34-day range  

· Reviewer – Checkbox not selected and will display the logged in user’s name  

· Ward – Checkbox not selected and defaults to All

· Treating Specialty and Service – Checkbox not selected and defaults to All

· Movement – Checkbox not selected and no default values display

· Patient Search – Checkbox not selected and no default values display

3.2 Dismissing a Patient Stay XE "Dismissing a Patient Stay"  
Use this feature to dismiss a patient stay movement. When you dismiss a stay from the Patient Selection screen, it will move to the Dismissed Patient Selection screen under the Tools menu. (This screen is described in more detail in Section 7.3). It is important to note that only the selected stay movement will be dismissed, however, the entry of a new movement or discharge in VistA will refresh the patient’s entry again on the Patient Selection screen with updated information. The system will now let you distinguish patient stay dismissal types.  Having this ability will assist with reporting and identifying patients in non-reviewable specialties. This is explained in Section 3.2.1. 
NUMI / VSSC Processes XE "NUMI / VSSC Processes" 
NUMI will automatically place stays that have treating specialties with the following text strings into the Dismissed Patient Stay list.  The text strings are: OBS (Observation), DOM (Domiciliary), NH (Nursing Home), OUTPATIENT, REHAB. 

NUMI moves the stay types mentioned above to the Dismissed Patient Stay list, except if the patient stay includes a Treating Specialty change from or to reviewable and non-reviewable specialties. If so, nothing would be filtered out for the stay.

This process happens once every 24 hours at 4:30am ET and looks at the previous 24 hours of data. 

Scenario #1:

The job runs on Tuesday at 4:30am ET: Patient was admitted to OBS ward Tuesday at 12:30am ET – if any NUMI users are on the system Tuesday between 12:30am ET and 4:30am ET they will see the patient stay on the Patient Selection screen until the job runs. NUMI users who do not log in until after 4:30am ET on Tuesday will never see the patient stay on the Patient Selection screen. 

Scenario #2:

The job runs on a Tuesday at 4:30am ET. A patient is admitted to an OBS ward Tuesday at 7:00am ET.  Users will see the patient on the Patient Selection screen until 4:30am ET Wednesday 
NUMI transmits/sends everything except the above to VSSC. 

VSSC receives NUMI data and does its own additional screening. VSSC does a daily update at 5:00am ET and reports should be refreshed by 9:30am ET. Users accessing VSSC reports will not see the data from the previous day until after 9:30am ET. (The date through which the report contains NUMI Review data is noted on the report header). As the NUMI data is received by VSSC, VSSC does additional screening. It screens out the following: 

· Patients with acute admission but no discharge or movement in 10 days (these are excluded as potentially invalid admissions)
· Stays that are less than 12 hours

· Wards whose names contain OB, GEM, REHAB MED
· Discharge dates and any reviews for discharge dates

· Treating Specialties whose names contain AMB, OUT, LAB, OBS, PROC, GEM, CWT
· Transaction Type is blank

· Non-Acute Treating Specialties

· The following Acute Treating Specialties:

· (18) NEUROLOGY OBSERVATION

· (20) REHABILITATION MEDICINE

· (23) SPINAL CORD INJURY OBSERVATION

· (32) GEM INTERMEDIATE CARE

· (35) GEM REHABILITATION MEDICINE

· (36) BLIND REHAB OBSERVATION

· (40) INTERMEDIATE MEDICINE

· (41) REHAB MEDICINE OBSERVATION

·  (24) MEDICAL OBSERVATION

· (65) SURGICAL OBSERVATION

· (78) ANESTHESIOLOGY

· (81) GEM NURSING HOME

· (94) PSYCHIATRIC OBSERVATION

· (95) NH SHORT STAY SKILLED CARE

·  (1A) SHORT STAY GRECC NHCU

·  (1C) SHORT STAY GRECC-GEM-NHCU

· (1D) GRECC-GEM-REHAB

· (1J) ED OBSERVATION

· (1N) POLYTRAUMA REHAB UNIT

A data management process flow for the UM Review Process for NUMI / VSSC is illustrated in Figure 30. 
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Figure 30: Data Mgmt for UM Review Process - NUMI / VSSC

There are several reasons that you may wish to dismiss a patient stay:

· A patient stay is in a treating specialty that does not require review (i.e.,  Observation, Domiciliary, Nursing Home, Outpatient, or Rehab) and automatic dismissal isn’t catching them due to naming conventions. (It is important to note that the nightly screening job does not screen out stays where the treating specialty has changed).
· A patient has been discharged and has all reviews for their stay entered in NUMI.

· A patient is not going to be reviewed in NUMI. Perhaps you are not reviewing 100% of patients yet, and the patient is not in your review sample.

· A patient’s admission was cancelled (invalidated) in VistA.  For example, perhaps a patient was admitted to acute care. The actual stay was very short, and the written admission orders are cancelled and the stay is reclassified in VistA.  When the reviewer selects the patient stay for review, they would see a message indicating that the stay for the patient cannot be retrieved because it may be invalid. (This is not an error, but an occurrence in clinical decision making with change of status of a patient). Note: It is advisable to check CPRS and/or VistA to confirm that a stay has changed or has been deleted, before deleting it from NUMI because the invalid stay message can appear if NUMI cannot connect to VistA and find the stay, even if it is still there. It may be important to compare the exact date/timestamps of the patient movements to determine if NUMI matches VistA, or if something was changed in VistA.
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  Each evening, Treating Specialties that are not reviewable in NUMI will automatically be marked “inactive” and moved to the Dismissed Patient Stay screen after the information is sent to NUMI from VistA. (“Inactivated” stays will not appear on the Patient Selection screen unless a review is performed on them).  To identify stays that are not reviewable, the system looks for one of the following in the Treating Specialty description: OBS, DOM, NH, OUTPATIENT, REHAB. The system then sets the stays to ‘dismissed’ and moves them to the Dismissed Patient Stay screen. This is a scheduled job that will run daily. As the synchronizer runs throughout the day, there is a chance for additional non-reviewable specialties to appear in NUMI.
You can generate a report showing all patient stays that have been dismissed. (This report is also discussed in Section 7.3). 

If you dismiss a patient stay in error, you can retrieve that patient and get them to reappear on the Patient Selection screen by going to the Dismissed Patient Selection screen, locating the patient stay, and performing a review. 

3.2.1 Dismissing/Distinguishing Stays XE "Dismissing/Distinguishing Stays" 
To dismiss / distinguish a stay
1. Perform a search for patients using the desired filters.

2. When the results display the <Dismiss Stays> button and Dismiss Type dropdown will both be enabled. (Figure 31)
3. Click the checkbox in the X column in the far left hand column beside the name of the patient stay you wish to dismiss, as illustrated in Figure 32.  (Note: if you hover your mouse over the X this tool tip will display: “Use the checkboxes to select stays to be dismissed”).
4. Click on the Dismiss Type dropdown and select an option by clicking on it. You may choose  Dismiss Non Reviewable Treating Specialty or Dismiss No Further Reviews. (If you select multiple checkboxes, whatever Dismiss Type dropdown option you choose will be applied all checked stays. If you wish to categorize the stays individually, select a single checkbox and then choose the desired Dismiss Type option).
5. Click on the <Dismiss Stays> button next to the dropdown. If you hover your mouse over the Dismiss Stays button, this tool tip will display: “Click this button to dismiss selected stays with the selected Dismiss Type”. 

6. The stay you chose will be dismissed and moved to the Dismissed Patient Stay screen with the reason you selected. 
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  If you click the Dismiss Stay button without selecting an option from the dropdown first you will see a message in red text advising you to select a Dismiss Type.  (Figure 34)
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Figure 31: Dismiss Type dropdown / Dismiss Stays button
To change the Dismiss Type

If you select an option from the Dismiss Type dropdown (Section 3.2.1, Step 6) and dismiss the stay, and you wish to go back and change the dismiss type to something else, you can do that by following these steps. 

1. Navigate to the Dismissed Patient Stay screen.

2. Click the hyperlinked patient name for the stay you wish to make the change to.

3. Perform a review on the patient.

4. Navigate to the Patient Selection screen.

5. Perform a search for the patient.

6. When the patient displays in the results, click the “x” checkbox beside their name.

7. Click on the Dismiss Type dropdown and select the new value.

8. Click the <Dismiss Stays> button.

9. The stay will be dismissed with the new Dismiss Type value.
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Figure 32: Selected Dismiss Stay option
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Figure 33: Enabled Dismiss Type and Dismiss Stays features
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Figure 34: Select Dismiss Type advisory message
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 Only a checked patient stay row is dismissed. It will reappear if there is another movement for the patient or a new hospital admission, to make UM reviewers aware of new admissions and continued stays requiring reviews.   
3.3 Selecting Patients for Review XE "Selecting Patients for Review" 
3.3.1 Selecting a Patient from the Patient Movements List

Use this feature to select a patient stay to enter a review.

To select a patient movement for review
84. Conduct a search for patients using the desired filters. 

85. When the results display in the table, click on a hyperlinked name in the Patient Name column in the worklist. (Figure 35)
86. The History screen will display. (Figure 40)
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Figure 35: Hyperlinked Patient Name
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  If you select a stay and the record no longer exists in VistA (it has been invalidated), a dialogue box will open and display the message: “Stay <stay number> for patient <patient name> can not be retrieved from VistA and may be invalid. Please choose a different stay.” Click the <OK> button and select another stay. This warning may occur because an invalid patient admission was entered into VistA, and the record was deleted from the hospital database – but not before the NUMI synchronizer came in and read the information. See Section 13.15 for more information about admission feeds from VistA to NUMI and Section 7.7 for more information about reviews that are in NUMI but the associated stay can no longer be found in VistA.
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  When a patient is selected for review, (depending on reminder dates or dismissals and the filters used), the name will remain in the patient stay list on the Patient Selection screen and you will be able to perform a second review right away, if you wish.
3.3.2 Deceased Patients
A review may be performed for a now-deceased patient for the purpose of documenting information related to their final stay in the hospital. If you select a deceased patient from the movement list, this message will display: “Warning – Patient is Deceased! Warning! This patient is deceased as of mm/dd/yyyy. Do you wish to continue?”, along with <Continue> and <Cancel> buttons. Click the <Continue> button to proceed.  After all reviews are entered on deceased patients, don’t forget to dismiss their final hospital stay from the Patient Selection list.

3.3.3 Sensitive Patients

Sensitive patient records will display #### in the SSN column. (Note: throughout NUMI, except on the History screen, if you know a sensitive patient’s SSN you can still search for them by partial or full SSN).  If you select a sensitive patient from the movement list, this message will display: “Warning – Sensitive Patient! This record is protected by the Privacy Act of 1974 and the Health Insurance Portability and Accountability Act of 1996 (HIPAA). If you elect to proceed, you will be required to prove you have a need to know. Accessing this patient is tracked, and your station Security Officer will contact you for your justification”, along with <Continue> and <Cancel> buttons. Click the <Continue> button to proceed. Once the button is pressed, a Sensitive Patient Bulletin will be sent to the Information Security Officer at that site.
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  While on the Review Selection screen, if you select a Sensitive patient review that has been locked to the database (blue hyperlink), you will see the entire message stated in Section 3.3.3.  However, if you select a Sensitive patient review that has been unlocked for editing (red hyperlink), you will see the pop up in Figure 36. 
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Figure 36: Sensitive Patient Warning for unlocked review
3.4 Viewing Patient Information for Different Sites XE "Viewing Patient Information for Different Sites" 
You will be able to use this feature if you have permission to view patient information for different sites. Please note that you may only view patient information for one site at a time. 

3.4.1 Switching to a Different Site

To select a different site

87. Click the Current Lookup Site dropdown. (Figure 37)
88. Select a site by clicking on it.

89. Click the <Go> button to view patient information for that site.
[image: image73.emf]
Figure 37: Current Lookup Site dropdown
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  You can switch to a site where you do not have a particular set of permissions and you can still navigate to the desired web page, but you will not be able to see any patient data. For example: if you get access to a site where you do not have Primary Review rights and you navigate to the Patient Selection screen you will not see patient data there.
3.5 Assigning and Reassigning Reviewers XE "Assigning and Reassigning Reviewers"  to Patient Stays

When you select a stay from the Patient Reviews screen and complete a review on that patient, NUMI will automatically assigned this stay to you. However, NUMI gives you the flexibility to manually assign and reassign stays to yourself or to others, as described in Section 3.5.1. In prior releases of NUMI, the Update Stays button was used for assigning and reassigning reviewers. In Release 1.1.13, a new button has been added for this purpose: Assign Reviewers.
3.5.1 Assigning/Reassigning a Reviewer

To assign a reviewer to a patient stay
90. Conduct a search for patients using the desired filters.

91. Click on the Assign Reviewer dropdown for each patient stay that you wish to assign a reviewer to.

92. Select a reviewer from each dropdown by clicking on their name. (Figure 38)

93. Click the <Assign Reviewers> button. If you hover your mouse over the <Assign Reviewers> button a tooltip will display. (Figure 39)
94. The review will be assigned and the reviewer you selected will see the patient information in their worklist. 

To reassign a reviewer for a patient stay
95. Click on the Assign Reviewer dropdown for a patient that has already been assigned to a reviewer.

96. Select another reviewer from the list by clicking on their name.

97. Click the <Assign Reviewers> button, The review will be reassigned and the name of the new reviewer you selected will display in the table. 

[image: image75.emf]
Figure 38: Assign Reviewer dropdown illustration
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Figure 39: Assign Reviewers button with tooltip
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  If you complete a review on a stay, you become the assigned reviewer regardless of whether or not the review was previously assigned to someone else.
3.6 HISTORY Screen XE "HISTORY Screen" 
This chapter describes the History screen. (Figure 40) The History screen is a read-only screen that displays information from VistA, related to the most recent status of a patient’s stay in the hospital. You can view prior movements and reviews for the stay, print out a worksheet for the patient stay for use when out on rounds, and begin a review by clicking a hyperlink. Upon initial display, the CERME and Primary Review buttons are grayed out. The features on this screen are listed in Table 4. 
Table 4: History Screen Features

	FEATURES

	Show / Hide Reviews Table 

	Select Review links from Movement History Table

	View Patient Insurance Information

	Print out a Patient Worksheet


[image: image78.emf]
Figure 40: History screen

3.6.1 Table of Stay Movements and Table of Reviews
The Stay Movements table is displayed when the History screen first opens. This table cannot be hidden. The Reviews table, however, is hidden when the screen first opens. Instructions for displaying that table are described in Section 3.6.2. 
3.6.2 Showing and hiding the Table of Reviews for a patient
98. Click the gold colored <Show Reviews> bar (depicted in Figure 41) to display the table containing the patient’s reviews since they were admitted. (Figure 43) While the table is open, the text on the bar will display <Hide Reviews>. (For more information about NUMI bars, please see Section 2.1.17).
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Figure 41: History screen tabs and buttons

3.6.3 Selecting a review from the Reviews table
Patient reviews that have not been locked into the database and may be requiring further review and completion or that have been unlocked will display a Review hyperlink in the Reviews table. Clicking the hyperlink will open the Review Summary screen (Figure 42) and you can continue working on the review from there. You will also have the option to copy the review – just click the <Copy This Review> button.

Reviews that have been locked to the database will display a View hyperlink in the Reviews table. Clicking the hyperlink will open the Review Summary screen, and you can look at the review and, if desired, you can edit the review, delete the review, or copy the review and save it with another date. When you open the review, you will see <Close>, <Unlock>, <Copy This Review>, <Delete> and <Print> buttons. If the review included an admission or day that did not meet criteria, depending on the state of the review you will also see the <Unlock Phys UM Advisor Review> button. (See Section 9.2 for more information). 
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 If you View a saved review that has an Admission Review Type that is not a valid type, if you Unlock the review, when the Primary Review screen displays, no selection will display in the Admission Review Type dropdown. You will not be able to save the review until you select a valid option from the Admission Review type dropdown.  The valid dropdown options are discussed in Section 5.7.
There are some restrictions imposed when copying reviews. You are prohibited from copying a review and applying it to a different patient. You are also prohibited from copying a review and using a stay date related to a different hospital admission.
From this versatile screen you can Unlock, Delete, Print and Copy a review with the click of a button. (See Chapter 9 for more details about Unlocking and Deleting reviews, and Chapter 10 for more details about Copying reviews). 
To select a review from the Reviews table

99. Click the gold <Show Reviews> bar (illustrated in Figure 41) to display the Reviews table.

100. Click on the View or Review hyperlink for the review you want to see.

101. A separate window will open and display the Review Summary screen. (Figure 42)
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Figure 42: Review Summary screen with Unlock, Delete, Print and Copy options

3.6.4 Selecting a patient movement from the Stay Movements table
Each patient will receive one review per day. Select a patient movement from the table as a starting point for reviewing a day of a stay because the Attending, Ward, and/or Treating Specialty are already populated. Any of these aspects related to the movement, as well as the date, can be corrected later on the Primary Review screen.  (See Chapter 5 for detailed information about the Primary Review screen).  Note: the Attending Physician from VistA may need to be updated in NUMI if it has been entered inaccurately on the unit, or in Admissions. This does not update it in VistA or on the Patient Selection screen, but NUMI reports will display the corrected Attending information.
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  To get to the CERMe screen, you must click on a Review link from the Stay Movements table. The review link that you select determines the ward, treating specialty and attending physician that will be populated on the review. 

To select a patient movement from the Stay Movements table 

102. Click the Review hyperlink in the Stay Movements table for the movement you want to see. 

103. Remember that the Attending Physician, Ward, and Treating Specialty from that movement will pre-populate on the Primary Review screen.

104. The CERMe screen will display. (See Chapter 3 for information about the CERMe screen and its use in NUMI).

[image: image83.emf]
Figure 43: Patient Movements and Reviews tables
3.6.5 Viewing Patient Insurance Information

The display of patient insurance is for informational purposes only and does not impact the review process. (Insurance review data can be entered into the VistA Claims Tracking application or another facility/VISN-designated program for tracking of this information). The Insurance field will be collapsed when the History screen first opens.
To display Insurance information
105. Click the <+> button, beside the Insurance field (shown in Figure 40) and the patient’s insurance information will display. If the patient does not have insurance, a “0” will display in the field.
3.6.6 Printing out a Patient Worksheet
NUMI offers a convenient feature that allows you to print out a hardcopy worksheet with admission information for a patient, and use it to take notes to assist you in entering reviews into NUMI. This can be helpful if you like to do all your CPRS research first and then enter reviews, or if you need to take notes when out on the units. Worksheets can be valuable tools if a reviewer needs to pick up patients from another reviewer. 

To print a patient worksheet
106. Click the <Patient Worksheet> button. (shown in Figure 41)
107. A worksheet with information for the patient will display in a new window, as shown in Figure 44. Right-click and select the <Print> option to print it out on your local printer.
[image: image84.emf]
Figure 44: Patient Worksheet example
4 CERMe Application Screen XE "CERMe Application Screen"  (Care Enhancement Review Manager enterprise)
This chapter describes the CERMe screen in the NUMI application. (Figure 46)  The CERMe screen is actually the portion of McKesson CERME integrated into NUMI that automates the usage of the InterQual® criteria, to determine whether a stay meets criteria or not. With very few exceptions, everything on this screen is McKesson CERME. When the screen is first displayed, the Primary Review button will be grayed out.

[image: image85.png]


  CERME 2011 criteria are loaded and can be selected as appropriate for your reviews. The Quality Indicator Checklist and the Transition Plan screens are just for reference. No data entered on these screens will be saved in the NUMI database.  If you check any boxes on those screens and click the Continue Primary Review button to proceed to the Primary Review screen from the quality indicator checklist or the transition plan screen, you will see the error depicted in Figure 45. 
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Figure 45:Unsupported Review Type error message
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  It is important to note that the current process you follow for using CERME (e.g.,  select an InterQual® Product, Category and Subset, view criteria notes, evaluate/select criteria, etc.) based on your InterQual® training, CareEnhance Review Manager training and National Policy will remain exactly the same. 
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  CERME 2011 requires the use of a Flash Player. If you try to access the CERMe screen and you do not have Flash Player loaded on your pc desktop, you will receive a message advising that you need to have Flash Player (see Figure 12). Just click the OK button to close this message and proceed into CERME to complete your review. Please see Section 2.1.22 for more information.
When you have completed your CERME activities on this screen, just click the <Continue Primary Review> button to move on to the NUMI Primary Review screen. 
The McKesson CERME features of this screen are listed in Table 5, and the NUMI features are listed in Table 6. 
Table 5: CERMe Screen – McKesson CERME Features

	CERME FEATURES

	Find InterQual® Medical Criteria Subsets

	View InterQual® Medical Criteria Subset Notes

	Select an InterQual® Medical Criteria Subset

	Print a Review Summary

	View InterQual® Notes

	View CERMe Help Topics

	View Clinical Evidence Summaries

	Change Current Level of Care

	Create a Review (Admission, Continued Stay, and Discharge screen)

	Transition Plan

	Quality Indicators Checklist


Table 6: CERMe Screen – NUMI Features

	NUMI FEATURES

	The “Continue Primary Review” Button

	The “Patient Selection”, “History”, “CERMe” and “Primary Review button bar (navigational tabs for moving through a review)

	The read-only information in the Review For, Age and Admission Dx fields


IMPORTANT

Below is a list of some features that may display as you are working on the CERMe screen. These are McKesson CERME features and are not applicable to NUMI. Please do not use them: 
· Add Reviewer Comments field (Any comments entered here will NOT be captured with the rest of the review. The Primary Review screen, described in Chapter 5, will provide you with an opportunity to enter review comments).
· Hide Comments checkbox
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Figure 46: NUMI Application ‘CERMe’ screen
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  IMPORTANT: If you wish to switch from the CERMe screen to the Primary Review screen DO NOT click on the Primary Review screen tab to move forward, as you will lose any changes you have made. Conversely, if you wish to cancel your changes in the InterQual® portion of the review, this is a handy way to do so!
4.1 Finding InterQual® Medical Criteria Subsets XE "InterQual® Medical Criteria Subsets"  
Use this feature to find Subsets, which are groupings by specialty under each InterQual® Level of Care. Within each Subset are the InterQual® medical criteria Products XE "Products" , Categories XE "Categories"  and Subcategories XE "Subcategories"  that the Subset is based upon. A specific subset of InterQual® criteria is implemented in NUMI. The subsets that are NOT implemented in NUMI are listed in Table 7. 
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  CERME will let you choose the Behavioral Health Procedure Review subsets below and do a review, but when you try to continue NUMI will stop you and reset the review to its previous state. 
Table 7: InterQual® Criteria Subsets not implemented in NUMI

	InterQual Product
	Category
	Unsupported Subsets

	BH: Geriatric Psychiatry
	Procedure Review
	· Geriatric Acute Short-Term Electroconvulsive Therapy (ECT)

· Geriatric Continuation/Maintenance Electroconvulsive Therapy

· Geriatric Neuropsychological Testing

· Geriatric Psychological Testing

	BH: Adult Psychiatry
	Procedure Review
	· Adult Acute Short-Term Electroconvulsive Therapy (ECT)

· Adult Continuation/Maintenance Electroconvulsive Therapy

· Adult Neuropsychological Testing

· Adult Psychological Testing


No reviews need to be done for non-implemented subsets (i.e.,  procedures within Behavioral Health), and they cannot be saved. 

To find Subsets by InterQual® Product and Category
108. Select an option in the InterQual® Products window by clicking on it. 
109. A list of categories will be populated in the Categories window.

110. Click on an option in the Categories window and a list of hyperlinked Subsets will populate in the table on the screen.
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 If you select the BH: Chemical Dependency & Dual Diagnosis InterQual® Product and the Adult or Adolescent Category options, an additional Subcategory-level window will display. Once you have selected a subcategory, a list of hyperlinked Subsets will display in the table.
4.1.1 Finding Subsets using Keyword(s) and Medical Code(s)
Use this feature to search for InterQual® Medical Criteria Product subsets using Keywords and Medical Codes. The Keyword search feature is handy when you are not sure which subset to use for an admitting diagnosis. The Medical Code search feature is handy in cases where concurrent coding has been done (i.e.,  a patient stay gets an ICD-9 code upon admission, and that code is changed concurrently as the diagnosis changes).
To find Subsets using Keyword(s)

111. Type the desired keyword(s) into the Keyword(s) field.
112. Click the <Find Subsets> button.

To find Subsets using Medical Code(s)

113. Type the desired ICD-9 medical code(s) into the Medical Code(s) field).
114. Click the <Find Subsets> button.
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 Use commas in between multiple Keywords and Medical Codes
4.2 Viewing Subset Notes XE "Subset Notes" 
Use this feature to look at InterQual® Medical Criteria Subset Notes. The types of criteria notes include: Instruction (Level of Care) Notes which facilitate level of care choices and explain correct applications (Figure 47), Informational Notes which clarify criteria points (Figure 48), and Glossary Notes that include frequently referenced notes and definitional terms (not shown).
To view Subset notes
115. Select an InterQual® Product, a Category, and a Subcategory (if applicable).

116. When the list of Subsets displays in the table, click on the yellow Notes icon [image: image94.emf]  beside the desired subset. 

117. Another window will open and display the notes for that Subset.

[image: image95.emf]
Figure 47: Instruction (Level of Care) Subset Notes example

[image: image96.emf]
Figure 48: Informational Subset Notes example

4.3 Selecting an InterQual® Medical Criteria Subset XE "Selecting an InterQual® Medical Criteria Subset" 
To select a Subset

1. Select an InterQual® Product, a Category, and a Subcategory (if applicable).

2. When the list of Subsets displays in the table, click on the desired Subset Description hyperlink.

3. A set of criteria with checkboxes will display. (Figure 49). 

4. To expand or collapse the criteria fields, click the <+> and <-> buttons.
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 The criteria that display will depend on the Subset you choose. Review criteria from the selected subset decision tree for a patient is captured and displayed on the Review Summary and Physician UM Advisor Worklist screens for reference. 
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Figure 49: Criteria InterQual® Criteria checkboxes
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  Clicking the <Next Step> button in the lower left portion of the sidebar may display the message: “There are no more steps to display”. This applies to McKesson CERME and is not applicable to NUMI.  If you see this message, click the <Continue Primary Review> button at the top righthand side of the page to proceed.
4.3.1 Changing a Subset Selection
To change a Subset selection

118. Click on the Subset information row in the sidebar to display the <Change Subset> button. (Figure 50)
119. Click the <Change Subset> button. 

120. The following message displays: “Changing subsets will erase all criteria point selections, reviewer notes, and the review outcome. Would you like to change subsets?”
121. Click the <Yes> button and select another Subset. 

[image: image100.emf]
Figure 50: Change Subset button
4.4 Printing a Review Summary XE "Printing a Review Summary" 
While this screen has a feature for printing a review summary, it should be noted that this summarizes CERMe data selected only, and does not include the other review data.

To print a review summary

1. Click the <Review Summary> button on the sidebar.
2. The summary information will display in the right hand side window, as shown in Figure 51. Use your browser’s print feature to print out the information.

[image: image101.emf]
Figure 51: Review Summary

4.5 Viewing InterQual® Notes XE "Viewing InterQual Notes" 
Any InterQual® Notes that display will depend on the criteria you have selected, and will populate to the lower left hand window in the sidebar, as illustrated in Figure 52. 
[image: image102.emf]
Figure 52: InterQual® Notes example

4.6 Viewing CERME Help Topics XE "CERME Help Topics" 
The Help dropdown contains a variety of McKesson CERME help topics that can be viewed from within the NUMI application. These are not NUMI help topics. The dropdown is located on the far right hand side of the CERMe screen, beneath the <Continue Primary Review> button, as shown in Figure 51.
To view the CareEnhance Review Manager help topic

1. Click the Help dropdown.

2. Click CareEnhance Review Manager. The topic will display in a separate window.
To view the Guide to Conducting Reviews

1. Click the Help dropdown.

2. Click Guide to Conducting Reviews. The topic will display in a separate window.

To view the InterQual® Abbreviations and Symbols topic
122. Click the Help dropdown.

123. Click InterQual® Clinical Reference.
124. Click Abbreviations and Symbols. The topic will display in a separate window.
To view the InterQual® Clinical Reference 2011 topic
125. Click the Help dropdown.

126. Click InterQual® Clinical Reference.

127. Click Clinical Reference 2011. The topic will display in a separate window.
To view the InterQual® Clinical Reference / Drug List topic
128. Click the Help dropdown.

129. Click InterQual® Clinical Reference.
130. Click Drug List. The topic will display in a separate window.
To view the Historical InterQual® Clinical Reference topic

131. Click the Help dropdown.

132. Click  InterQual® Clinical Reference.

133. Click Clinical Reference 2010. The topic will display in a separate window.

To view the About CareEnhance Review Manager topic
134. Click the Help dropdown.

135. Click About CareEnhance Review Manager. The “About” information will display in a separate window.
4.7 Viewing Clinical Evidence Summaries XE "Clinical Evidence Summaries" 
Use this feature to view InterQual® Clinical Evidence Summaries. These are a collection of concise, current white papers that synthesize medical research on complex and controversial diagnoses to support second-level physician review recommendations and promote evidence-based standards of care.

To view Clinical Evidence Summaries
136. Click the Clinical Evidence Summaries information row in the sidebar (shown in Figure 53).
137. A list of Categories will display.

138. Click on a Category (or, to search for specific information, type in one or more Keywords). 
139. Click the <Find Subsets> button.
140. A list of Clinical Evidence Subsets will display.

141. Click on a Subset Description hyperlink for the clinical evidence summary you wish to see. A Book View of the summary you chose will display.
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Figure 53: Clinical Evidence Summary Subsets

4.8 Change the Current Level of Care Option XE "Current Level of Care Option" 
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 Hyperlinked Current Level of Care options will display when Behavioral Health InterQual® Product / Category combinations are selected.     
To change the Current Level of Care
142. Click on a product in the InterQual® Products window (e.g.,  BH: Chemical Dependency & Dual Diagnosis). 
143. Click on a category in the Categories window (e.g.,  Concurrent Review).

144. Click on a Subset to select it.

145. A list of hyperlinked Current Level of Care options will display, as illustrated in Figure 54.

146. Click on a hyperlink. 
147. The message “Changing this choice will erase all criteria. Click Yes to change or No to keep the old value” will display.

148. Click the <Yes> button and select another value.
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Figure 54: Current Level Of Care option examples
4.9 Transition Plan XE "Transition Plan" 
The Transition Plan is a comprehensive discharge planning guideline intended to provide reviewers with a means to document, track and report on the discharge plan throughout the episode of care. It provides a framework for identifying discharge needs and outlines the interventions necessary to ensure continuity of quality patient care. Evidence has demonstrated that attention to transitioning care from one setting to another can significantly improve outcomes, impact quality of care and reduce readmissions. 

 The Transition Plan is available in the criteria books and as a reportable, interactive checklist in CareEnhance® Review Manager.  
 Within the criteria, select criteria points are flagged with a new green icon [image: image106.jpg]


, indicating that the patient may be at risk for readmission and could benefit from comprehensive discharge planning. 

To view Transition Notes

149. Click on the green Transition Notes icon beside a subset in the table.

150. Another window opens and displays the Transition Notes for that subset.

4.10 Quality Indicator Checklist XE "Quality Indicator Checklist" 
The National Quality Forum (NQF) inpatient quality measures can now be found in the "Quality Indicator Checklist". This checklist is designed for ease of use, to improve quality of care, and to enable reporting.   The Quality Indicator Checklist is available in the criteria books and as a reportable, interactive checklist in CareEnhance® Review Manager. 

 Within the criteria, select criteria points that have associated NQF inpatient quality measures are flagged with a new orange icon. [image: image107.jpg]



To view Quality Indicator Notes

1. Click on the orange Quality Indicator Notes icon beside a subset in the table.

2. Another window opens and Displays the notes for that subset.

4.11 Creating Reviews XE "Creating Reviews"  
Below are the basic steps for creating Admission and Continued Stay Reviews. Note: if a reviewer has previously performed a review for a stay that does Not Meet criteria and has specified reasons and assigned the review to a Physician UM Advisor, then they return and change the review so that the stay Meets criteria, the prior reasons and Physician UM Advisor review will all be lost. 
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 The system will not permit you to create more than one review per patient, per day.  If an attempt is made to save a second review for a single calendar day, an error message will be displayed indicating: “A review has already been saved for <review date> by <reviewer name>. Only one review per day can be entered into NUMI. Please modify the saved review, if necessary, or select another day”, and the review will not be saved.
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  InterQual® Notes can be displayed for certain Admission, Continued Stay and Discharge criteria. Criteria that have notes associated with them will display in the InterQual® Notes window on the lower lefthand side of the CERMe screen. 
4.11.1 Creating an Admission Review
An Admission Review is performed upon hospital admission to acute care treating specialties, or transfer to a higher LOC to determine whether that patient meets criteria for that level of care. For information about how the system identifies the various admission review types, please see Section 5.7.
To create an Admission Review

151. From the Subset menu, click on the LOC: Acute Adult InterQual® Product. 

152. Click on a category in the Categories window. 

153. A listing of Subsets will populate in a table on the screen. 

154. Select a Subset by clicking on its Subset Description hyperlink.

155. Click on the Admission hyperlink (Figure 55) to indicate to the system that the review is an Admission. 
156. Click the <+> button beside the criteria to expand the Admission criteria fields. (Figure 56)

157. Click on the desired checkboxes. 

158. A checkmark will appear beside each box you have selected.  (The criteria checkboxes you select will determine what displays in the IQ Criteria Met field on the Primary Review screen. Please see Table 8 for more information).
159. When you have selected criteria for both Severity of Illness and Intensity of Service, you will notice that if the patient has met criteria on both factors there will be a green Criteria Met box in the upper right corner. If the patient has not met criteria on both factors, you will see a red Criteria Not Met box.

160. Click the <Continue Primary Review> button and the Primary Review screen will display. On the Primary Review screen you will complete the review by entering the Date you are reviewing, indicating if the admission is an unscheduled readmit within 30 days, selecting an admission review type, selecting the Current Level of Care and, if the review does not meet criteria, selecting a Recommended Level of Care and Stay Reason, and selecting a Physician UM Advisor. Verify that the Ward, Treating Specialty, and Attending Physician are correct. (Note: when generating NUMI reports and using the Admission Review Type filter, the information that displays will be determined by the admission review type that was selected). Please see Chapter 8 for more information about reporting and Section 5.7 for information about the different types of admissions). There is a free text field to enter comments on the Primary Review screen. This field will accommodate extensive comments and is intended for your use to document information for future reference and to assist you in identifying specific findings of this review.
161. Click the <FINAL SAVE/Lock to Database> button to save your work. (See Chapter 5 for detailed instructions on using the features of the Primary Review screen).
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  IMPORTANT: If you ever need to come back to the CERMe screen to make changes to the InterQual® criteria portion of the Admission review, you MUST click the <Continue Primary Review> button for NUMI to capture the changes, and reflect them in the review accordingly. Otherwise your changes will be lost.
[image: image111.png]


 Both the Severity of Illness criteria and the Intensity of Services criteria rules from the same criteria subset must be met on Admission. Thus, in NUMI, once criteria checkboxes have been selected for Severity of Illness and Intensity of Service, the criteria for Admission will be met and the review status will automatically change to  [image: image112.emf].
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Figure 55: Review Type options

[image: image114.emf]
Figure 56: Admission criteria example
[image: image115.png]


 Selecting certain criteria may display advisory messages, such as: “Admit to Inpatient/Observation”, “Admit to Inpatient / Observation and refer to Dual Diagnosis criteria subset for concurrent review” or “Admit to Inpatient Detoxification”. Click the <OK> button to continue working.
4.11.2 Creating a Continued Stay (CS) Review
A Continued Stay Review is performed to determine if a continued stay day in the acute care setting meets clinical criteria. The system will only permit you to create one Continued Stay review per day.
To create a Continued Stay Review
1. From the Subset menu, click on the LOC: Acute Adult InterQual® Product. 

2. Click on a category in the Categories window. 

3. A listing of Subsets will populate in a table on the screen. 

4. Select a Subset by clicking on its Subset Description hyperlink.

5. Click on the Continued Stay hyperlink (Figure 55). 

6. Click the <+> button beside the criteria to expand the fields. (Figure 57)

7. Click on the desired checkboxes. 

8. A checkmark will appear beside each box you have selected.  (The criteria checkboxes you select will determine what displays in the IQ Criteria Met field on the Primary Review screen. Please see Table 8 for more information).
9. Click the <Continue Primary Review> button and the Primary Review screen will display. On the Primary Review screen you will complete the review by entering the Date Being Reviewed, the Current Level of Care, and, if the review does not meet criteria, selecting a Recommended Level of Care and Stay Reason, and selecting a Physician UM Advisor. Verify that Ward, Treating Specialty, and Attending Physician are correct. Enter clinical comments to assist you for further reference. If this is a review that does not meet criteria and will be forwarded to a Physician UM Advisor for review, clinical comments that provide information about why the patient is not meeting criteria will be helpful for the Advisor.

10. Click the <FINAL SAVE/Lock to Database> button to save your work. (See Chapter 5 for detailed instructions on using the features of the Primary Review screen).
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  IMPORTANT: If you ever need to come back to the CERMe screen to make changes to the InterQual® criteria portion of the Continued Stay review, you MUST click the <Continue Primary Review> button for NUMI to capture the changes, and reflect them in the review accordingly. Otherwise your changes will be lost.
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 Once one or more criteria checkboxes for Intensity of Service have been selected, the criteria for Continued Stay will be met. The review status will remain  [image: image118.emf] .
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  You can select the <Continue Primary Review> button regardless of whether criteria have been met. Note: if criteria has not been met, the review will become a Physician UM Advisor review (unless, by formal hospital policy, a Physician UM Advisor review is not required. Please see Section 5.10.1 for information about indicating a Physician UM Advisor review is not required).
 [image: image120.emf]
Figure 57: Continued Stay criteria example
[image: image121.png]


 Selecting certain Continued Stay criteria may display this message: “Choosing these criteria indicates that the patient may be ready for discharge or transfer. Would you like to review the discharge screens for assistance in discharge planning? (For more information click on the Help tab to access the appropriate criteria review process e.g., , Acute Care, Acute Rehabilitation, LTAC)”, along with <Yes> and <No> buttons. Click the desired button to continue working.
4.12 Continue Primary Review Button XE "Continue Primary Review Button" 
Select this button to leave the CERMe screen in the NUMI application and proceed with the primary review. The type of review and whether it meets criteria or not will change the display of the Primary Review screen when it displays after the <Continue Primary Review> button is pressed.
To continue a Primary Review 
162. Click the <Continue Primary Review> button at the top righthand side of the screen.

163. The Primary Review screen will display.
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  If you click the <Continue Primary Review> button and the review is not supported in NUMI, you will see the message: “Unsupported review type. Please use another CERMe review”. You will need to select another review. A Behavioral Health Procedure Review is one example of when this message may display. (Table 7 lists the non-implemented InterQual® Criteria Subsets in NUMI).    
5 PRIMARY REVIEW Screen XE "PRIMARY REVIEW Screen" 
This chapter describes the Primary Review screen. (Figure 60) This is where you will select a day being reviewed date and add and update patient review information such as review and reminder dates, levels of care, attendings, and stay reasons. 
In the IQ Criteria Met field, a visible Met / Not Met indicator is displayed for your convenience. The value that displays in the field (Yes/No) will be determined by the criteria checkboxes that were selected on the CERMe screen. Table 8 shows the detailed review outcomes and what will populate to the field. (The IQ Criteria Met field value will also display in the Met? column on the Patient Selection screen).
Table 8: Review Outcomes and IQ Criteria Met Values

	CERMe Screen Review Outcome Value 
	Primary Review Screen IQ Criteria Met Field Value

	Observation Met – Yes
	Yes

	Acute Met – Yes
	Yes

	Intermediate Met – Yes
	Yes

	Critical Met – Yes
	Yes

	Criteria Met – Yes
	Yes

	Criteria Not Met – No
	No

	Alternate Met – Yes
	Exception/Not allowed  

	N/A
	Exception/Not allowed  
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 If the InterQual® product criteria you selected results in an review outcome of Alternate Met – Yes or N/A, when you select the Continue to Primary Review button from the CERMe screen and the Primary Review screen displays, the error message shown in Figure 58 will display and you will be returned to the CERMe screen. An example of criteria selections that are not supported in NUMI and will produce the error message would be selecting the LOC Acute Adult Product and either the Transition Plan or Quality Indicator Checklist categories.  
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Figure 58: IQ Criteria Met error message
On this screen you can also assign reviews that did not meet criteria to Physician UM Advisors, add reviewer comments, identify unscheduled readmissions, enter custom notes in a free text field (and later generate a report [Section 8.6] that shows those notes), copy a review (via a link in the Reviews table), and save/lock reviews to the database. The bottom half of the screen displays read-only review text information from McKesson CERME. (The information that displays in the Attending, Treating Specialty and Ward fields will depend on which Review hyperlink you selected on the History screen). When the screen first displays, the Patient Selection, History, CERME and Primary Review buttons will be available for selection. The features on this screen are listed in Table 9. 
If a user creates Admission or Initial Review type reviews, the system will display an Admission Review Type dropdown (discussed in Section 5.7), a Number of Days Since Last VA Acute Care Discharge field (discussed in Section 5.20), and a Check if Unscheduled Readmit Within 30 Days checkbox (discussed in Section 5.14) on the Primary Review screen.  
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  All fields on the Primary Review screen (with the exception of Custom and Reviewer Comments) are required and must be populated before a review can be saved and locked to the database. If the review Meets you must select Review Date, Attending Physician, Current Level of Care, Treating Specialty, Ward, and Service Section. If the review Does Not Meet you must select options from the abovementioned fields as well as options for Recommended Level of Care and Physician UM Advisor. If the review is an Admission or BH Initial type you must select an Admission Review Type. If you do not select something from these dropdowns you will see one or more messages in red text. (Figure 59). 
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Figure 59: Example required field messages on Primary Review screen
Table 9: Primary Review Screen Features

	FEATURES

	Select Day Being Reviewed Date

	Select/Change Current Level of Care

	Select/Change Attending Physician

	Select/Change Treating Specialty

	Select/Change Ward

	Select/Change Service Section

	 Working with Admission Review Types

	Add Reviewer Comments

	Select Stay Reasons

	Assign a Physician UM Advisor to a Review that has Not Met Criteria

	Change Next Review Reminder Date

	Indicate no more Reviews on a Stay

	Select/Change Recommended Level of Care

	Indicate an Unscheduled Readmission within 30 days

	Show a Patient’s Reviews

	Copy a Review

	View CERME Review Text

	Add Custom Notes

	Save and Lock a Final Review

	Days Since Last VA Acute Care Discharge Calculation
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Figure 60: Primary Review screen
5.1   Selecting the Day Being Reviewed Date XE "Day Being Reviewed Date" 
When the Primary Review screen opens, you will need to select a Day Being Reviewed date.  This calendar feature is located below the Admit Date field and above the Review Type field.  If you would like to view a list of existing reviews to help determine which date to select, use the Show Reviews button. (Please see Section 5.15 for more information).
To select the Day Being Reviewed date
1. Click on the dropdown box beside the Calendar icon (Figure 61) and select a date between the Admission date and the Discharge date (or the current day’s date if the patient has not been discharged). 
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Figure 61: Calendar
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  The calendar only lets you select a date between Admission and Discharge dates (or current day’s date if the patient is still in the hospital). If you manually enter a date, it must be within that range or a message like the one shown in Figure 62 will display. If you type in the date, you must use the format mm/dd/yyyy.
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Figure 62: Review Date prompt

5.2 Selecting or Changing Current Level of Care XE "Changing Current Level of Care"  
Use this feature to select or change the Current Level of Care for a patient. You must select a Current Level of Care or you will not be able to save the review.
To select or change the Current Level of Care

164. Click on the Current Level of Care dropdown. 
165. Select a Current Level of Care by clicking on an option in the list. OR

166. Change the Current Level of Care to another value by clicking on a different one. 
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  If ‘Other’ is selected, a text box will display and you will need to type in a description. You may type up to 1,000 characters into the text box. 

5.3 Selecting or Changing Attending Physician XE "Changing Attending Physician"  
NUMI gives you a convenient way to select or change the Attending Physician information for a review, and associate the review with the correct Attending. This feature is especially handy in cases where the Attending information from VistA is not provided or is incorrect.  

To select or change Attending Physician
167. Click on the Attending Physician dropdown. (Figure 63)
168. Select a new Attending by clicking on the name. OR
169. Change the Attending by clicking on the dropdown and selecting another name.
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Figure 63: Attending Physician dropdown

5.4 Selecting or Changing Treating Specialty XE "Changing Treating Specialty"  
To select or change the Treating Specialty
170. Click on the Treating Specialty dropdown. (Figure 64)
171. Select a Treating Specialty by clicking on it. OR
172. Change the Treating Specialty by clicking on the dropdown and selecting another one.

[image: image133.emf]
Figure 64: Treating Specialty dropdown

5.5 Selecting or Changing Ward XE "Changing Ward"  
To select or change the Ward
173. Click on the Ward dropdown. (Figure 65)
174. Select a Ward by clicking on it. OR
175. Change the Ward by clicking on the dropdown and selecting another one.
[image: image134.emf]
Figure 65: Ward dropdown

5.6 Selecting or Changing Service Section XE "Changing Service Section"  
To select or change the Service Section

1. Click on the Service Section dropdown. (Figure 66)

2. Select a Service Section by clicking on it. OR
3. Change the Service Section by clicking on the dropdown and selecting another one.

[image: image135.emf]
Figure 66: Service Section dropdown
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  There may be instances where you may expect to see a particular Ward, Treating Specialty, Service Section or Admitting Physician, but the information does not display. The NUMI database will not include this information until NUMI first finds it in a patient movement record from VistA. While you cannot manually add this information to the dropdowns, you can use the Sync With VistA feature (please see Section 7.6 for more information). Once the information has been synchronized and pulled into NUMI, the information will display in the dropdowns.
5.7 Working with Admission Review Types XE "Working with Admission Review Types" 
Review Type information comes over to NUMI in a separate field from CERME. The Admission Review Type dropdown list, shown in Figure 67, will only be displayed if the review type is an Admission or BH Initial review.  If the review type is Continued Stay or BH Concurrent, the dropdown will not be displayed.
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Figure 67: Admission Review Type dropdown

5.7.1 Admission Review Types for Admission Reviews XE "Admission Review Types for Admission Reviews" 
When you select a patient for an Admission or BH Initial review and navigate to the Primary Review screen, the system will display the following list of options in the Admission Review Type dropdown (also illustrated in Figure 68):
· Hosp Acute Adm - Traditional Criteria  (formerly called Hospital Acute Admission)
· Hosp Acute Adm – Condition-Specific Criteria

· Observation Converted to Hospital Admission

· Conversion to New Condition-Specific Criteria

· BH Initial Review

· Transfer to Higher Level of Care

· Transfer to/from Acute Care and BH
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Figure 68: Review Type Options
5.7.2 Select / Change Admission Review Type XE "Select / Change Admission Review Type" 
To select or change the Admission Review Type

1. Click on the Admission Review Type dropdown.

2. Select an option from the dropdown by clicking on it. If you hover your mouse pointer over the dropdown you will see a tooltip advising that you can select multiple choices from the dropdown.
 XE "" 
[image: image139.png]


  If you create an Admission or BH Initial review and do not select an Admission Review Type and then try to save/lock the review, a red error message will display (Figure 69) and advise that you must select one of the valid types. 
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Figure 69: Admission Review Type select option message
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  The information that displays on the NUMI reports will depend on the Admission Review Type that is selected on the Primary Review screen. (See Chapter 8).
5.8 Adding Reviewer Comments XE "Adding Reviewer Comments" 
Comments that you enter here will also display in the Comments window on the Physician UM Advisor Worklist screen for reviews not meeting criteria. Your comments may be up to 4,000 characters in length. It is helpful to enter information which will explain why the patient does not meet criteria. For reviews meeting criteria, use this field to document information that will be helpful to you for future reference. (Please see Section 7.5 for more information about this screen). 
To add reviewer comments

1. Type your comments directly into the Reviewer Comments field. (Figure 70)
[image: image142.emf]
Figure 70: Reviewer Comments

5.9 Selecting a Stay Reason XE "Selecting a Stay Reason" 
Stay reasons will only be required on the Primary Review screen for reviews that have not met criteria. The Stay Reason categories are collapsed when the screen first opens. To expand the categories and view the list of Stay subcategories, click the <+> buttons. (Figure 71) 
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  You must choose a Stay Reason if the stay does not meet criteria, or you will not be able to save the review and the message “Please Select a Reason” will display. 
[image: image144.emf]
Figure 71: Expanded Stay Reason categories
To select a stay reason
1. Click on the <+> button beside the desired stay reason category.

2. Choose a stay reason by clicking on it.
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  If none of the listed Stay Reasons are appropriate and ‘Other’ is selected, a text box will display and you must type in a description of what your reason for the Stay Not Meeting Criteria is. You may type up to 500 characters into the text box. 
5.10 Assigning a Physician UM Advisor to a Review XE "Assigning a Physician UM Advisor to a Review"  that has Not Met Criteria

Use this feature to assign a review that did not meet criteria to a Physician UM Advisor. You must choose a Physician UM Advisor or you will not be able to save the review and the message “Please Select a Physician UM Advisor” will display. (Figure 72)
To select a Physician UM Advisor to receive a review that has not met criteria
176. Select the Physician UM Advisor Review dropdown and select a name by clicking on it.
177. Once you click the <FINAL SAVE/Lock to Database> button, the review will be assigned to that individual and it will display the next time they open their Physician UM Advisor Worklist screen. 
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Figure 72: Physician Utilization Management Advisor dropdown
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  Please see Section 5.10.1 for information about how to indicate that a Physician UM Advisor review is not necessary.
5.10.1 Physician UM Advisor review not required

There is an overarching rule that all unmet reviews are sent to a Physician UM Advisor. NUMI gives you an option to indicate that a Physician UM Advisor review is not required. 
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  In order to check the box indicating that the Physician UM Advisor review is not required, a local facility policy must be in place defining the specific cases not requiring Physician UM Advisor review. If this box is checked and the unmet review is not sent for physician review, the review will still be stored in the NUMI database as an unmet review, and included in the unmet review reporting.
To indicate that a Physician UM Advisor review is not required
178.  Click the <Check here if criteria is NOT MET and formal hospital policy does NOT require physician review> checkbox (Figure 73) beside the Physician UM Advisor Review dropdown list for the desired patient.

179. Click the <FINAL SAVE/Lock to Database> button.

180. A Physician UM Advisor review will not be created.

[image: image149.emf]
Figure 73: Physician UM Advisor review not required checkbox indicator

[image: image150.png]


  If the checkbox is selected, you do not have to choose a Physician UM Advisor (and no Physician UM Advisor review will be created). And if a Physician UM Advisor had been selected from the dropdown and the checkbox was then selected, the system will ignore the Physician UM Advisor information.
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  If your facility policy does not require Physician UM Advisor review, the reviews that do not meet criteria will be included in reports and treated the same as all other reviews  (including the requirement to select a Stay Reason and Recommended Level of Care), except that there is no Physician UM Advisor Review attached to the primary review.
5.11 Changing the Next Review Reminder Date XE "Next Review Reminder Date" 
Use this feature to indicate when the next review should be performed. The default is the next day’s date. This feature can also be used to defer reviews. For example, if a patient is going to be in the ICU for the next 3 days, you might choose to defer the next review and use the time to review other higher priority stays, then catch up with the deferred reviews later.
To change the next review reminder date

1. Click on the dropdown box beside the Calendar icon.

2. Scroll through the calendar screens and select the desired date by clicking on it  (date field and calendar are shown in Figure 74) OR
3. Type the desired date into the Next Review Reminder field.
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Figure 74: Next Review Reminder Date field with calendar displayed

5.12 Indicating No More Reviews on a Stay XE "Indicating No More Reviews on a Stay"  
Use this feature to indicate that no more reviews will be performed on a stay. For example, you might use this in a situation where a patient is discharged on Sunday, and a Continued Stay review was performed for Saturday. The patient is now discharged and the review no longer meets criteria. Selecting this option will ensure that the review no longer appears on the Patient Selection list unless a subsequent VistA movement brings the patient back to the list. 

To indicate that you will not be doing further reviews on a stay
181. Click the <Check this box if you will not be doing further reviews on this stay> checkbox. (Figure 75). 
182. Click the <FINAL SAVE/Lock to Database> buttons to dismiss the reminder. 

[image: image153.emf]
Figure 75: Further Review on Stay checkbox
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  Once you indicate that you will not be doing any further reviews on a stay, it will be removed from the table on the Patient Selection screen. It will display on the screen again only after someone goes to the Dismissed Patient Selection screen and performs another review on it. (See Section 7.3 for more information about the Dismissed Patient Select screen.) Note: another movement may cause a stay to re-display on the Patient Selection screen.
5.13 Selecting or Changing Recommended Level of Care XE "Changing Recommended Level of Care" 
The Recommended Level of Care dropdown will only display for reviews that have not met criteria.

To select or change Recommended Level of Care

183. Click the Recommended Level of Care dropdown.
184. Select an option from the dropdown (illustrated in Figure 76) by clicking on it.

[image: image155.emf]
Figure 76: Recommended Level of Care options
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  If none of the listed levels of care are appropriate and ‘Other’ is selected, a text box will display and you must type in a description of what the ‘other’ level of care involves. You may type up to 1,000 characters into the text box. 

5.14 Indicating an Unscheduled Readmit XE "Unscheduled Readmit"  Within 30 Days

This checkbox feature will only display on the screen if you are doing an admission or initial review. Use this feature to indicate that a patient was an unscheduled readmit to the hospital within the past 30 days. (Figure 77) 
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Figure 77: Unscheduled Readmit Within 30 Days checkbox
To indicate an unscheduled readmit within 30 days

185. Click on the Check if Unscheduled Readmit Within 30 Days checkbox to select. 
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  NUMI lets you generate a report showing reviews performed on unscheduled readmissions. Please see Section 8.10 for more information.
5.15 Showing a Patient’s Reviews XE "Reviews" 
To show reviews for a patient

1. Click on the <Show Reviews> button.
2. Reviews for the patient will display in a table, as depicted in Figure 78. (Note that the button display changes to <Hide Reviews>).
[image: image159.emf]
Figure 78: Show Reviews table display

5.16 Copying a Review from the Primary Review Screen XE "Copying a Review from the Primary Review Screen" 
To copy a review from the Primary Review screen
1. Click on the <Show Reviews> button.

2. Reviews for the patient will display in a table, as depicted in Figure 78. 

3. Clicking a View hyperlink in the table will display the <Copy This Review> button, and you can make a copy of the review from there. 

5.17 Viewing CERME Review Text XE "CERME Review Text" 
The lower half of the Primary Review screen displays CERME Review Text. What displays depends on the criteria that have been selected, and is read-only. An example is shown in Figure 79. All possible subset criteria are displayed with an [X] to the left of the selected criteria.
[image: image160.emf]
Figure 79: CERME Review Text example

5.18 Adding Custom Notes XE "Custom Notes" 
You may wish to enter special notes, to be used when you are doing a focused study or doing special tracking of some issue. NUMI provides you with a field specifically for that purpose. Some examples of when this feature would be used are:

· Tracking diabetic-related admissions

· Tracking Operation Enduring Freedom/Operation Iraqi Freedom (OEF/OIF) patients

· Entering the Admitting Physician
· Flagging this review for special studies   

To add a custom note

1. Click in the Custom field (shown in Figure 80) and type in up to 25 characters’ worth of text.

2. Click the <FINAL SAVE/Lock to Database> button and your notes will be saved.

 [image: image161.emf]
Figure 80: Custom field text example
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  NUMI lets you generate a report [Section 8.6] showing notes that were typed into the Custom field.  
5.19 Saving and Locking a Final Review XE "Saving and Locking a Final Review" 
This feature will save and lock a review to the database. In order to be included in NUMI reports, a review must be locked into the database. If you lock a review and then later need to amend it, you can do this by clicking on the View link in the Reviews Table on the History page. Clicking on View for a locked review will produce the saved review with boxes that allow you to unlock and edit, delete, or copy the review.
To save changes to the database and lock the review
1. Click the <FINAL SAVE/Lock to Database> button.
2. The message “This review will now lock into the NUMI Database. Further changes require an administrator. Are you sure you are ready to lock this review?” will display, with <OK> and <Cancel> buttons.
3. Click the <OK> button. 
4. While this period of saving and checking is occurring, all buttons and links on the page will be disabled, and an on-screen textual legend will appear, reading “Saving review. Please wait.” 
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Figure 81: Saving review legend

This legend will disappear when the saving and checking are complete.

Additionally, if users attempt to leave the Primary Review screen without saving their work, they will be informed of this fact via a dialog box, and be prompted as to whether they really wish to abandon their changes.
[image: image164.png]@ Are you sure you want to leave this page?
Message from webpage:

You have not saved your Review yet.
You willlose your changes.

 Stay on this page





Figure 82: Unsaved review message

Click “Stay on this page”.
5. The review will be locked and saved to the database and can then be accessed from the Review Select screen in view-only format. (Please see Section 7.2 for more information about the Review Select screen).
If NUMI cannot confirm that the data has been saved, it will not proceed to the next screen. It will instead display an error message, “An error occurred during commit…” and leave the review data previously entered on the screen. The reviewer may again attempt to save the data.
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Figure 83: Commit error
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  Only reviews with ‘Don’t Meet Criteria’ status will go to the Physician UM Advisor Review Page [Physician UM Advisor Worklist] from the Primary Review screen. All reviews that are locked (both ‘Meets Criteria’ and ‘Don’t Meet Criteria’ statuses) will automatically be reported in the Date of Last Review field on the Patient Selection List.
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  If you would like to perform another review on the same patient stay, you can do this by selecting a saved review from the Reviews table and copying it. There is a gold button on the History and Primary Review screens that you can click on to see a listing of the saved reviews on a patient stay and make a copy from there, as well. (See Chapter 10 for more information). Reminder: the system will only permit you to save one continued stay review per day.
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 When you create a review, the Review Type comes pre-populated from CERMe.  In some instances, CERMe does not do this and the Review Type field is blank. NUMI will not let you save a review without the review type information. If the review you are working on has no review type information and you try to save it, you will now see the message: “Review Type cannot be blank. Please return to CERMe to select a Review Type and re-enter criteria”. To continue with your review, click the CERMe tab at the top of the Primary Review screen, reselect your CERMe criteria, and you will be able to complete your review and save it. (Note: if you generate Report #1, if any reviews are missing the Review Type, those reviews will display at the top of the report, as illustrated in Figure 114).     

5.20 Days Since Last VA Acute Care Discharge Calculation XE "Days Since Last VA Acute Care Discharge Calculation" 
The NUMI system calculates the number of days since a patient’s last discharge from a VA facility. It displays the number in the Days Since Last VA Acute Care Discharge field . The field is above the Check if Unscheduled Readmit Within 30 Days checkbox field.
If the value in the field is over 30 days, the reviewer will know that it is not possible for the stay to be an unscheduled readmission in less than 30 days. If the value in the field is less than 30 days, the reviewer would then consider whether the stay is unscheduled.
[image: image169.emf]
Figure 84: Days Since Last VA Acute Care Discharge field

5.20.1 Calculation Rules

The NUMI system shall display an error message, “The last VA discharge date is not available” in the Days Since Last VA Acute Discharge field when a prior stay does not have a discharge date. 

The NUMI system shall display “n/a” in the Days Since Last VA Acute Discharge field when there is no VA facility discharge. (illustrated in Figure 84). 
The NUMI system shall display the number of days between the last VA facility discharge date and the current VA facility admission date in the Days Since Last VA Acute Discharge field when there has been a prior VA facility discharge. 

6 PHYSICIAN UM ADVISOR WORKLIST XE "PHYSICIAN UM ADVISOR WORKLIST" 
This chapter describes the Physician UM Advisor Worklist screen. (Figure 86)  Physician UM Advisors access this screen by selecting the Physician UM Advisor Worklist option from the Tools menu. This screen lets Physician UM Advisors see the reviews that have been sent to them (including the name of the sender). The features of this screen are listed in Table 10.
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  If you do not have Physician UM Advisor permissions, you will not see the Physician UM Advisor Worklist option in the Tools menu dropdown.
Table 10: Physician UM Advisor Screen Features
	FEATURES

	The Physician UM Advisor Worklist

	Select a Physician UM Advisor Review

	Agree / Disagree with Current Level of Care

	Enter Physician UM Advisor Review Comments

	FINAL SAVE/Lock To Database
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  All reviews that are locked (both ‘Meets Criteria’ and ‘Don’t Meet Criteria’) will automatically go to the Patient Selection screen from the Physician UM Advisor Review screen.
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  If a Primary Review is deleted, its associated Physician UM Advisor Review will also be deleted.
6.1 Physician UM Advisor Worklist XE "Physician UM Advisor Worklist" 
When this screen first opens, Physician UM Advisors will see a table with reviews that did not meet criteria and have been sent to them from a UM reviewer. (Figure 86)  If there are no reviews assigned, their list will be empty and “No Records Found” will display. (Figure 85)
[image: image173.emf]
Figure 85: Physician UM Advisor Worklist with no reviews assigned
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  The Review Date column on the screen will always display the date with a time of 00:00:00 underneath. This is not an error. The time will always display as 00:00:00 (Midnight) because reviews are for the CALENDAR DAY. 

[image: image175.emf]
Figure 86: Physician UM Advisor list of reviews sent by UM reviewers
6.2 Selecting a Physician UM Advisor review XE "Selecting a Physician UM Advisor review" 
To select a review from the list
1. On the Physician UM Advisor Review screen, click on the Review hyperlink on the far right side of the row of the review you wish to access.
2. The Physician UM Advisor review summary for that patient will display, as shown in Figure 87.
3. Immediately below the review list, you will see the Agree or Disagree response box and a Comments box. This is where the Physician UM Advisor enters information. All that is required from the Physician UM Advisor is an Agree or Disagree response. Additional comments are optional.

4. Below the Agree or Disagree response box, the entire review is available for review.
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Figure 87: Physician UM Advisor review screen
6.3 Agreeing / Disagreeing with Current Level of Care XE "Agreeing / Disagreeing with Current Level of Care" 
Use this feature to show concurrence or non-concurrence with the indicated Current Level of Care.

To Agree with the Current Level of Care
186. In the I AGREE with the current level of care section (Figure 88), click on the desired radio button.

[image: image177.emf]
Figure 88: Agree Reasons

To Disagree with the Current Level of Care
1. In the I DISAGREE with the current level of care section (Figure 89), click on the desired radio button.
[image: image178.emf]
Figure 89: Disagree Reasons
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  If none of the listed Agree or Disagree options are appropriate and ‘Other’ is selected, a text box will display and you must explain what the Other reason is. You may type up to 1,999 characters into the Agree and Disagree text boxes.  

6.4 Entering Physician UM Advisor Comments XE "Physician UM Advisor Comments" 
To enter Physician UM Advisor comments
187. Type the desired comments into the Comments window. (You may type up to 4,000 characters).
188. When you click the <FINAL SAVE/Lock to Database> button, your comments will be saved.
6.5 Saving and Locking a Final Review

This feature will save and lock a review to the database. 

To save changes to the database and lock the review
1. Click the <FINAL SAVE/Lock to Database> button.
2. The message “This review will now lock into the NUMI Database. Further changes require an administrator. Are you sure you are ready to lock this review?” will display, with <OK> and <Cancel> buttons.
3. Click the <OK> button. The review will be locked and saved to the database and can then be accessed from the Review Select screen in read-only format. (Please see Section 7.2 for more information about the Review Select screen). 

7 TOOLS Menu XE "TOOLS Menu" 
This chapter describes the Tools menu, which offers you different options that can be selected by clicking on them. (Figure 90) It is a navigation menu that includes some features that are accessible through other screens and other features only accessible here. The Tools Menu dropdown is located at the top of several NUMI screens. You can choose options related to selecting patients and reviews, unlocking and deleting reviews (see Chapter 9 for more information), locating dismissed patient movements, accessing the Physician UM Advisor Worklist (if you are designated as a Physician UM Advisor on NUMI), and on-demand synchronization of stay information between VistA and NUMI. Note: the features you see in the dropdown will depend on your NUMI privileges (e.g.,  Physician UM Advisors will not see the Patient Select option; Primary Reviewers will not see the Physician UM Advisor Worklist, etc.) The features on the Tools menu are listed in Table 11.
Table 11: Tools Menu features

	FEATURES

	Patient Select Option

	Review Select Option 
(includes Unlock/Copy/Delete options, and Print Preview and Export to Excel features)

	Dismissed Patient Stay Select Option

	Free Text Search Patient Option

	Physician UM Advisor Worklist Option

	Sync With VistA Option

	Patient Stay Admin Option

	Logout Option


[image: image180.emf]
Figure 90: NUMI Tools Menu

7.1 Patient Select Option XE "Patient Select Option" 
Select this option to work with the Patient Selection screen, where you can select stays to perform primary reviews. This screen also contains paging features that allow you to navigate thru the information in the table on the screen. Use of the paging features is explained in in Section 2.1.21.  The Find and Reset buttons have been moved to the righthand side of the screen. Please see Chapter 3 for more information about the Patient Selection screen.
To work with the Patient Select option

189. Click on the Tools dropdown.

190. Select the <Patient Select> option by clicking on it and the Patient Selection screen will display.  (Figure 91)
[image: image181.png]ation Management Integrat indows Internet Explorer

v |18 centficate Ervor | 49| X | [ oo £~

2. hitpsijjshaiswnumineb1 vha med va,gov/WeblPatientSelection aspx

Fle Edt View Favortes Took Help

% g0 (55~ | @natonl uiaton vaneg.. | worang Documents

Site: Ann Arbor, MI

Ann Arbor, MI v [o9]

Current Lookup Site:

Treating Specialt

[ Jstart Date

/2972011 |+
[ [End Date
22011 |

Find | [Reset

Click FIND to list all active stays in the past 34 days. To create a diferent stay list, click RESET. select your fiter criteria, and click FIND.

poweredty
FEIEDORA % e o e Vi A Ao Raslinears Canter ATHIL 401 Svia - C36 - 208 somaliaft. Varsion 1,112

@ et oo -

Dane.





Figure 91: Patient Select screen
7.2 Review Select Option XE "Review Select Option" 
Select this feature to work with the Patient Reviews screen, where you can see reviews that have been locked to the database. Section 2.1.11 explains how to use the filters at the top of the screen, and use of the paging features is covered in Section 2.1.21. NUMI reviewers will be able Unlock, Copy, and Delete reviews.  (See Chapter 9 for details about NUMI’s Unlock and Delete features).  The View and Review hyperlinks and the Review column have been removed from the screen. The hyperlinked patient name now functions as the View/Review link.
Print Preview and Export to Excel buttons have been added to the screen (Figure 93).  These features work the same way that they do on the Report screens. Note: if more than 5,000 rows of information display in your search results, the Print feature will be disabled and the message in Figure 92 will display. Selecting additional filters to further refine your search and obtain fewer results will resolve this. Unlike the Print feature, there are no restrictions to how many rows you may export to Excel. Please see Section 7.2.1 and Section 7.2.2 for more information about Printing and Exporting information from this screen.
[image: image182.png]National Utilization Management Integration - Windows Internet Explorer,

L R A P ) 28]

Flo Edt View Favortes Took

Help

% & (25~ | o workng pocuments

| € mroscf ook e cces,.. | @ ool reston tnag... % | |

- & -

Page 5 Tols -

ABBOTTROBERTMLTONJR 2345 W 040110000000 Yes PERPHERALVASCULAR SPCU  Confinued Stay ntermediate (step-dowin) A ‘SCHWETZER BONNE J
ABBOTTROBERTMLTONJR 2345 M 0328/100000:00 Yes STICU ST Admission criical A ‘SCHWETZER SONNE J
ABBOTTROBERTMITONJR 2345 M 033010000000 Yes STICU SSTCU  Continued Stay criical A ‘SCHWETZER BONNE J
ABSHRE LARRY JACK 5453 1 032410000000 Yes PERPHERALVASCULAR SPCU  Admission criical A ‘SCHWETZER SONNE J
ADAMS DAVD JOEL 1155 M 0428010 00:00:00 Yes  MEDICNE SEMED  Admission Acute A WAYWEATHER SETTY J
ADAMSFRANCIS MARION 6305 I 03/220300:00:00 No  MEDICALICU MU Continued Stay Domiclary VAN ORDERMARY VAN ORDERMARY
ADAUSMCHAEL MART  S681 M 031210000000 Yes WEDICHE SwM Admission Acute A LEE-HANS SUSAN It
ADAUS MCHAEL MART  S681 M 031310000000 No  WEDICHE SwM Continued Stay Acute A LEE-HANS SUSAN It
ADAUSMCHAFL MART  S681 M 031410000000 No  WEDICHE SWM Continued Stay Acute A LEE-HANS SUSAN It
ADAUS MCHAEL MART  S681 M 031SA00000:00 No  WEDICHE SwM Continued Stay Acute A LEE-HANS SUSAN It
ADAMS MLLEAGE MARSHALL 8455 M 0427/1000:00:00 No  PSYCHATRY SWP  BH ConcurrentReview npatientObservation WA ‘GuDO ReNEE
ADAMS MLLEAGE MARSHALL 8455 M 042210 00:00:00 Yes PSYCHATRY WP BH ConcurrentReview npatientObservation WA Gupo ReNEE
ADAMS MLLEAGE ARSHALL 8455 M 04261000:00:00 No  PSYCHATRY SWP  BH ConcurrentReview npatientObservation WA ‘GuDO ReNEE
ADAMS MLLEAGE ARSHALL 8455 M 04251000:00:00 No  PSYCHATRY WP BH ConcurrentReview npatientObservation WA Gupo ReNEE
ADAMS MLLEAGE MARSHALL 8455 M 0424/1000:00:00 No  PSYCHATRY SWP  BH ConcurrentReview npatientObservation WA ‘GuDO ReNEE
ADAMS MLLEAGE ARSHALL 8455 M 0423/1000:00:00 No  PSYCHATRY WP BH ConcurrentReview npatientObservation WA Gupo ReNEE
ADAMS MLLEAGE ARSHALL 8455 M 042010 00:00:00 Yes PSYCHATRY SWP  BHintalReview  paentObscrvaon WA ‘GuDO ReNEE
ADAMS MLLEAGE MARSHALL 8455 M 0421/1000:00:00 Yes PSYCHATRY WP BH ConcurrentReview npatientObservation WA Gupo ReNEE
ADKNSROY B 8150 M 0S077100000:00 No  WEDICHE SNMED  Continued Stay Acute A LEE-HANS SUSAN It
ADKNSROY B 8150 M 0SHEI00000:00 No  WEDICHE SNMED  Continued Stay Acute A LEE-HANS SUSAN It
ADKNSROY B 8150 M 0S0S100000:00 No  WEDICHE SNMED  Continued Stay Acute A LEE-HANS SUSAN It
ADKNSROY B 8150 M 0500000000 No  WEDICHE SNMED  Continued Stay Acute A LEE-HANS SUSAN It
ADKNSROY B 8150 M 0S0S100000:00 No  WEDICHE SNMED  Admission Acute A LEE-HANS SUSAN It
ADKNSROY B 8150 M 0S0G00000:00 No  WEDICHE SNMED  Continued Stay Acute A LEE-HANS SUSAN It
AKERSDANNY LEE 69 M 05010000000 Yes ORTHOPEDCS SN.SURG Admission Acute A MARSHALL SANDRA|
AKERSJAMESMONROE 9677 M 0SM21000.00:00 Yes MEDICNE Sw Admission Acute A UAYWEATHER SETTY J
AKERSJAMESMONROE 9677 M 0SM300000:00 Yes WEDICHE SWM Continued Stay Acute A WAYWEATHER SETTY J
AKERSJAMESMONROE 9677 M 0S14/1000:00:00 Yes MEDICHE SwM Continued Stay Acute A UAYWEATHER SETTY J

Next Last Page.
showing 6575 rows

Print Preview Export to Excel

poweredty
FEIEDORA

print function is disabled if more than 5,000 rows would be pri

ted because of time-out issues. Please narrow your criter

in order to print

A progus of he VA A Aroar Haslincars Canter ATIL 01 Sz - G55 - 208 semplisf, Varsion 1.1.12

@ et oo -





Figure 92: Print Function Disabled message
To work with the Review Select Option
1. Click on the Tools dropdown.
2. Select the <Review Select> option by clicking on it.
3. The Patient Reviews screen will display (Figure 93).

4. Selecting filters to search by and clicking the <Find> button will display a list of patients based on your search criteria, as shown in Figure 94.   
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  Locked reviews will display a blue hyperlink. Clicking on these will open the Review Summary screen. Reviews that have been unlocked for editing will display a red hyperlink. Clicking on these will open the Primary Review screen. An example of the screen with red and blue links is shown in Figure 94. 
7.2.1 Printing Patient Reviews Screen Information XE "Printing Patient Reviews Screen Information" 
To print out information on the screen

1. Select the desired search filter options.

2. Click the <Find> button.

3. When the results display, click the <Print Preview> button.

4. When the print preview window opens with results, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option.

7.2.2 Exporting Patient Reviews Screen Information XE "Exporting Patient Reviews Screen Information" 
To export the information on the screen to Excel

1. Select the desired search filter options.

2. Click the <Find> button.

3. When the results display, click the <Export to Excel> button. 

4. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You may also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. To proceed, click the <Open> button.

5. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to continue.  

6. The report will display. 

7. Select the <File> dropdown and click on <Print> to print it out.

[image: image184.png]National Utilization Management Integration - Windows Internet Explorer provided by ProSol

~ [ hetpitocaiostas7swebjrevienselection.aspx 2] (48] [x] [ 2l

Ele Edt View Favortes Toos Help

R T——

Site: 7ZAlbany

Current Lookup Site: | ZZAlbany K
Patient Reviews
Free Text:
Search Ty @ [Exact | |similar Word  Partial Word " Ispecific Word
[ Istart Date A A Service A
justd A
TEnome  [CIShow My Reviews Frrom Vista e—
justd A
™ JLast Modified [ lcorrected
Status
Find| [Reset
powsredby
FEIEDORA % e o e Vi A Ao Raslinears Canter ATHIL 401 Svia - C36 - 208 somaliaft. Varsion 1,112

oo T R -





Figure 93: Patient Reviews screen with grayed out Print and Export buttons
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Figure 94: Patient Reviews screen with results and selectable buttons
7.2.3 Filtering Reviews by Free Text 
To filter by Free Text

191. Click on the Tools dropdown.

192. Select the <Free Text Search> option by clicking on it.
193. Click on a Search Type radio button.

194. Type your text into the Free Text field.

195. Click the <Find> button and the results will display in a table. To select a patient, click on their hyperlinked name in the Patient Name column.
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  Using Free Text, you can search for an exact word or phrase, for synonymous words, for partial words, or for a specific word, and the system will check the database for certain information. (The system searches the following to try to match what you’ve entered:  treating specialty, ward, patient name and SSN, movement, reviewer name, attending physician name, comments, custom notes, and admitting diagnosis.  If the admitting physician name has been manually entered in the custom notes or comments fields, the search will find it). 
7.2.4 Filtering Reviews by Date 
To filter by Date

196. Click on the Date filter checkbox to activate it.

197. Select a date from the Start Date dropdown by clicking on it. (Start Date is from 12:00a.m. that day)
198. Select a date from the End Date dropdown by clicking on it. (End Date is until 11:59p.m. that day)

199. Click the <Find> button and the results will display in a table.
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  To select only one day, select the same date for the Start and End Date fields. Entering the Start Date only will give you the start date and everything after. Entering the End Date only will retrieve everything up to, and including, the end date.
7.2.5 Filtering Reviews by Reviewer 
To filter by Reviewer

200. Click on the Reviewer filter checkbox to activate it.The name of the individual who is logged into NUMI will display in the dropdown, by default.
201. Select another option from the dropdown by clicking on it OR

202. Select “All” to see all (regardless of whether a reviewer has been assigned or not) OR

203. Click the <Find> button and the results will display in a table.

7.2.6 Filtering Reviews by Attending

To filter by Attending

1. Click on the Attending filter checkbox to activate it.
2.  Select an Attending from the dropdown list by clicking on it OR
3. Select “All” to see the Attendings for all reviews  OR
4. Click the From VistA checkbox to see Attendings from VistA  OR
5. Click the Corrected checkbox to see all Attendings that were corrected after coming across to NUMI from VistA.
6. Click the <Find> button and the results will display in a table.

7.2.7 Filtering Reviews by Ward 
To filter by Ward

204. Click on the Ward filter checkbox to activate it.

205. Select a Ward from the list by clicking on it. To select multiple Wards, click on one, then hold the <Ctrl> key down and click on others. You can also press and hold the <Shift> key down to select a block of Wards.
206. Click the <Find> button and the results will display in a table.
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  There may be instances where you may expect to see a particular ward in the Ward dropdown, but it does not display. Ward lists are populated as movements for those wards occur. For example, a patient you are looking for has been in a bed for awhile and has not had any movements. Their information has not been picked up by the overnight synchronizer yet because there weren't any qualifying movements. While you cannot manually add a ward to the dropdown, you can use the Sync With VistA feature (please see Section 7.6 for more information) to search for a patient that you know is in a particular ward. Once their information has been synchronized and pulled into NUMI, that ward will display in the Wards dropdown.
7.2.8 Filtering Reviews by Service/Specialty/Status 
To filter by Service/Specialty/Status
207. Click on the Service/Specialty/Status filter checkbox to activate it.

208. Select options from the Service and/or Specialty and/or Status dropdowns by clicking on them.

209. Click the <Find> button and the results will display in a table.

7.2.9 Filtering Reviews by Review Type
To filter by Review Type
210. Click the Review Type filter checkbox to activate it.

211. Select an option from the dropdown by clicking on it.
212. Click the <Find> button and the results will display in a table.

7.3 Dismissed Patient Select Option XE "Dismissed Patient Select Option" 
This feature opens the Dismissed Patient Select screen. This is where patient stays that were dismissed from the Patient Selection screen will display. The screen contains the same filters that appear on the Patient Selection screen. Section 3.1 and Section 2.1.11 describe the use of these filters. The Review column and hyperlinks have been removed from the screen. The hyperlinked patient name now functions as the Review hyperlink. The Update Stays button has been renamed to Dismiss Stays. For more information about dismissing patient stays, please see Section 3.2. 

When the screen opens, a series of filters will display. The Date checkbox will be pre-selected, as will the Start Date and End Date checkboxes. A 1 week date range, to include the last day of the week, will also be pre-populated. The default Start and End dates will appear as the last week, even after clicking the Reset button, but each time they appear on the screen, these dates can be changed. (Figure 95) After obtaining search results, this screen could potentially display several thousand stays, so paging features have been built into it so you can view next, previous, first and last pages, and indicate how many rows of results you would like to see in each page of the table. Please see Section 2.1.21 for more information). 
The following informational message displays on the screen under the Find and Reset buttons: “Click FIND to list all dismissed stays meeting the filters specified above. To create a different stay list, click RESET, select your filter criteria and click FIND”.
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  “Non-reviewable” Treating Specialties (i.e.,  Observation, Domiciliary, Nursing Home, Rehab) will be intercepted as they come from VistA into NUMI, and automatically moved to the Dismissed Patient Select screen. Each evening, treating specialties that are not reviewable in NUMI will automatically be marked “inactive” and moved to the Dismissed Patient Stay screen after the information is sent to NUMI from VistA. (“Inactivated” stays will not appear on the Patient Selection screen unless a review is performed on them).  To identify stays that are not reviewable, the system looks for one of the following in the Treating Specialty description: OBS, DOM, NH, OUTPATIENT, REHAB. The system then sets the stays to ‘dismissed’ and moves them to the Dismissed Patient Stay screen. This is a scheduled job that will run daily. As the synchronizer runs throughout the day, there is a chance for additional non-reviewable specialties to appear in NUMI.
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  While working on the screen, you may see a message in red text advising there was a problem loading the webpage (Figure 18). Refreshing your browser will reload the webpage and display the NUMI screen.   

To work with the Dismissed Patient Select option

1. Click on the Tools dropdown.

2. Select the <Dismissed Patient Select> option by clicking on it and the Dismissed Stays screen will display, as shown in Figure 95.  

3. Select the desired search filters and click the <Find> button. (If there are no dismissed movements, ‘No Records Found’ will display on the screen).
4. After the results display, to see a particular patient stay, click on the hyperlinked patient name in the Patient Name column. (The Review hyperlink and column have been removed from the screen).
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  Once a patient review has been performed, the patient’s name will be removed from the Dismissed Patient Select screen and will re-display on the Patient Selection screen.  
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Figure 95: Dismissed Stays screen with 1 week default date range
After obtaining search results on the Dismissed Stay screen, when you click on the Reset button the system will restore all fields to their default values, except the 1 week default date range.  The fields and default values are:

· Date – Checkbox selected and defaults with a 1 week range (this timeframe keys off the Next Review Date)  

· Reviewer – Checkbox not selected and will display the logged in user’s name  

· Ward – Checkbox not selected and defaults to All

· Treating Specialty and Service – Checkbox not selected and defaults to All

· Movement Type – Checkbox not selected and no default values display

· Patient Search – Checkbox not selected and no default values display

7.4 Free Text Search Patient Option XE "Free Text Search Patient Option" 
This feature lets you type information in and search by exact words, similar words, partial words or specific words. You can filter by Date, Reviewer, Ward, Treating Specialty and Service, Movement and Patient Search. When you search using free text, the system will check for certain types of information.  
To work with the Free Text Search Patient option

213. Click on the Tools dropdown.

214. Select the <Free Text Search Patient> option by clicking on it and the Free Text Search Patient screen will display, as shown in Figure 96.  (See Section 2.1.11 for more information about how to use NUMI filters, and Section 7.2.3 for more information about using the free text search options). 
215. To select a patient for review from the Free Text Search screen, just click on the hyperlinked name of the patient. (The Review hyperlink and column have been removed from the screen).

[image: image193.emf]
Figure 96: Free Text Search Patient screen
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  The NUMI free text search will search the following to try to match what the user enters: treating specialty, ward, patient name and SSN, movement type, reviewer name, attending physician name, and admitting diagnosis. 
7.5 Physician UM Advisor Worklist Option XE "Physician UM Advisor Worklist Option" 
This feature opens the Physician UM Advisor Review Page. (Figure 97) This is where Physician UM Advisors will be able to access and work on the reviews that have been assigned to them. (See Chapter 1 for more information about this screen).
To work with the Physician UM Advisor Review Page
216. Click on the Tools dropdown.

217. Select the <Physician UM Advisor Worklist> option by clicking on it.

218. The Physician UM Advisor Review Page will open. If a Physician UM Advisor has reviews assigned to them, the reviews will display in a table. 
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  Only reviews with ‘Don’t Meet Criteria’ status will go to the Physician UM Advisor Worklist.
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Figure 97: Physician UM Advisor Review Page screen

7.6 Sync with VistA Option XE "Sync with VistA Option" 
This feature lets you synchronize stay information between VistA and NUMI. An automatic feed containing admissions, ward transfers, discharges and provider and specialty changes is sent to NUMI from VistA at the top of each hour during the day, and at midnight.  Stays that were dismissed the previous day will not redisplay in the Patient Selection worklist after the midnight synchronizer information feed occurs.  (Note: if information changes in VistA, the information in NUMI will be overwritten / overlaid in the next feed. It should also be noted that resynching with VistA will always update the stay data, but the review data will not be overwritten). When you synchronize a patient or several patients, you are bringing VistA information on those patients into NUMI and placing those patient stays in your Patient Selection list.

With the Sync With VistA feature, you do not need to wait for a feed. You can retrieve and synchronize information on-demand. This feature comes in handy when you know a patient has been admitted to the hospital (or transferred to another Ward – a frequent occurrence during the day) and is in VistA, but you do not see them in NUMI yet. As an added convenience, the table on the screen includes Ward, Specialty and Admitting Diagnosis information to help you identify which patients need to be “synched” onto the Patient Selection list.
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  You can only synchronize by Date OR by Checkin ID OR by Patient on this screen. In addition, please note that if you only enter a date without a patient name, everything for that date will be synchronized. 
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  You must click on the Date, Checkin ID or Patient Search radio buttons in order to activate the search filters on the Sync With VistA screen. For more information about using the filters in NUMI, please see Section 3.1 in this guide.
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  While working on the Sync With VistA screen, you may see a message in red text advising that the server is busy (Figure 98) . Perform your last action (e.g.,  re-click a button; re-select a hyperlink) to retry.   

[image: image200.emf]
Figure 98: Server Busy Error Message
To work with the Sync with VistA option

1. Click on the Tools dropdown.
2. Select the <Sync with VistA> option by clicking on it, and the Sync with VistA screen will display.
3. Click the Date radio button, and select or type the desired date in the Movement Start Range field. If you type in the date, use the format mm/dd/yyyy.
4. Select a specific time range, if desired, by clicking in the Hour fields and entering the desired hours (e.g.,  06:00 thru 11:00) OR
5. Click the Patient Search radio button, type in a Patient name (in <Lastname, Firstname> format) and click the <Find Patient> button. Then single-click on a patient name in the result window to select it. If you do not select a patient, the message “You must select a patient.” will display (Figure 102) OR
6. Click the Checkin ID radio button and type in a Checkin ID, if you know it.
 (You can always search by Date or Name and the Checkin ID will be displayed in the search results, as shown in Figure 99). If the patient isn’t in NUMI but has an inpatient stay in VistA, you can add them to NUMI by searching for them by date range or patient name. If the patient doesn’t have any inpatient stays in VistA, they will display in the search by patient list but no stays will be returned. If the patient’s admission is not in NUMI, you can synchronize with VistA by entering the Admission date, which will add the Admission movement to NUMI. 
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   If NUMI still can’t find the admission, you may need to get the VistA Patient Movement file admission movement’s internal entry number (IEN) from your local IRM and enter it as the Check In ID, then click <Find Stays in VistA> and, when the list appears, click on the box to the left of the ones you want to add to NUMI and press <Synchronize Stays>.  Note: The number displayed as the Movement ID on the Patient History/worksheet screen corresponds to the VistA Patient Movement IEN if the movement already appears in NUMI.
7. Click the <Find Stays in VistA> button.
8. When the search results display, click on the checkboxes in the far left hand column in the row for each patient stay you wish to synchronize into NUMI and display on the Patient Selection list. (Figure 100)
9. Click the <Synchronize Stays> button.
10. The message: “Synchronized <number> stays for site <site number>” will display on the screen. (Figure 101)
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Figure 99: Sync With VistA search results screen
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Figure 100: Stays selected for Synchronizing
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Figure 101: Synchronized Stays confirmation message
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Figure 102: Patient Search Message
7.7 Patient Stay Admin Option XE "Patient Stay Admin Option" 
This option can only be used by NUMI Administrators. While non-Administrator users will see this option displayed in the Tools menu, selecting it will display an error message (i.e.,  “You are not authorized to administer patient stays at this site”). If a VistA patient stay is entered in the NUMI database and VistA subsequently deletes the stay, NUMI will display an “invalid stay” message when the NUMI user clicks the review link for the deleted stay.  Additionally, NUMI will move the NUMI patient stay record to the Patient Stay Admin screen. NUMI Administrators can use the Patient Stay Admin screen to verify the status of the stay in VistA and delete NUMI patient stay records that are no longer in VistA.
Here is some background information about how this process works:

Patient Stay Movements are entered into VistA and then synchronized into the NUMI database. Every time a stay is touched in NUMI, NUMI goes back to VistA to update the stay record with any changes in VistA. If nothing is returned from VistA when the record is requested, then NUMI marks its record of the stay as “invalid”, and removes it from the Patient Selection worklist. It is put in a limbo state, but not deleted. NUMI Administrators can then review the invalid stays using this screen. Selecting them from the table will cause NUMI to again try to retrieve them from VistA. If it cannot, the Administrator can delete the patient stay from NUMI. If NUMI can retrieve the stay, then the Administrator has the option of selecting the Restore button to reactivate the stay.
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 Invalidated stays are periodically removed automatically from the Patient Stay Admin screen.  NUMI Administrator users will still be able to manually delete stays from the screen, as described in Section 7.7.2. 

To access the Patient Stay Admin feature
1. Click on the Tools dropdown.

2. Select the <Patient Stay Admin> option. 
3. The Patient Stay Admin page displays with a list of invalidated stays. (Figure 103).

[image: image207.emf]
Figure 103: NUMI Patient Stay Admin screen

7.7.1 Finding Patient Stays that were Removed from VistA

To find patient stays that were removed from VistA
1. Choose search filters by clicking on the checkboxes in the filter headers. This will activate the options in each filter. (For more information about NUMI filters, please see Section 2.1.11).
2. Choose the desired options from each filter and click the <Find> button. 
3. A list of patient stays matching your search criteria will display in a table.  If your search produces no results, No Records Found will display. 

7.7.2 Deleting Patient Stays that were Removed from VistA
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  If a patient stay is ‘invalidated’ (i.e.,  the patient was admitted and subsequently the admission was cancelled and removed from VistA), there is still a stay created in NUMI when the synchronizer first picks up the patient. The invalidated stay’s status is changed to Dismissed and it is moved to the Dismissed Patient Select screen (see Section 7.3) where it will be available for retrieval, if necessary.  NUMI Administrators and Reviewers can delete any invalidated patient stay. 

To delete a patient stay that was removed from VistA
219. Click the Validate hyperlink beside the stay you wish to delete.

220. Click the <OK> button when this message displays: “Stay <number> for patient <patient name> can not be retrieved from VistA and may be invalid. Please Delete the stay, or try again later”.

221. Click the <Delete> button in the patient history portion of the screen. 

222. The patient stay will be deleted.
7.7.3 Restoring a Patient Stay

To restore a patient stay

1. Click the Validate hyperlink beside the stay you wish to restore.

2. Click the <OK> button when this message displays: “Stay <number> for patient <patient name> has been retrieved from VistA. Please click on the Restore button to set it as valid in NUMI.” (Figure 104). 

[image: image209.emf]
Figure 104: Stay retrieval advisory message.
3. Click the Restore button in the center of the screen (illustrated in Figure 105).
4. The screen will refresh and the patient record will no longer display in the table.
5. The patient will display in the table on the Patient Selection screen.

[image: image210.emf]
Figure 105: Patient Stay Admin screen with Restore button displayed
7.8 Logout Option XE "Logout Option" 
This feature will take you to the logout screen.

To access the Logout option

223. Click on the Tools dropdown.

224. Select the <Logout> option by clicking on it.

225. The Logout screen opens. (See Chapter 12 for more information about logging out of the NUMI application).
8 REPORTS Menu XE "REPORTS Menu" 
This chapter describes the Reports Menu. (Figure 106) This is where you can generate a variety of on-demand reports that can be printed out on your local printer or exported to an Excel spreadsheet and printed from there. Some reports were designed to display in landscape orientation (vs portrait) – those display an (L) in the menu dropdown. Marking those reports that way was intended to indicate that you should print them out in landscape mode.  Some reports have less ‘real estate’ than others, and printing those particular reports out in Landscape orientation produces nicer output.

For convenience, the reports are numbered 1 thru 10. This eliminates the need to remember the exact name of any particular report. The Reports Menu dropdown is on the menu bar located along the top of most  NUMI screens. 
It is important to note that the reports will not generate until the <Find> button is clicked. In addition, the report search filters are ‘sticky’. This means that if you choose dates, radio buttons or dropdown options, your choices will remain populated until you either manually change the dates or click on the calendar and then click on ‘Clear Date’, or select different radio buttons or dropdown options - or leave the report altogether. If you leave a report and then come back to it, all of the search filters will be reset to the original settings. 
Based on the Admission Review Type selection that is made on the Primary Review screen, the output on the reports will vary. Please see Section 5.7 for more information about working with admission review types.  Each report (with the exception of Reports #3 and  #7)  will have an Admission Review Types dropdown.   *Note: Only the Hosp Acute Adm-Traditional Criteria (formerly called Hospital Acute Admission), Hosp Acute Adm – Condition-Specific Criteria (Admission reviews only), Observation Converted to Hospital Admission, Conversion to New Condition-Specific Criteria (Admission reviews only), BH Initial Review, Transfer to Higher Level of Care and Transfer to/from Acute Care and BH options are selectable when entering reviews on the Primary Review screen. Other review types are included as selections when generating reports because they were used in previous versions of NUMI.
Reports #s 1, 2, 4, 5, 6, 8, 9, 11 and 12 will display these general Admission Review Type options, in the order listed:

· All Admission Reviews

· Hosp Acute Adm – Traditional Criteria
· Hosp Acute Adm – Condition-Specific Criteria  
· Observation Converted to Hospital Admission  
· Conversion to New Condition-Specific Criteria  
· BH Initial Review 
· Transfer to Higher Level of Care

· Transfer to/from Acute Care and BH

· Admission Review - Type Unknown

Report #10 will display the Admission Review Type options below, in the order listed:

· Hosp Acute Adm – Traditional Criteria

· Hosp Acute Adm – Condition-Specific Criteria

· Observation Converted to Hospital Admission

· BH Initial Review

The contents of the reports will display as follows, when the various options are selected:

· If the All Reviews filter option is selected, the report will display all review types
· If the All Admissions fiter option is selected, the report will display Hospital Acute Admission, Admission Review: Type Unknown, BH Initial Review, Transfer to Higher Level of Care and Transfer to/from Acute Care and BH reviews
· If the Not an Admission Review filter option is selected, the report will display all Continued Stay and BH Concurrent review types
· If the Hosp Acute Adm – Traditional Criteria filter is selected, the report will display Hosp Acute Adm – Traditional Criteria and BH Initial reviews

· If the Hosp Acute Adm – Condition-Specific filter is selected, the report will display Hosp Acute Adm – Condition-Specific reviews
· If the Observation Converted to Hospital Admission filter is selected, the report will only display reviews for observation patients that were not discharged within the required 24 hour period, then were admitted to acute care (Note: this filter is not available on Reports #3 and #7)

· If Conversion to New Condition-Specific Criteria filter is selected, the report will display  Conversion to New Condition-Specific Criteria  reviews
· If the BH Initial Review filter is selected, the report will only display BH Initial reviews

· If the Transfer to Higher Level of Care filter is selected, the report will only display Transfer to Higher Level of reviews

· If the Transfer to/from Acute Care and BH filter is selected, the report will only display Transfer to/from Acute Care and BH reviews

· If the Admission Review - Type Unknown filter is selected, the report will only display Admission Review:Type Unknown reviews

In Release 1.1.13, Enhanced Reporting has been added to NUMI. For information about this option and the underlying reports and when they are available for selection, please see Section 8.13.
The NUMI reports are listed in Table 12.
Table 12: Reports Menu list of reports

	FEATURES

	Report #1 - Percent Met/Not Met Report

	Report #2 - Reasons for Admission Reviews Not Meeting Report

	Report #3 - Reasons for Continued Stay/Concurrent Reviews Not Meeting Criteria Report

	Report #4 - Summary RLOC Reasons Report

	Report #5 - Patient Reviews Met/Not Met Report

	Report #6 - Patient Reviews Met/Not Met ‘Custom’ Report

	Report #7 - Patient Detail Report

	Report #8 - Physician UM Advisor Reviews Report

	Report #9 - Physician UM Advisor Response Report

	Report #10 - Unscheduled Readmits in Less Than 30 Days Report

	Report #11 - RLOC Aggregate Report

	Report #12 – Clinical Comments Detail Report

	Enhanced Reporting
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Figure 106: Reports Menu
8.1 Report #1 XE "Report #1"  - Percent Met/Not Met Report
This report summarizes the reviews that Meet and Don’t Meet criteria, displayed in descending sort order within the Admission and Continued Stay categories. The count of reviews on the report output will match the count of saved/locked reviews that display on the Review Selection screen. You can generate the report by Attending MD, Reviewer, Service Section, Treating Specialty and Ward Location, and print it out on your local printer or export it to Excel. (If you run this report and any reviews have a blank Review Type, those reviews will display at the top of the report, as illustrated in Figure 114). The grand total of the report includes the count of reviews with blanks). 
The following bulleted instructional text has been added to the report filter screen:

· In the Admission Review Type box, Admission Review-Type Unknown contains admission reviews that were saved prior to the v 1.1.12 release

To generate the report
226. Click the Reports menu dropdown.
227. Click on 1: Summary Met/Not Met. The search filters will display. (Figure 107)
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Figure 107: Percent of Reviews Meeting Criteria filters
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228. Figure 108: Admission Review Types list displaySelect an option from the Current Lookup Site dropdown by clicking on it.
229. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.

230. Select a Review By radio button by clicking on it. 

231. A corresponding dropdown will display for the radio button you chose (not shown in Figure 107). 

232. Select an option from the dropdown by clicking on it. 

233. Select a single option from the CERMe Review Types pick list by clicking on it.  (If you select Admission or BH Initial Review, the Admission Review Types pick list will display. (Figure 108).

234. Select one or more options by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).

235. Be sure to click the <Find> button after you select ALL of the report parameters. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 

236. The report output will display, as illustrated in Figure 109.
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Figure 109: Percent of Reviews Meeting Criteria output
237. To print, click the <Print Preview> button. 
238. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 110)
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Figure 110: Percent of Reviews Meeting Criteria printout

239. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
240. A File Download dialog box may display indicating: “Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file”. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111)  If it does, click the <Open> button.
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Figure 111: Export to Excel download advisory
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Figure 112: Excel format dialog box

241. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.

242. The report will be displayed, as illustrated in Figure 113. 
243. Select the <File> dropdown in Excel and click on <Print> to print it out. 
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Figure 113: Percent of Reviews Meeting Criteria spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

[image: image219.png]Live search

Fie

Edt Vew Favores Tooks

Help

R T——

1. Percent of Reviews Meeting Criteria By Reviewer

Current Lookup Site:

ZZalbany

 Inthe Admission Review Type box, Admission Review-Type Unknown contains admission reviews that are not hospital admission reviews that were saved prior to the v.1.1.12 release.

Review By Reviewer CERMe Review Types Review Date
= Start Date
attending 1D [DAVULURILATHA [Admission =
& Reviewer |GROOIS, ANTHONY BH Concurrent Review
HEUER CIDY o il Reviews
© [Senice Section HOLIES MARY L Continued Stay End Date
[ rreating Specialty e o =
[ ward Location RED ADREA L 8
Find
Percent of Reviews Meeting Criteria By Reviewer
(Ste: 2ZAbany;
Reviewer. Al
CERle Review Types: Al Reviews )
Humber
Reiewer = liecing g ttestng Hecin
Type 2 Mesting Criteria 2
Criteria Criteria
Criteria
VIHELESS, CAROLYN o 1 1 000% 100.00%
Subtotal o 1 1 000% 100.00%
HEUER, CHDY adm 1 1 2 s0.00% s0.00%
VAN ORDER, MARY adm 2 o 2 100.00% 000%
VANTEST, SUZANNE adm o 1 1 000% 100.00%
VIHELESS, CAROLYN adm B 2 7 3% EEN
Subtotal Adm s 4 ” s6.57% EE
HEUER, CHDY s 1 o 1 100.00% 000%
HOLWES, WARY L s 1 o 1 100.00% 000%
VANTEST, SUZANNE s o 2 2 000% 100.00%
VIHELESS, CAROLYN s B B " 7273% 21214
Subtotal Cs. 0 5 15 s6.57% EE
VIHELESS, CAROLYN o 2 o 2 100.00% 000%
Subtotal DIC 2 o 2 100.00% 000%
Grand Total B 0 El s6.57% EE
Print Preview Export to Excel

Dane.

@ et





Figure 114: Percent of Reviews Meeting Criteria showing blank Review Type
8.2 Report #2 XE "Report #2"  - Reasons for Admission Reviews Not Meeting Criteria Report
This report will show you a distribution listing of Admission reviews not meeting criteria, sorted in descending order within each subcategory of reasons. You can generate the report by Attending MD, CERMe Review Types, Treating Specialty or Ward Location, and print it out on your local printer or export it to Excel.
The following bulleted instructional text has been added to the report filter screen:

· In the Admission Review Type box, Admission Review-Type Unknown contains admission reviews that were saved prior to the v 1.1.12 release

To generate the report

1. Click the Reports menu dropdown.

2. Click on 2: Summary Adm Reasons. The search filters will display. (Figure 115)
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Figure 115: Reasons for Admission Reviews Not Meeting Criteria filters

3. Select an option from the Current Lookup Site dropdown by clicking on it.

4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
5. Select a Review By radio button by clicking on it. 
6. A corresponding dropdown will display for the radio button you chose (not shown in Figure 115). 
7. Select options from the dropdown by clicking on them. 

8. If you choose the CERMe Review Types radio button, a CERMe Review Types dropdown will display. (Figure 116) The system will only let you select a single option from this dropdown.  When an option is selected, the Admission Review Types pick list will display.  (Figure 108) Select one or more options by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).
9. Be sure to click the <Find> button after you select ALL of the report parameters. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
10. The report output will display, as illustrated in Figure 116.
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Figure 116: Reasons for Admission Reviews Not Meeting Criteria output

11. To print, click the <Print Preview> button. 
12. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 117)
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Figure 117: Reasons for Admission Reviews Not Meeting Criteria printout
13. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
14. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
15. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed. 
16. The report will display, as illustrated in Figure 118. 
17. Select the <File> dropdown and click on <Print> to print it out.
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Figure 118: Reasons for Admission Reviews Not Meeting Criteria spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

8.3 Report #3 XE "Report #3"  - Reasons for Continued Stay/Concurrent Reviews Not Meeting Criteria Report
This report will show you Continued Stay/Concurrent Reviews that did not meet criteria. You can generate the report by Attending MD, CERMe Review Type, Treating Specialty or Ward Location, and print it out on your local printer or export it to Excel.

To generate the report

1. Click the Reports menu dropdown.

2. Click on 3: Summary CS Reasons. The search filters will display. (Figure 119)
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Figure 119: Reasons for CS/Concurrent Reviews Not Meeting Criteria filters

3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
5. Select a Review By radio button by clicking on it. 
6. A corresponding dropdown will display for the radio button you chose (not shown in Figure 119). 
7. Select options from the dropdown by clicking on them. 

8. If you choose the CERMe Review Type radio button, a CERMe Review Type dropdown will display with non-admission options. (Figure 120)  The system will only let you select a single option from this dropdown.  

9. Select an option from the dropdown by clicking on it.

10. Be sure to click the <Find> button after you select ALL of the report parameters. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
11. The report output will display, as illustrated in Figure 121.
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Figure 120: Non-Admission CERMe Review Type options
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Figure 121: Reasons for CS/Concurrent Reviews Not Meeting Criteria output

12. To print, click the <Print Preview> button. 
13. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 122)
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Figure 122: Reasons for CS/Concurrent Reviews Not Meeting Criteria printout

14. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
15. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
16. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.  
17. The report will display, as illustrated in Figure 123. 
18. Select the <File> dropdown and click on <Print> to print it out.
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Figure 123: Reasons for CS/Concurrent Reviews Not Meeting Criteria spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

8.4 Report #4 XE "Report #4"  - Summary RLOC Reason Report

This report provides a report of Recommended Level Of Care Reasons for Not-Met reviews and is generated in landscape orientation. You can print the report out on your local printer or export it to Excel.

The following bulleted instructional text has been added to the report filter screen:

· In the Admission Review Type box, Admission Review-Type Unknown contains admission reviews that were saved prior to the v 1.1.12 release

To generate the Report

1. Click the Reports menu dropdown.

2. Click on 4: Summary RLOC Reason (L). The search filters will display. (Figure 124)
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Figure 124: Summary RLOC Reason Criteria filters

3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
5. Click on the Service Section dropdown. 
6. Select an option by clicking on it. To select more than one option, hold down the <Ctrl> key before clicking on each one.
7. Select an option in the Treating Specialty dropdown by clicking on it. To select more than one option, hold down the <Ctrl> key before clicking on each one.
8. Select an option from the CERMe Review Type pick list by clicking on it. If you select Admission or BH Initial Review, the Admission Review Types dropdown will display. (Figure 108)
9. Click the Admission Review Types dropdown. Select one or more options by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).
10. Be sure to click the <Find> button after you select ALL of the report parameters. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
11. The report output will display, as illustrated in Figure 125.
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Figure 125: Summary RLOC Reason output

12. To print, click the <Print Preview> button. 
13. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 126)
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Figure 126: Summary RLOC Reason printout

14. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
15. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
16. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.   
17. The report will display, as illustrated in Figure 127. 
18. Select the <File> dropdown and click on <Print> to print it out.
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Figure 127: Summary RLOC Reason spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

8.5 Report #5 XE "Report #5"  - Patient Reviews Met/Not Met Report

This is a basic patient level report, generated in landscape orientation and sorted in ascending alphabetical order by patient last name within Met and Not Met subcategories. The reviews on the report output will match the saved/locked reviews that display on the Review Selection screen. You can generate the report by Attending MD, Reviewer, Treating Specialty, Ward Location and Service Section, and print it out on your local printer or export it to Excel. 

The following bulleted instructional text has been added to the report filter screen:

· In the Admission Review Type box, Admission Review-Type Unknown contains admission reviews that were saved prior to the v 1.1.12 release

To generate the Report

1. Click the Reports menu dropdown.

2. Click on 5: Pt Reviews Met/Not Met (L). The search filters will display. (Figure 128)
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Figure 128: Patient Reviews Met/Not Met filters

3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
5. Select a Review By radio button by clicking on it. 
6. A corresponding dropdown will display for the radio button you chose (not shown in Figure 128). 
7. Select an option by clicking on it. To select more than one option, hold down the <Ctrl> key before clicking on each one.

8. Select an option from the CERMe Review Types pick list by clicking on it. If you select Admission or BH Initial Review, the Admission Review Types dropdown will display. (Figure 108)   
9. Select one or more options from the Admission Review Types dropdown by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).
10. Be sure to click the <Find> button after you select ALL of the report parameters. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
11. The report output will display, as illustrated in Figure 129.
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Figure 129: Patient Reviews Met/Not Met output

12. To print, click the <Print Preview> button. 
13. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 130)
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Figure 130: Patient Reviews Met/Not Met printout

14. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
15. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
16. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.  

17. The report will display, as illustrated in Figure 131. 
18. Select the <File> dropdown and click on <Print> to print it out.
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Figure 131: Patient Level Met/Not Met spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

8.6 Report #6 XE "Report #6"  - Patient Reviews Met/Not Met ‘Custom’ Report

This report is similar to the Patient Reviews Met/Not Met Report, but this report includes the information that has been typed into the Custom field on the Primary Review screen. The report is generated in landscape orientation. You can generate the report by Attending MD, Reviewer, Treating Specialty, Ward Location and Service Section, and print it out on your local printer or export it to Excel.

The following bulleted instructional text has been added to the report filter screen:

· In the Admission Review Type box, Admission Review-Type Unknown contains admission reviews that were saved prior to the v 1.1.12 release

To generate the report

1. Click the Reports menu dropdown.

2. Click on 6: Pt Reviews Met/Not Met Custom (L).  
3. The search filters will display. (Figure 132)
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Figure 132: Patient Reviews Met/Not Met Custom filters

4. Select an option from the Current Lookup Site dropdown by clicking on it.
5. Select a Review By radio button by clicking on it. 
6. A corresponding dropdown will display for the radio button you chose (not shown in Figure 132).

7. Select an option by clicking on it. To select more than one option, hold down the <Ctrl> key before clicking on each one.

8. Select an option from the CERMe Review Types pick list by clicking on it. If you select Admission or BH Initial Review, the Admission Review Types dropdown will display.  (Figure 108)
9. Select one or more options from the Admission Review Types dropdown by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).
10. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
11. Be sure to click the <Find> button after you select ALL of the report parameters. 
12. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
13. The report output will display as illustrated in Figure 133.
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Figure 133: Patient Reviews Met/Not Met Custom output

14. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
15. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
16. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.  

17. The report will display, as illustrated in Figure 134. 
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Figure 134: Patient Reviews Met/Not Met Custom spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

18. To print, click the <Print Preview> button. 
19. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 135)
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Figure 135: Patient Reviews Met/Not Met Custom printout

8.7 Report #7 XE "Report #7"  - Patient Details Report
This report shows all reviews saved for a specific patient for a selected time period, sorted chronologically by Service Date Reviewed with earliest date first and most recent date last. The report is generated in landscape orientation. You can print the report out on your local printer or export it to Excel.
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  When searching for patients by Patient Name, please use lastname,firstname  format (e.g.,  Smith,John) without putting a space after the comma, as depicted in Figure 136.  For a more general search, you may also type in the patient’s last name (e.g.,  Smith). You will not get any results if you search for patients using their last initial + last 4 SSN, or their last 4 SSN.
To generate the Report

1. Click the Reports menu dropdown.

2. Click on 7: Reviews for One Pt (L). The search filters will display. (Figure 136)
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Figure 136: Patient Details filters
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Figure 137: Patient Details filters with patient name populated

3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
5. Type a patient’s name in in the Patient Name field, as shown in Figure 137. (You may also type in a partial name, e.g.,  Van).
6. Click the <Find Patient> button.
7. When the list of results displays in the window, single –click on a name.  
8. Be sure to click the <Find> button after you select ALL of the report parameters. 
9. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
10. The report output will display for the patient you specified, as illustrated in Figure 138.
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Figure 138: Patient Details output

11. To print, click the <Print Preview> button. 
12. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 139)
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Figure 139: Patient Details printout

13. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
14. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
15. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.   
16. The report will display, as illustrated in Figure 140. 
17. Select the <File> dropdown and click on <Print> to print it out.
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Figure 140: Patient Details spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

8.8 Report #8 XE "Report #8"  - Physician Reviews Report

This report will show you a patient-level listing of reviews that were sent to Physician UM Advisors and their responses (i.e.,  Agree or Disagree). The report is generated in landscape orientation. You can print the report out on your local printer or export it to Excel.
The following bulleted instructional text has been added to the report filter screen:

· In the Admission Review Type box, Admission Review-Type Unknown contains admission reviews that were saved prior to the v 1.1.12 release

To generate the report

1. Click the Reports menu dropdown.

2. Click on 8: Physician Reviews (L). The search filters will display. (Figure 141)
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Figure 141: Physician Reviews filters

3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Select an option from the Physician UM Advisor dropdown by clicking on it.
5. Select an option from the CERMe Review Types pick list by clicking on it. If you select Admission or BH Initial Review, the Admission Review Types dropdown will display.  (Figure 108)
6. Select one or more options from the Admission Review Types dropdown by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).

7. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
8. Be sure to click the <Find> button after you select ALL of the report parameters. 
9. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
10. The report output will display, as illustrated in Figure 142.
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Figure 142: Physician Reviews output

11. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
12. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
13. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.   
14. The report will display, as illustrated in Figure 143. 
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Figure 143: Physician Reviews spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

15. To print, click the <Print Preview> button. 
16. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 144)
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Figure 144: Physician Reviews printout

8.9 Report #9 XE "Report #9"  - Physician UM Advisor Response Report

This report will show you a patient-level listing of reviews that were sent to Physician UM Advisors, their response (i.e.,  Agree or Disagree) and their comments. The report generates in landscape orientation. You can print the report out on your local printer or export it to Excel.

The following bulleted instructional text has been added to the report filter screen:

· In the Admission Review Type box, Admission Review-Type Unknown contains admission reviews that were saved prior to the v 1.1.12 release

To generate the Report

1. Click the Reports menu dropdown.

2. Click on 9: Phy UM Advisor Response (L). The search filters will display. (Figure 145)
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Figure 145: Physician UM Advisor Response filters

3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
5. Click the Physician UM Advisor dropdown. Click on the desired Physician UM Advisor name. 
6. Select an option from the CERMe Review Type pick list by clicking on it. If you select Admission or BH Initial Review, the Admission Review Types dropdown will display.  (Figure 108)
7. Select one or more options from the Admission Review Types dropdown by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).

8. Click the Treating Specialty dropdown. Select an option by clicking on it. To select multiple options, click and hold down the <Ctrl> key before clicking on them.
9. Be sure to click the <Find> button after you select ALL of the report parameters. 
10. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
11. The report output will display, as illustrated in Figure 146.
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Figure 146: Physician UM Advisor Response output

12. To print, click the <Print Preview> button. 
13. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 147)
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Figure 147: Physician UM Advisor Response printout

14. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
15. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
16. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.  

17. The report will display, as illustrated in Figure 148. 
18. Select the <File> dropdown and click on <Print> to print it out.
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Figure 148: Physician UM Advisor Response spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

8.10 Report #10 XE "Report #10"  - Unscheduled Readmits in Less than 30 Days Report

This report will let you see a listing of all reviews of unscheduled readmits within the last 30 days, sorted in ascending alphabetical order by patient name. The report generates in landscape orientation. You can print the report out on your local printer or export it to Excel.

To generate the report

1. Click the Reports menu dropdown.

2. Click on 10: Unsched Readmission (L). The search filters will display. (Figure 149)
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Figure 149: Unscheduled Readmits in Less than 30 Days filters
3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.
5. Select an option from the CERMe Review Type pick list by clicking on it, and the Admission Review Types dropdown will display.  
6. Select one or more options from the Admission Review Types dropdown by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).

7. Be sure to click the <Find> button after you select ALL of the report parameters. 
8. As soon as you select the <Find> button, you will see report information. If you specify other parameters such as Start and End dates, don’t forget to click on <Find> to generate your specific report. The subtitle on the report will contain the parameters you specify, so double-check that all of your parameters are specified in the sub-title. 
9. The report output will display, as illustrated in Figure 150.
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Figure 150: Unscheduled Readmits in Less than 30 Days output

10. To print, click the <Print Preview> button. 
11. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 151)
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Figure 151: Unscheduled Readmits in Less than 30 Days printout

12. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 
13. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. (Figure 111) If it does, click the <Open> button.
14. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.  

15. The report will display, as illustrated in Figure 152. 
16. Select the <File> dropdown and click on <Print> to print it out.
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Figure 152: Unscheduled Readmits in Less than 30 Days spreadsheet

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.

8.11 Report #11 XE "Report #11"  - RLOC Aggregate Report
This report shows an aggregated listing of recommended levels of care, grouped by Treating Specialty and based on the review entries into NUMI. The report is sorted on the following columns: Service Section (first sort field), Treating Specialty (second sort field), Review Type (third sort field), and Recommended Level of Care (fourth sort field). In addition, the report will display the percentage of reviews for each treating specialty based on the radio button selection, the count of the total number of reviews, and the count subtotals by Treating Specialty, Service, and Review Type for Not-Met reviews. The report generates in landscape orientation. You can print the report out on your local printer or export it to Excel.

To generate the report
1. Click the Reports menu dropdown.

2. Click on 11: RLOC Aggregate (L). The search filters will display, as shown in Figure 153.
3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the date, using the format mm/dd/yyyy.

5. Select a Review By radio button by clicking on it. A list of options within each Review By radio button choice will display when the radio button is selected.
6. Select an option by clicking on it. To select more than one option, hold down the <Ctrl> key before clicking on each one.

7. If you choose CermE Review Types, a CermE Review Types pick list will display.  (Figure 154) The system will only permit you to select one option from the list.  If you choose either Admission or BH Initial Review, the system will display an additional dropdown box - Admission Review Types. (Figure 108) You may select one or more options by clicking on them.
8. Click the <Find> button.

9. The report output will display with the title Recommended Level of Care Aggregate by <review by option>, as illustrated in Figure 155.
10. To print, click the <Print Preview> button. 

11. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 156)

12. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 

13. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. If it does, click the <Open> button.
14. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.  

15. The report will display, as illustrated in Figure 157. 

16. Select the <File> dropdown and click on <Print> to print it out.

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.
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Figure 153: RLOC Aggregate Report filters
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Figure 154: RLOC Aggregate CERMe Review Types filter
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Figure 155: RLOC Aggregate Report output
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Figure 156: RLOC Aggregate Report printout
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Figure 157: RLOC Aggregate Report spreadsheet

8.12 Report #12 XE "Report #12"  - Clinical Comments Detail Report

This report shows all comments that have been entered into NUMI regarding a patient.  The report entries are sorted on the following columns: Patient Name, Review Date and Treating Specialty. The sort order is first by Treating Specialty and then alphabetically.  In addition, the report displays a Grand Total count of the total number of reviews. The report generates in landscape orientation. You can print the report out on your local printer or export it to Excel.

To generate the report

1. Click the Reports menu dropdown.

2. Click on 12: Clin. Comments Detail (L). The search filters will display, as shown in Figure 158.

3. Select an option from the Current Lookup Site dropdown by clicking on it.
4. Click on the Date Being Reviewed Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the dates, using the format mm/dd/yyyy.

5. Click on the Date Review Saved Start Date and End Date calendar icons and select dates by clicking on them. You can also type in the dates, using the format mm/dd/yyyy.

6. Select a Review By radio button by clicking on it. A list of options within each Review By radio button choice will display when the radio button is selected.
7. Select an option by clicking on it. To select more than one option, hold down the <Ctrl> key before clicking on each one.

8. If you select the CermE Review Types radio button, the CERMe Review Types pick list will display. The system will only permit you to select one option from the list. Select an option by clicking on it. If you select Admission or BH Initial Review, the Admission Review Types dropdown will display. (Figure 108)

9. Select one or more options from the Admission Review Types dropdown by clicking on them. (Note: the information that displays on this report when each of the admission review type filter options is selected will vary. Please see Section 5.7 for details).

10. Click the <Find> button.

11. The report output will display with the title Clinical Comments Detail by <review by option>, as illustrated in Figure 159. 
12. To print, click the <Print Preview> button. 

13. When the Print Report preview window opens, select <File> from the menu bar and then select <Print>. If you prefer, you can just right-click in the preview window and click the <Print> option. (Figure 160)

14. To export the report to an Excel spreadsheet, click the <Export to Excel> button. 

15. A File Download dialog box may display indicating: Some files can harm your computer. If the file information below looks suspicious, or you do not fully trust the source, do not open or save this file. You will also see the message: “Would you like to open the file or save it to your computer?” along with Open, Save, Cancel and More Info buttons. If it does, click the <Open> button.
16. Excel will open. Note: if you are using Excel version 2007, you may see a dialog box advising that the file you are trying to open is in a different format than specified by the file extension. (Figure 112) Click the <Yes> button to proceed.  

17. The report will display, as illustrated in Figure 161. 

18. Select the <File> dropdown and click on <Print> to print it out.

Note: After you have downloaded the raw data to EXCEL, the data comes over without totals and subtotals. You may format the size of columns and rows according to your needs. All dates will be expressed in numerical format, so date columns will need to be reformatted into a Date format.
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Figure 158: Clinical Comments Detail Report filters
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Figure 159: Clinical Comments Detail Report output
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Figure 160: Clinical Comments Detail Report printout
[image: image267.png]do-c- o8&

Home | Inset  Pagelayout  Formulas  Data  Review  View  Developer @ -7 x

2 Report_03-21-2011-02-55(1].xs - Microsoft Excel -5 x

T —" Eow  (ows o B [rema s Good newa - e E ] 57 @
152 Copy =
Paste B I U-| - Merge & Center - + |[%8 28| || Conditional Format [Calculation Check Cell Explanatory ... _ _ | Insert Delete Format Sort& Find &
HE pomat e | =] 2 st feiian)) oot o et S e
Ciipboard. 5 Font 5 Alignment 0 Number 0 Styes cells Editing
AL -~ x| Treating Specialty.
s c ) £ £ s H ! 3 K L M N ) ) a R s
[Treating Specialty [patient Name  SSN_ Date of Admission Date Being Reviewed Date Review Saved Met/Not Met Reviewer Clinical Comments
GEN MED JO, POWTESTER 4422 5/15/2009 8/24/2010 8/24/2010 No 'VANTEST, SUZANNE





Figure 161: Clinical Comments Detail spreadsheet

8.13 Enhanced Reporting XE "Enhanced Reporting" 
The option for Enhanced Reporting is located at the bottom of the Reports menu. When you select the Enhanced Reporting option from the Reports menu the system will check to see if your Windows and NUMI credentials match. Please see Section 2.3.1.1 for more information about this. 

Credentials Match

If your credentials match, when you select the Enhanced Reporting option from the Reports menu you will see the list of available reports. An example is shown in Figure 162. 
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Figure 162: Example Enhanced Reporting List
If you login with matching credentials and there are no available enhanced reports to view you will see the message that is shown in Figure 163.
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Figure 163: Enhanced Reporting - no active reports

Credentials Do Not Match

If your credentials do not match, when you select the Enhanced Reporting option from the Reports menu you will see the message depicted in Figure 164. You will then have the option of either updating your network account name in NUMI or logging out and logging back in using your own VA network account.
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Figure 164: Enhanced Reporting Security Warning
8.13.1 Updating your Network Account Name for Enhanced Reporting XE "Updating your Network Account Name for Enhanced Reporting" 
If you wish to update your network account name

1. With the Security Warning message displayed, click on the <Update My Network Account name in NUMI> hyperlink.

2. Your network account name will be updated by the system. This update will not be visible to you. 
3. Click on the Reports menu.

4. Click on the Enhanced Reporting option.

5. The list of enhanced reports will display. (Note: if you have been using NUMI thru someone else’s Windows session and opt to update your network account from their PC, your credentials will not match when you login to NUMI from your PC. You will need to update your credentials from your PC in order to see the Enhanced Reporting artifacts). 
If you do not wish to update your network account name

1. With the Security Warning message displayed, click on the <Logout> hyperlink.

2. Your network account name will not be updated by the system and you will be logged out of NUMI.

3. Login to NUMI using your own credentials.

4. Click on the Reports menu.

5. Click on the Enhanced Reporting option.

6. The list of enhanced reports will display.

8.13.2 Generating Enhanced Reporting Reports XE "Generating Enhanced Reporting Reports" 
To generate Enhanced Reporting reports   

1. Click the Reports menu dropdown.

2. Click on the Enhanced Reporting option at the bottom of the dropdown list.

3. A list of available reports will display. An example is shown in Figure 162.

4. Select a report in the list by clicking on its hyperlink.  
5. A new window (report viewer) will open.
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 will briefly display in the window.
7. The report contents will display. (Figure 165)
8. To print, click the <File> dropdown in the report viewer window. 

9. Select <Print>.  

10. The report will print to your local printer.
11. To export the report, click on the Select a Format dropdown and select Excel.
12. Hover your mouse over the word Export. It will display as a red hyperlink.  (Figure 166)

13. Click on the Export hyperlink.

14. The information will be exported to an Excel spreadsheet. 
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Figure 165: Enhanced Reporting report viewer window
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Figure 166: Format dropdown selection and Export hyperlink

9 Unlocking and Deleting Reviews XE "Unlocking and Deleting Reviews" 
The features for unlocking Primary and Physician UM Advisor Reviews, and Deleting reviews are accessed from the Review Selection screen, which is located on the Tools menu. 
· Primary Reviewers have the ability to Unlock and Delete their own reviews. 
· Administrators have the ability to Unlock and Delete any reviews. 

· Administrators can Unlock or Delete reviews, on behalf of  Physician UM Advisors 

9.1 Unlocking a Locked Primary Review XE "Unlocking a Locked Primary Review"  

NUMI offers the ability for a Primary Reviewer to unlock any Primary Review that was locked to the database at their site. This would be handy in cases where a reviewer might be covering for someone else in the VISN. (Note: if there is a Physician UM Advisor review associated with the Primary Review, unlocking the Primary Review will automatically unlock the Physician UM Advisor review portion, as well). 
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  If a Primary Review that Did Not Meet criteria is Unlocked and then its status changes to Meets criteria, the associated Physician UM Advisor review will be deleted. 

To unlock a Primary Review that was locked to the database
244. Click on the Review Select option on the Tools menu to open the Review Selection screen.

245. Select the desired filter options by clicking on them.

246. Click the <Find> button and the results will display in a table.

247. Click on the desired View hyperlink to open the Review Summary screen. (You can also get to the Review Summary screen from the Reviews table on the History screen and the Primary Review screen).

248. The Review Summary screen will display with <Close>, <Unlock> and <Delete> buttons. (Figure 167)

[image: image275.emf]
Figure 167: Review Summary window

249. Click the <Unlock> button.
250. A dialog box displays with the message: “Are you sure you want to Unlock this Review?”
251. Click the <OK> button and the screen will refresh and display: “Successfully unlocked the record” and the <Unlock> button on the Review Summary screen will now display as <Review>.
252. Click the <Review> button.
253. The message “Are you sure you want to review?” displays.
254. Click the <OK> button  to be redirected to the Primary Review screen where you can continue working on the review. 

9.2 Unlocking the Physician UM Advisor Portion of a Locked Review XE "Unlocking the Physician UM Advisor Portion of a Locked Review" 
NUMI offers the ability to unlock just the Physician UM Advisor portion of a review that has been locked to the database. 
Certain events must occur before the <Unlock Physician UM Advisor Review> button will display on the Review Summary screen: a Primary Review that Does Not Meet is assigned to a Physician UM Advisor and locked to the database; the Physician UM Advisor opens the review from their Worklist, performs a review, and locks the Physician UM Advisor portion of the review back to the database. 

To unlock the Physician UM Advisor portion of a review that was locked to the database

255. Click on the Review Select option on the Tools menu.

256. Click on the View hyperlink for the review. 

257. The Review Summary screen will display with <Close>, <Unlock>, <Delete> and <Unlock Physician UM Advisor Review> buttons. (Figure 168)

258. Click the <Unlock Physician UM Advisor Review> button. 

259. The Physician UM Advisor can then open the review from their Worklist, perform a review and lock the Physician UM Advisor portion of the review back to the database. (Note: the Primary Review portion of the review remains locked to the database).  
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Figure 168: Review Summary with Unlock Physician UM Advisor Review button

9.3 Deleting a Review XE "Deleting a Review" 
NUMI Administrators will use this feature to delete reviews. Primary Reviewers will be able to delete their own reviews. Administrators can delete reviews on behalf of Physician UM Advisors. A review that has been performed on a patient stay might be deleted if that stay has been deleted from VistA. Deleting the review from NUMI will ensure that no ‘orphan’ stays are on the application.
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  If a Primary Review is deleted, the associated Physician UM Advisor review will also be deleted. There is no way to directly delete a Physician UM Advisor review. You may, however, unlock it and reassign to another Physician UM Advisor and even change it completely.
To delete a review

260. Click on the Review Select option on the Tools menu to open the Review Selection screen.

261. Select the desired filter options by clicking on them.

262. Click the <Find> button and the results will display in a table.

263. Click on the desired View hyperlink to open the Review Summary screen in a different window.
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  If you select the Review hyperlink, you will not be able to delete the review. You will be taken to the Primary Review page where you can continue working on it. If another review is in process, then all changes will be lost unless it has been saved or locked.
264. The screen will display <Close>, <Copy Review>, <Unlock> and <Delete> buttons. (Figure 167)
265. Type a Deletion Reason into the text box. (Note: you will not be able to delete the review unless you do this first).
266. Click the <Delete> button.
267. A dialog box will display with this message: “Are you sure you want to Delete this Review?”
268. Click the <OK> button, and the screen will refresh and display: “Successfully Deleted the record” and the <Delete> button will be grayed out.
269. Click <Close> to return to the Review Selection screen.
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  Be very careful when using the Delete option. Once a review has been deleted, it cannot be restored.
10 Copying Reviews XE "Copying Reviews" 
NUMI simplifies the process of creating multiple reviews for the same patient/stay. You can easily create and save a review by copying another review. This will save you considerable time and effort, especially for weekend stay days and patients awaiting long term care beds and procedures. A review can be copied from the History screen, the Primary Review screen, or the Review Summary screen.  
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 IMPORTANT: Do not copy an Admission review. Since Admission reviews are only done once, there is no reason to copy them.  (If your intent is to copy the criteria and use it for the following day, note that CERMe will not permit you to do that, and will require you to select the type of review before you select the criteria. If you are doing a Continued Stay review, you will want to be using Continued Stay criteria - not Admission criteria. So, there would not normally be any scenario in which you would copy an Admission review).
To copy a review from the History screen
270. From the History screen, click the gold Show Reviews tab to display all the reviews.

271. The Reviews table will open and display all reviews for the patient.

272. Click on a View hyperlink in the table.
273. The Review Summary screen will open and the <Copy This Review> button will display.

Click the button and an identical copy of the review will be created. You can change anything you need to on the copy, and then save it. 

To copy a review from the Primary Review screen
274. From the Primary Review screen, click the gold Show Reviews tab to display all the reviews.

275. The Reviews table will open and display all reviews for the patient.

276. Click on a View hyperlink in the table.

277. The <Copy This Review> button will display. (Figure 169)

278. Click the button and an identical copy of the review will be created.
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  It is only appropriate to copy a review if the criteria and met/not met outcome have not changed. You can copy a review as many times as you wish.  
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Figure 169: Primary Review screen with Copy This Review button

To copy a review from the Review Summary screen
279. From the Primary Review screen, click the gold Show Reviews tab to expand the Reviews table. 

280. The original review and all its copies will display. 

281. To see the summary for any review, click its View hyperlink. 

282. The Review Summary screen will display. (Figure 170)

283. Click the <Copy This Review> button and an identical copy of the review will be created.

[image: image283.emf]
Figure 170: Review Summary screen with Print and Copy This Review buttons

11 ADMIN Menu XE "ADMIN Menu" 
This chapter describes the Admin menu. Only NUMI Administrators can use these features. The menu is located in the Admin dropdown at the top of the History, CERMe and Primary Review screens. (Non-Administrator users will see the Admin menu header on the screen but if they click on it they will not see any options). On this screen, Administrator users can search for VistA users, add them as NUMI users, add and edit NUMI user information and assign privileges, deactivate user sites, and add/remove users from the Physician UM Advisor, Primary Reviewer and Site Administrator panels. There are 2 Admin options: Users and Admin Site. (Figure 171) The administrative features of the Users screens are listed in Table 13, and the features of the Admin Site screens are listed in Table 14.
Table 13: Admin Users features
	FEATURES

	Access NUMI Users Feature

	Find VistA Users by Name

	Find VistA Users by Site

	Find VistA Users by Status

	Add NUMI User / Assign Privileges

	View NUMI User information / Privileges

	Edit NUMI User information

	Deactivate a User’s Site


Table 14: Admin Site features

	FEATURES

	Access NUMI Admin Site Feature (find VistA Users)

	Find VistA Users

	Add Users to the Physician UM Advisor Panel

	Add Users to the Primary Reviewer Panel

	Add users to the Site Administrators Panel

	Remove Users from the Physician UM Advisor Panel

	Remove Users from the Primary Reviewer Panel

	Remove Users from the Site Administrators Panel
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Figure 171: Admin Menu

11.1 Accessing the NUMI Users XE "NUMI Users"  Feature
NUMI Administrators will use this feature to find VistA users, add/edit NUMI user information including the assignment of user privileges, and deactivate user sites.

To access the NUMI ‘Users’ feature
284. Select the Admin dropdown and click on the Users option. A list of existing NUMI users displays on the NUMI User List screen, as illustrated in Figure 172.
[image: image285.emf]
Figure 172: NUMI User List screen
11.1.1 Finding VistA Users by Name
The list of NUMI users can be very long. But you don’t have to scroll thru the entire list. NUMI saves you time by letting you search for specific VistA users using a Find feature. You can search by the user’s full name using lastname,firstname format (e.g.,  Smith,John) without putting a comma after the last name, or you can search by a partial name (e.g.,  Smi). Please note that if you search by partial name you may receive a long list of results (e.g.,  Smi will retrieve all instances of ‘smi’ in user names (e.g.,  Goldsmith, Smit, Smith, Smithfield, etc).
To find VistA users by name
285. Type the user’s name into the VISTA User Name field. (Figure 173)
286. Click the <Find> button. 

[image: image286.emf]
Figure 173: Find VistA Users search fields
11.1.2 Finding VistA Users by Site

To find VistA users by Site

287. Click the Site dropdown (Figure 173) and select a site by clicking on it.

288. Click the <Find> button.

11.1.3 Finding VistA Users by Status

To find VistA users by Status (Active / Inactive)
1. Click the Status dropdown (shown in Figure 173) and select an option by clicking on it.

2. Click the <Find> button.

11.1.4 Adding a NUMI User and Assigning Privileges
To add a NUMI user and assign privileges
289. Click the <Add New User> button (shown in Figure 173).   
290. When the Add New User/Privileges screen displays (Figure 174), enter the user’s name into the VISTA User Name field. You can also enter partial names (e.g.,  instead of Smith, John you can search by Smith or Smi).
291. Select the VISTA User Login Site dropdown and choose a site by clicking on it.
292. Click the <Find VISTA User> button. 
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Figure 174: Add NUMI User

293. When the results display on the screen (Figure 175), click the Select hyperlink in the Select One column for the user you wish to add. 

[image: image288.emf]
Figure 175: Find VistA User results

294. When the screen with user privilege checkboxes displays (Figure 176), choose a site in the NUMI Access Site dropdown by clicking on it.
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  Multiple sites can be chosen from the Select Site for Granting Access dropdown on the Add User screen, if the user has permission to visit more than one site. Only one site can be selected and viewed at a time, however. 

[image: image290.emf]
Figure 176: Add User Permissions

295. Choose NUMI privileges by clicking on the User Privileges checkboxes.
296. Type a reason into the Reason field.
297. Click the <Save> button and the message: ‘Successfully added new user. Site: <location> privileges’ will display, as illustrated in Figure 177.
11.1.5 Viewing NUMI User Information and Privileges

To view a NUMI user’s information and privileges 
298. Click the Select hyperlink (illustrated in Figure 172) for the desired user on the NUMI User List screen. 
299. Each site that they have access to will display either a View or an Edit hyperlink, as depicted in Figure 177. 
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Figure 177: View User Privileges

300. To view privileges for a particular site, click the View hyperlink for that site.
301. The information will display and the View hyperlink will change to grayed out text displaying Selected Site. (Figure 178)
302. While on this screen, if the user has privileges at multiple sites, you can click on the NUMI Access Site dropdown and then click on the desired site in the dropdown to see them.
303. Click the <Cancel> button to return to the NUMI User List screen.
[image: image292.emf]
Figure 178: View NUMI User Information
11.1.6 Editing NUMI User Information

To edit NUMI user information 
304. Click the Select hyperlink for the desired user on the NUMI User List screen. 
305. Each site that they have access to will display either a View or an Edit hyperlink, as depicted in Figure 177.
306. To edit privileges for a particular site, click the Edit hyperlink (shown in Figure 178) for that site.

307. The information will display and the Edit hyperlink will change to grayed out text displaying Selected Site. (Figure 179)
308. Type a reason for the change(s) into the Reason field.

309. Add or change the user’s privileges by selecting/deselecting the User Privileges checkboxes. 
310. Select the site that the privileges will apply to from the NUMI Access Site dropdown by clicking on it.
311. Click the <Save> button. The message “Successfully Updated User: <user name>” will display, as well as the reason you entered, as depicted Figure 177.
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  While multiple sites can be selected from the NUMI Access Site dropdown if the user has permission to visit more than one site, only one site’s privileges can be viewed at a time. 

[image: image294.emf]
Figure 179: Edit NUMI User screen
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  If someone tries to edit a NUMI user record and they do not have the proper administrator privileges, an error message will display: “You do not have admin access to modify user privileges for: <user name>”.
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  If a user’s privileges are changed, they will need to logout and log back in for the changes to take effect.
11.1.7 Deactivating a User’s Site
A user’s permission to visit and view site information for a particular facility can be deactivated using this feature. (NUMI does not allow you to deactivate a user, but you can accomplish that general goal by deactivating all of their site permissions).
To Deactivate a user site
312. Click the Select hyperlink for the desired user on the NUMI User List screen.
313. Click the Edit hyperlink to display the user’s privileges. (Figure 177)
314. Select the desired site from the NUMI Access Site dropdown by clicking on it.
315. Click the Deactivate button.
316. When the prompt “Are you sure you want to deactivate user site <City, State>” displays.

317. Click the <OK> button to deactivate the site.

11.2 Accessing the NUMI Site Admin Feature XE "NUMI Site Admin Feature" 
Administrators will use this feature to find VistA users, and add or remove users from the NUMI Physician UM Advisor, NUMI Primary Reviewer and NUMI Site Administrators lists. The examples below illustrate adding NUMISTUDENT,FIVE to several Admin lists.
To access the NUMI ‘Admin Site’ feature
1. Select the Admin dropdown and click on the Admin Sites option. 
2. The Site Admin Panel screen (Figure 180 and Figure 181) displays the names of existing users in the NUMI Physician Utilization Management Advisor List, NUMI Primary Reviewer List and NUMI Site Administrator List panels.
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Figure 180: Site Admin screen (top half) 
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Figure 181: Site Admin screen (bottom half)

11.2.1 Finding a VistA User

To find a VistA User

1. Type the user’s name into the VISTA User Name field.

2. Select a site from the VISTA User Login Site dropdown by clicking on it.

3. Select a site from the NUMI Access Site dropdown by clicking on it.

4. Click the <Find VISTA User> button. A list of names matching your search criteria will display in the Physician UM Advisor, Primary Reviewer and Site Administrators VistA User List panels. (shown in Figure 180 and Figure 181)
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  When searching for a VistA user, the user name is required. If you try to search for a user without providing this information, the message ‘Please enter VISTA User ID’ will display. 
11.2.2 Adding a User to NUMI Physician UM Advisor Panel

To add a user to the list
318. In the Physician UM Advisor Panel portion of the screen, click on a name in the VISTA User List.
319. Click the [image: image300.emf] button, and the name will populate to the NUMI Physician UM Advisor List.

320. When the message ‘Are you sure you want to add <name(s)> to the Physician UM Advisor panel?’ displays, click the <OK> button.

11.2.3 Adding a User to NUMI Primary Reviewer Panel

To add a user to the list
1. In the Primary Reviewer Panel portion of the screen, click on a name in the VISTA User List.

2. Click the [image: image301.emf] button, and the name will populate to the NUMI Primary Reviewer List portion of the panel.

3. When the message ‘Are you sure you want to add <name(s)> to the Primary Reviewer panel?’ displays, click the <OK> button
11.2.4 Adding a User to NUMI Site Administrators Panel

To add a user to the list
1. In the Site Administrators Panel portion of the screen, click on a name in the VISTA User List.

2. Click the [image: image302.emf] button, and the name will populate to the NUMI Site Administrators List portion of the panel.

3. When the message ‘Are you sure you want to add <name(s)> to the Site Administrators panel?’ displays, click the <OK> button

11.2.5 Removing a User from the NUMI Physician UM Advisor Panel

To remove a user from the list

321. Click on a name in the NUMI Physician UM Advisor List.

322. Click the [image: image303.emf]  button, and the name will be moved from the list to the VISTA User List portion of the panel.

323. When the message ‘Are you sure you want to remove <name(s)> from the Physician UM Advisor panel?’ displays, click the <OK> button.

11.2.6 Removing a User from the NUMI Primary Reviewer Panel

To remove a user from the list
1. Click on a name in the NUMI Primary Reviewer List.

2. Click the [image: image304.emf]  button, and the name will be moved from the list to the VISTA User List portion of the panel.

3. When the message ‘Are you sure you want to remove <name(s)> from the Primary Reviewer panel?’ displays, click the <OK> button.

11.2.7 Removing a User from the NUMI Site Administrators Panel

To remove a user from the list
324. Click on a name in the NUMI Site Administrators List.

325. Click the [image: image305.emf]  button, and the name will be moved from the list to the VISTA User List portion of the panel.

326. When the message ‘Are you sure you want to remove <name(s)> from the Site Administrators panel?’ displays, click the <OK> button.

12 Logging Out XE "Logging Out"  of the NUMI Application
The Logout option is located on the Tools menu.

To logout of the NUMI application
1. Click on the Tools dropdown.

2. Click on <Logout> option.

3. The NUMI Logout screen will display.

4. Click the <Close Browser> button. The message “The Web page you are viewing is trying to close the window. Do you want to close this window?” displays.

5. Click <Yes> to close the browser window.
13 Additional NUMI Information XE "Additional NUMI Information" 
This chapter contains some additional information about NUMI.      
13.1 Access NUMI System (Login) Screen

· VistA will display an error message and lock you out of the application for 20 minutes if you exceed the maximum number of login attempts. After 20 minutes, VistA will automatically reset your Access and Verify Codes and you may try to login again. The maximum number of login attempts varies by station and is set according to the local VistA policy
· Security Warning message displays if the Windows and NUMI credentials do not match
· Security Warning message provides option for updating network account name or logging out of NUMI and logging back in using your own credentials

13.2 Patient Selection Screen
· When a patient review reminder is set to a day outside of a date filter range, then the patient stay will disappear from the list. If you would like to use the Patient Selection screen in such a way that when a review is performed, the patient disappears from the list, set the reminder date on the Primary Review screen to an appropriate future reminder date (e.g.,  the next day), and then set the date filters to have an End Date prior to that day. If you don’t want the reviews to disappear from your Patient Selection screen, then leave the End Date filter blank
· If a patient movement is dismissed, it will be removed from the Patient Selection table. It will reappear if another review is performed from the Dismissed Patient Select screen. Each subsequent movement, including transfers, discharges and provider/specialty changes, will cause a stay to display on the screen again even though an earlier entry was dismissed  
· Any reviewer can Dismiss a patient from the Patient Selection screen

· The original worklist sort order will be retained, even after leaving the screen and returning to it

· To select a patient for review, click on the patient’s hyperlinked name in the Patient Name column of the worklist

· The worklist displays each row of information on one line only; if the text on a line exceeds a certain length you will see an ellipsis (“…”)
· Hovering your mouse pointer over any field with an ellipsis will display the full text
· Dismiss Type dropdown has been added to the screen

· The Update Stays button has been renamed to Dismiss Stays

· Assign Reviewers button has been added to the screen

· Dismiss Type dropdown and Dismiss Stays button are disabled when screen first displays. After selecting at least 1 stay checkbox on the screen, the Dismiss Type dropdown will be enabled. After choosing an option from the Dismiss Type dropdown, the Dismiss Stays button will be enabled
· Hovering your mouse pointer over Dismiss Type dropdown, Dismiss Stay button and Assign Reviewers button will display tooltips
· Review hyperlink and column have been removed from the screen

13.3 History Screen

· The demographics information on the screen comes from VistA and is read-only
· Any reviewer can print out patient worksheets

· Any reviewer can review and copy an existing review for a patient
13.4 CERMe Screen

· Behavioral Health Procedure Review Subsets are NOT supported in NUMI

· To display Subcategories, select the BH: Chemical Dependency & Dual Diagnosis InterQual® Product and the Adult or Adolescent category.
· If a Keyword or Medical Code search produces no results, the message “No Subsets Found” displays
· Criteria Met or Criteria Not Met will display based on the criteria checkboxes you select
· InterQual® Notes, Transition Notes and Quality Indicators will display, based on the criteria you select
13.5 Primary Review Screen

· Only reviews with ‘Don’t Meet Criteria’ status will go to the Physician UM Advisor Worklist
· Can indicate that a Physician UM Advisor review is not required for a stay

· Can copy a review

· Can add Custom notes

· Can indicate unscheduled readmission within 30 days
· Can enter comments
· Must select an Admission Review Type for admission or initial reviews
13.6 Physician UM Advisor Review Screen

· If a search for a stay produces no results, “No Records Found” will display
· Must Agree or Disagree with Current Level of Care

· Can optionally enter comments
· Must enter a comment if agree/disagree type “Other” is selected

13.7 Review Select Screen (Tools Menu)

· Can select reviews that have been locked to the database
· Can Unlock a review

· A reviewer can Delete their own review
· Administrators can Delete any reviews

· Can copy a review

· A Print Preview button has been added to the screen. Print functionality is disabled if more than 5,000 rows of information display in the search results so that system performance is not impacted
· An Export to Excel button has been added to the screen. There is no limit on how many rows of information can be exported to Excel
13.8 Dismissed Patient Select Screen (Tools Menu)

· Can use Go To Page feature

· Can use Next and Previous Page features

· Can use First and Last Page features

· The Date filters are pre-selected and display a 1 week date range. The user can change these dates, as desired

· Clicking the Reset button clears all fields on the screen and resets all filters back to the default values, except for the 1 week date range
· Instructional text has been added to the screen that displays when the screen opens: “Click FIND to list all dismissed stays meeting the filters specified above. To create a different stay list, click RESET, select your filter criteria and click FIND”.
· If when you click Find, you see the message “Error Occurred Loading the Page. Please click your browser’s Refresh button and try again.”          please see below:
· Check to see if you have a blank Start Date and/or End Date field
· The date range you have selected produces too many stays in the results. Please narrow your date range to produce a smaller number of stays 
13.9 Sync With VistA Screen (Tools Menu)

· Can synchronize NUMI with what is in VistA

13.10 Patient Stay Admin Screen (Tools Menu)

· Administrators can View and Delete stays in NUMI that were removed from VistA

13.11 Report Menu

· Al users can generate on demand reports

· All users can Print reports

· All users can Export reports to Excel

· An Enhanced Reporting menu option has been added (you must be logged in with  your own credentials in order to access these reports) 

· After selecting the Enhanced Reporting menu option, a Security Warning message displays if the Windows and NUMI credentials do not match
13.12 Online Help Menu

· All users can access the most current version of the User Guide from the online Help menu

13.13 NUMI Application Timeouts / Lost Sessions
Timeout due to Inactivity

· After 15 minutes of inactivity, a dialog box with an audible “beep… beep… beep… beep… beep” will display at the top of the screen with a countdown timer set for 5 minutes and the message illustrated in Figure 182.  If the OK button is clicked within the 5 minutes, you will be returned to the last screen you were on in NUMI. Note: if the OK button is not clicked before the 5 minutes elapse, the system will log you out of NUMI, but your browser will remain open
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Figure 182: Session Idle Message
Lost Session

· When the HTTP session is lost due to a connection issue, high load or network issue from MDWS, VistA or NUMI, the error message displayed in Figure 183will display.  Please note: this is not a ‘timeout’. This problem is due to a dropped connection or high user volume on the system
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Figure 183: Lost Session Error Message
13.14 NUMI Application Lockout
· VistA will lock your Access and Verify Codes after the maximum number of permitted login attempts is exceeded. VistA will automatically unlock your Access and Verify Codes after 20 minutes and you may try to login again. See Section 2.3.1 for more information
13.15 Information Feeds from VistA
· There is an hourly feed of admissions, ward transfers, discharges, and specialty/provider transfers from VistA, during daytime hours. Then the entire day will again be updated between midnight and 6:00 a.m. (within each time zone)
· When the synchronizer process runs at midnight, stays that were dismissed the prior day will not be re-populated to the Patient Selection screen
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  While working in NUMI, if you use the BACK button on your browser instead of one of the screen tabs (shown in Section 2.1.15) or the Tools menu, you may get an error message. Always navigate around NUMI using the tabs or the Tools menu and you will avoid error messages and delays.
14 Online Help Menu XE "Help Menu" 
An online Help menu is located at the top of many NUMI screens. The menu contains an option that, when selected, will take you to the Office of Quality and Performance (OQP) web page where you can find the most current version of this User Guide. If the online help information does not answer your question, first contact your NUMI site POC/Administrator for assistance. If the question is still unresolved, you may log a Remedy ticket. 
You may go to the OQP webpage directly by typing this URL in your browser’s address line:   http://vaww.oqp.med.va.gov/programs/um/numi/numi.aspx
14.1 Selecting the Online Help Menu XE "Selecting the Online Help Menu" 
To access the online Help feature

327. Click on the Help menu dropdown. (Figure 184)
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Figure 184: Help Menu dropdown

2. Select the User Guide option by clicking on it, and you will be redirected to the Office of Quality and Performance (OQP) web page (Figure 185). 
3. Click on the NUMI Program Homepage option.

4. Click on the NUMI User Guide option. (Here you will be able to click on a link that will open an electronic copy of this User Guide in its entirety. Or, if you prefer, you can click on individual links to each chapter in the document). 
[image: image310.emf]
Figure 185: OQP Web Page XE "Glossary" 
15 Glossary XE "Glossary"  of Terms
A glossary of UM terms that are relevant to the NUMI application are defined in Table 15.
Table 15: Glossary of Terms
	Term
	Description

	Acute Admissions
	A level of health care in which the patient’s severity of illness and intensity of service can only be performed in an in-patient setting.

	Admission Review
	An assessment of medical necessity and appropriateness of a hospital admission after the hospitalization has occurred and the patient has been moved to a higher level of care (e.g.,  from a Ward to MICU). This review is typically performed on admission, within 24 hours following admission or no later than the first business day following the admission. Standardized review criteria must be used to determine the appropriateness of care.

	ALOC
	Acronym for Alternate Level Of Care

	CERMe
	Acronym for Care Enhance Review Manager enterprise. A Web-based application, made available by McKesson that provides computerized InterQual® templates to field Utilization Management staff.

	Concurrent Review
	A Behavioral Health review for a patient who has already received an initial review.

	Concurrent Review Process
	An assessment of medical necessity or appropriateness of services that covers the time period throughout the time of review and the previous 24 hours.

	FAQ
	Acronym for Frequently Asked Questions

	GEM
	Acronym for Geriatric Evaluation and Management Program. GEM is a specialized program of services in an inpatient or outpatient setting where an interdisciplinary health care team performs multidimensional evaluations on a targeted group of elderly patients who will most likely benefit from these services.  This team approach to assessment of the patient is followed by an interdisciplinary plan of care, including treatment, rehabilitation, health promotion and social service interventions.

	Hospital Admission Review
	A review that is performed when a patient first comes into the hospital. All admission reviews should be dated with the actual admission date, regardless of when the review is performed. 

	IEN
	Acronym for Internal Entry Number

	InterQual® Behavioral Health Criteria
	Assists in determining initial and successive level of care decisions for psychiatric conditions, chemical dependency and dual diagnosis for individuals at each stage of life.

	InterQual® Care Planning Criteria
	Supports healthcare organizations in promoting clinical quality and cost-effective allocation of medical resources by helping identify when care-related interventions are appropriate.

	InterQual® Clinical Evidence Summaries
	Collection of current white papers that synthesize medical research to support controversial diagnoses, which support second-level medical review recommendations and promote evidence-based standards of care.

	InterQual® Criteria
	InterQual® is a product of the InterQual® division of McKesson Corporation. InterQual® criteria is used to determine if a patient’s [image: image311.png]



hospital length of stay is appropriate. The criteria is based on the diagnoses and any treatments involved in the patient’s care[image: image312.png]



. 

	InterQual® Level of Care Criteria
	InterQual Level of Care Criteria address admissions and continued stays across the continuum of care, from acute settings through home care and outpatient treatment.

	InterQual® Products, Categories and Subcategories
	For assistance in determining when and how individual patients progress through the continuum of care, McKesson's InterQual® criteria products are the gold standard in evidence-based clinical decision support. The most widely used clinical content in health care, InterQual® can help create greater transparency and alignment between providers and payors in care management decisions. Also, the clinical basis and intense rigor of the InterQual® content development process result in unparalleled content integrity, ensuring the appropriateness of care and increased confidence in clinical decision-making.

	InterQual® Retrospective Monitoring Criteria
	Helps healthcare organizations evaluate the appropriateness of surgical and nonsurgical invasive procedures, for retrospective justification and validation.

	IS
	Acronym for Intensity of Services

	Length of Stay
	A term commonly used to measure the duration of a single episode of hospitalization. Inpatient days are calculated by subtracting day of admission from day of discharge. However, persons entering and leaving a hospital on the same day have a length of stay of one.

	Level of Care
	Refers to the continuum of care, which includes various intensities of service levels such as acute, rehabilitation, sub-acute, home care and outpatient rehabilitation.

	LOC
	Acronym for Level Of Care

	LOS
	Acronym for Length Of Stay

	Movement Types
	A movement refers to the act or process of moving a sick, injured, wounded, or other person to obtain medical care or treatment. Movement types in NUMI include Admission, Continued Stay, Discharge and Transfer.

	National Utilization Management Integration
	A Web-based application that automates documentation of clinical features relevant to each patient’s condition and the associated clinical services provided as part of VHA’s medical benefits package.

	NUMI
	Acronym for National Utilization Management Integration

	Observation Beds
	An alternative level of health care comprising short-stay encounters for patients who require close nursing observation or medical management.

	Pre-Admission Review
	A review performed prior to admission to determine whether a patient meets criteria for acute hospital care.

	RLOC
	Acronym for Recommended Level Of Care

	Severity of Illness
	The extent of organ system derangement or physiologic de-compensation for a patient. Classified into minor, moderate, major, and extreme. Meant to provide a basis for evaluating hospital resource use or to establish patient care guidelines.

	SCI
	Acronym for Spinal Cord Injury

	SI
	Acronym for Severity of Illness

	UM
	Acronym for Utilization Management

	Under-Utilization
	The failure to provide appropriate or indicated services, or the provision of a lower level of services than clinically required.

	Utilization Management
	The process of evaluating and determining the coverage and the appropriateness of medical care services across the patient health care continuum to ensure the proper use of resources.

	Utilization Review
	A formal evaluation or the coverage, medical necessity, efficiency or appropriateness of health care services and treatment plans for an individual patient

	UR Criteria
	A set of measurable, clinical indicators, as well as diagnostic and therapeutic services reflecting the need for hospitalization or treatment.

	VSSC
	Acronym for VISN Support Services Center

	VISN
	Acronym for Veterans Integrated Service Network. 


Appendix A  –NUMI Screen Flow XE "NUMI Screen Flow" 
Figure 186 illustrates the basic flow of the major NUMI screens.
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Figure 186: NUMI Basic Screen Flow
Appendix B  – NUMI Tips for Success XE "NUMI Tips for Success" 
This Appendix contains tips that will help you make the most of working with NUMI.

Remember that each row on the Patient Selection list is a patient stay.  Use the Patient Selection screen to identify your patient stays and the reviews needed. This screen will tell you: 

· Time and date of admission

· If the patient is discharged

· When the last review was done

· Whether criteria was met on the last review

Use the Assign Reviewer function. This will make it easier for you to locate your patients on the Patient Selection screen.  
When you do a review, NUMI automatically assigns you as the reviewer. If you assign yourself to new admissions in your area of responsibility every day, then you can filter your facility Patient Selection List by your name, and you will have a complete listing of your active patient stays.

Be diligent with Patient Selection list “housekeeping.”   
Every day, dismiss patients in non-acute specialties, such as Nursing Home and Domiciliary, and dismiss patients who are discharged and up to date with reviews. A shorter Patient Selection List will result in faster response time when you are filtering and sorting the patient stays.

Use your G&L or Ward Roster reports to confirm that all admissions are appearing in NUMI.   
Occasionally patient admissions are not picked up by the NUMI synchronizer.  When this happens, you can add that patient through the Synch with Vista feature. If you make certain that all admissions are captured every day, your patient stay list will be complete.
Use short cuts and best practices whenever possible.   
As you work with NUMI, you will find the workflow that is best for you. Here are some things that are time-savers:

· Navigate around the system using the 4 tabs

· Filter your patient selection list – make sure everyone gets an admission review. They will then be in your list daily until you dismiss them.

· Use the Copy Review function as much as possible…especially after weekends.

· Some people make brief written notes while in CPRS or on the units enter reviews all at once. Others prefer to toggle back and forth between NUMI and CPRS while doing reviews.

Use Clinical Comments fields strategically.  
Enter information in the Clinical Comments boxes that will assist you in identifying critical issues with this stay and jog your memory for future reviews. This is an optional field, if there is nothing notable, leave it blank. For reviews not meeting criteria that will be sent to the Physician UM Advisor, enter clinical comments that can provide information to help the Physician UM Advisor understand the Not Met status.
Meet with your Physician UM Advisor to develop policy and guidelines for reviews.  Discuss which types of Not Met reviews should go to the Physician UM Advisor for review. If there are categories of Not Meeting reviews that the Physician UM Advisor would consider “Automatic Agree,” consider establishing a formal local policy to not send those to the Physician UM Advisor. Find out what types of clinical comments are helpful to the Physician UM Advisor. 

Use reporting.  
There are eight basic report templates. Some are facility aggregates, and some are patient level detail. At day’s end, use the patient detail report to print out a summary of your reviews. This is a helpful tool for the following day.
 Utilize the training and help resources available. Ask for help when needed.  
The NUMI  implementation for your facility will include LiveMeeting training classes. Make time to attend them. The UM website will have a NUMI section with helpful tools and resources.  Call on the NUMI Trainers for assistance as needed.
Be patient with yourself and the NUMI system.  
It takes time to learn how to apply a new tool like NUMI. Expect that you will make mistakes at first. NUMI is in its first version, so there will be new capabilities and changes identified. NUMI enhancements are already in development. NUMI upgrades will be rolling out regularly.

Appendix C  - NUMI Terminology XE "NUMI Terminology" 
Below are some clarifications to terminology that is used in NUMI.
Primary Reviewer and Primary Reviews

Primary Reviewers may also be known as Nurse Reviewers or UM Reviewers. Whichever descriptor is utilized, this refers to the individual looking at the patient stay and performing the review that determines whether or not the stay meets InterQual® Criteria. In general, NUMI attempts to use the terms Primary Reviewer and Primary Review.

Physician UM Advisors and Medical Reviews

In cases where the Primary Review does not meet InterQual® Criteria as determined by the CERMe component of NUMI, the Primary Reviewer will be asked to assign a Physician UM Advisor to perform a medical review of the primary review.

InterQual® and some UM programs make use of a Secondary Reviewer who lies between the Primary Reviewer and the Physician UM Advisor. In NUMI there is no discreet Secondary Reviewer step -- this is best done by saving a review, and then having the Secondary Reviewer look at it.

CERME vs CERMe vs CERM

CERME stands for Care Enhanced Review Manager, McKesson's automation of their InterQual® Criteria -- an industry standard. Per McKesson, it is pronounced "Kermie". The 'E' or 'e' on the end technically refers to the standalone version of CERM which has its own administrative and reporting tools. 

Regardless of how you see it in the application, this refers to the McKesson software embedded within NUMI.  References to a "standalone CERME" refer to the correct usage of the CERME (or CERMe) name. There are sites in the VA that have been using their own standalone instances of CERME without the VistA integration.

Appendix D – UM Admission Reason Codes XE "UM Admission Reason Codes" 
Table 16 provides a list of UM Admission Reason Codes and their definitions.

Table 16: UM Admission Reason Codes

	UM Code
	Code Description for Admission Reviews
	Definition for Reason

	Social
	
	

	1.01
	Admitted for placement 
	Lack of family / social support, family unable to care for patient or patient unable to care for self, example nursing home placement.

	1.02
	Homeless
	Patient does not have a home.

	1.03
	Admitted for patient/family convenience/respite
	Patient admitted without medical necessity to accommodate patient / family's request.  (i.e.,  Family is going on vacation and no one will take care of the patient; colon prep prior to surg; admitted a day early due to early am surg; admitted day early because driver is not available on the day of surg; no available family caregiver at home; late surg and more convenient for patient to go home the following day.)

	1.04
	Patient non-compliant with outpatient management
	Patient is noncompliant with outpatient medication regimen and / or treatment plan, and / or scheduled Outpatient follow-up appointments.

	1.99
	OTHER (Social Factors):
	Specify reason

	Environmental
	
	

	2.01
	Transportation
	Unreasonable distance to travel for being admitted on day of admission; or having difficulty finding a ride to the VA on day of  scheduled admission.

	2.02
	Adverse environmental condition
	Covers snow storms, rain, tornados, floods, hurricanes, mud or rock slides, fires closing roadways, etc. 

	2.99
	OTHER (Environmental Factors):
	Specify reason

	Scheduling
	
	

	3.01
	Delay in scheduling outpatient clinic appointment 
	Back log obtaining an outpatient clinic appointment (i.e.,  Cardiology, Nuclear Medicine, any Surgical or Medical Clinics)

	3.02
	Delay in scheduling outpatient procedure (scheduled sooner as inpatient.) 
	Physician felt outpatient procedure (labs or x-rays or consults, etc.) would be completed sooner as Inpatient.

	3.03
	Admitted for workup
	Patient is admitted to have labs or x-rays or consults or other routine (EKGs, MRIs, ECT's, Work Ups) done as an inpatient.  Also includes patients admitted for "medical clearance" admission due to wish to circumvent slowness or lack of timely appointments in ambulatory care system;  e.g., , timeliness of routine lab, x-rays, procedures, consults

	3.04
	Premature admission
	Procedures scheduled after admission day or patient admitted on Friday and not evaluated until Monday

	3.99
	OTHER (Scheduling Factors):
	Specify reason

	Service/Care/Bed Availability
	
	

	4.01
	Alternative service/care/bed available but not accessible 
	This is the type of service/care that is provided at your medical center but not available at this time (such as no tele beds and patient admitted to ICU).

	4.02
	Alternative service/care/bed unavailable 
	This is to assist/identify services/care that you would like to implement in the future. (If the data can justify this type of care needed).     

	4.03
	Outpatient Procedure unavailable
	Procedure is not available at your facility as an outpatient.

	4.04
	Outpatient  services unavailable
	These services are not available at your med center as outpatient. 

	4.99
	OTHER (Service/Bed Availability Factors):
	Specify reason

	Practitioner
	
	

	5.01
	ALOC is appropriate and services are available
	Physician chose to admit the patient although the services or specialty needs are available and offered in the ambulatory care setting (i.e.,  outpatient, observation, nursing home, subacute, etc.)

	5.02
	Physician determined that patient needed hospitalization for medical reasons. 
	Patient is admitted however clinical signs/symptoms do not meet nationally approved criteria.

	5.03
	Physician ordered treatments/services do not reflect acuity
	Pt has acute symptom/sign/illness for the proposed level of care but does not have physician ordered services/treatments

	5.99
	OTHER (Clinical Factors):
	Specify reason

	Administrative
	
	

	6.01
	Admitted in order to transfer to another private or VA facility
	When a patient is admitted solely for the purpose of transfer to another facility, either private or VA.

	6.02
	External factors
	Patients admitted due to external issues designated by each facility.

	6.03
	Admitted as a transfer from a private or VA facility
	When a patient has been receiving care at a community hospital or VA facility and is transferred to our facility for continuation of care.

	6.04
	Admitted from Community Nursing Home / Boarding Home for management
	Admitted from Community Nursing Home / Board Home for more acute care due to a) medical reasons and/or b) psychiatric reasons.

	6.05
	Hospital policy mandates admission
	Medical Center is directed by Hospital Policy to admit the patient (i.e.,  Chemotherapy not given in Extended Care, Continuous EEG monitoring, etc.)

	6.99
	OTHER (Administrative Factors):
	Specify Reason

	Communication
	
	

	7.99
	OTHER (Communication Factors):
	Specify Reason

	Other
	
	

	8.99
	Other (All Other Factors)
	Specify Reason


Appendix E  - UM Continued Stay Reason Codes XE "UM Continued Stay Reason Codes" 
Table 17 provides a list of UM Continued Stay Reason Codes and their definitions. 

Table 17: UM Continued Stay Reason Codes

	UM Code
	Code Description for Cont’d Stay Reviews
	Definition for Reason

	Social
	
	

	9.01
	Difficult Placement
	Patients who have issues with non-compliance or behavior resulting in multiple failed placements in the community who are awaiting initial evaluation or follow-up by Social Work.

	9.02
	Hospitalized until home environment is acceptable or alternate LOC found
	Patient whose home environment has been determined to be unsafe (i.e.,  sexual abuse, elder abuse, hazardous environmental concerns, etc.)

	9.03
	Lacks Family Support for home care
	Discharge to home care is appropriate though family / support services are not available.

	9.04
	Homeless
	Lives on streets-awaiting for placement in appropriate LOC (shelter, SNF, B&C, etc.)

	9.05
	Patient/Family Resistive to discharge/treatment/placement
	Patients or family resistive to treatment plan, discharge plan, or selected placement (for various reasons, including the cost of CNH) causing a delay in discharge.

	9.06
	Patient/family convenience or respite
	Patient remains hospitalized as it is more convenient for him (i.e.,  doesn't have to travel for treatment, patient prefers discharge on a specific date, family wants patient discharged on a specific date, etc.).

	9.99
	OTHER (Social Factors):
	Specify reason

	Environmental
	
	

	10.01
	Transportation needed
	Having difficulty finding a ride home on day of discharge from VA. Or needs travel arrangements made.  Unreasonable distance to travel to ALOC.

	10.02
	Adverse Environmental Conditions
	Covers snow storms, rain, tornados, floods, hurricanes, mud or rock slides, fires closing roadways, etc. 

	10.99
	OTHER (Environmental Factors):
	Specify reason

	Scheduling
	
	

	11.01
	Cancellation of Test or Procedure
	These are patients who stayed as Inpatient after the test/procedure had been cancelled for various reasons (i.e.,  patient did not get NPO prior to test, Operating Room closed down for whatever reason, etc.), did not get discharged, waiting for them to be re-scheduled with no services (no IVF, pox meds only, etc.).

	11.02
	Waiting for test or procedure/consult to be done at your medical center
	Test or procedure is appropriate, but patient is waiting to have it done at your VAMC 

	11.03
	Waiting for test or procedure/consult to be done at another VAMC
	Test or procedure is appropriate, but patient is waiting to have it done at another VAMC.

	11.04
	Waiting for test or procedure/consult to be done at a NON-VA facility
	Test or procedure is appropriate, but patient is waiting to have it done at a NON-VA Facility.

	11.05
	Premature Admission 
	Premature admission (procedures scheduled after admission day, or Patient admitted on Friday and not evaluated until Monday. (Is an inpatient procedure).

	11.06
	Testing could be done as Outpatient but kept Inpatient to expedite
	Physician keeps the patient in the hospital to circumvent a long waiting list for an Outpatient test.  Example:  Schedules an Outpatient Sleep Study but waiting list is 3 months.  If kept Inpatient can get it done within 2 days.

	11.07
	Awaiting a consult/appointment at another VA
	An inpatient on acute medical whose discharge is being delayed in order for them to be seen in a consult/specialty clinic at another  VA in order for the specialist to make recommendations regarding plan of care.

	11.08
	Consult to CLC/Long Term Care
	 

	11.09
	Consult to Palliative Care
	 

	11.10
	Consult to Hospice
	 

	11.99
	 OTHER (Scheduling Factors):
	Specify reason

	Service/Care/Bed Availability
	
	

	12.01
	Alternative service/care/bed available but not accessible
	This is the type of service/care that is provided at your medical center but not available at this time (such as no tele beds and patient admitted to ICU).

	12.02
	Alternative service/care/bed unavailable
	This is to assist/identify services/care that you would like to implement in the future. (If the data can justify this type of care needed).  Such as skilled nursing level of care available.   

	12.03
	Outpatient Procedure unavailable
	Patient remains in hospital because procedure not available as an outpatient. 

	12.04
	Outpatient  services unavailable
	Patient remains in hospital due to services not available as an outpatient.

	12.05
	Awaiting acceptance/transfer to a VA or NON-VA inpatient facility
	Stay is extended due to patient awaiting an acceptance/transfer to ANOTHER VA or NON VA Facility.

	12.99
	OTHER (Bed Availability Factors):
	Specify reason

	Administrative
	
	

	13.01
	External factors
	Patients admitted due to external issues designated by each facility.

	13.02
	Awaiting Military Separation Orders
	Active Duty patient remains in acute care setting awaiting DOD discharge.

	13.03
	Delay in Equipment Delivery/Setup
	Patient's discharge is being delayed due to the need for equipment to be delivered and/or set-up in the home.

	13.04
	Delay in initiating an order or omission of order
	The patient has a plan of care ordered, but the services have not been implemented. (i.e.,  patient admitted for chemotherapy, the chemo medicine was ordered, but wasn't administered; Lab failed to draw blood; Nurse did not obtain stool specimen).

	13.99
	OTHER (Administrative Factors):
	Specify reason

	Communication
	
	

	14.01
	Awaiting communication of test/procedure results or consults
	Test or Procedure has been completed, but results are not available and physician is awaiting results to determine further care. Consult has been entered, but remains unanswered and physician is awaiting response to determine further care.

	14.02
	Patient Education
	Patients needing education before being discharged (i.e.,  - 1) Diabetic education (diabetic education or dietician not able to get with the patient); 2) PICC line education; 3) Ostomy care; 4) Dressing Changes; 5) Education regarding administration of subcutaneous lovenox.).

	14.99
	OTHER (Communication Factors):
	Specify reason

	Practitioner
	
	

	15.01
	Failure to write discharge orders
	Failure to write discharge orders

	15.02
	Failure to initiate timely discharge planning
	Failure to initiate timely discharge planning.

	15.03
	Continued Observation.
	Continued observation for signs and symptoms related to specific aspects of a treatment plan; patient does not meet discharge screen (i.e.,  Med Adjustment, Pain Management and Labs; Vital Signs, Neuro Checks, POx; SOB, activity tolerance, return of bowel function, diet tolerance, etc.) 

	15.04
	No documented plan of active treatment or evaluation
	An absence of documentation, by the provider, of a continued active plan of care during the weekend/holiday weekend or from Monday through Friday (i.e.,  No visits by any provider to the Inpatient Psych Unit).

	15.05
	Physician chose to keep at the current level of care when care and service could be provided safely and effectively at a lower level
	Patient is not meeting criteria for the level of care in which they are located and based on review, care and services could be provided safely and effectively at a lower level of care; however, it is the physician's preference that the patient remain at the current level of care; patient meets discharge screens.

	15.06
	Physician ordered treatments/services do not reflect acuity
	Pt does not meet criteria and does not meet discharge screens.

	15.07
	Perception is that the care on the ward will not meet the patient's needs
	MD prefers a particular level of care due to needs of the patient.  MD preference is a major component of this reason.  The MD may prefer ICU to acute care because of concern that intensity of service cannot be met.

	15.99
	OTHER (Practitioner/Clinical Issues Factors):
	Specify reason


Appendix F  – Frequently Asked Questions (FAQ) XE "Frequently Asked Questions (FAQ)" 
This Appendix contains a list of Frequently Asked Questions about NUMI:

Getting Started:
Q: What do I need before I start using NUMI?

A: This is what you will need:

· a Windows pc on the VA intranet, running Microsoft Internet Explorer 6.0 or higher (IE6) 

· While it is expected that NUMI will run on your pc without any difficulty, should you experience problems please contact your local IRM for assistance. Many issues can be resolved by changing some settings on the pc. (See Section 2.1 in the User Guide for more information).If you are not permitted to change settings yourself due to restrictions at your particular VA site, your local IRM can help you. 

· a production VistA account at one site that has CPRS access to that site

· You only need one “home” login site. Please note that NUMI access is completely separate from access for CPRS and VistAWeb - you will need to arrange for those rights separately. Performing reviews in NUMI without proper additional clinical informatics tools such as CPRS and VistAWeb is strongly discouraged.

· to have your account set up by a NUMI Administrator

· The rights you will need will depend on whether you are a Primary Reviewer, a Physician UM Advisor or an Administrator.

· the URL for the NUMI application

· This will be provided to you after you have attended NUMI training.

Login Error Messages:
Q: I’m unable to login to VistA. I’m getting this message: “Unable to login to VistA. The error was: Device IP address is locked due to too many invalid signon attempts”. What should I do?

A: This error means you have exceeded the maximum number of login attempts permitted by your local VistA. When this happens, VistA will lock you out of the NUMI application for 20 minutes. After 20 minutes, VistA will clear your login restriction and you can try to login again. You can also call your IRM support person and ask them to zero out your login attempt count so you can login without waiting for 20 minutes.
Q: During login, after selecting my VISN and site and entering my access and verify codes, a mostly blank screen appears with the site I selected towards the upper left and a “GO” button next to it.  Do I need to click the button to proceed?

A: No. In fact, if you click the button you will get an error and have to start the login process over again.  Just wait for the screen to paint fully.

Q: I’m unable to login.  I’m getting this message: “Verify code must be changed before continued use.”  What should I do?

A: Your VistA site Verify code has expired and you need to log into VistA.  After you enter your Verify code VistA will ask you to re-enter it and enter a new Verify code, then re-enter it to confirm.  After you have successfully logged into VistA you should be able to log in to NUMI.
Warning / Advisory Messages:
Q: I selected a patient stay from the Stay Movement table, but got a warning message telling me that the stay cannot be retrieved from VistA and may be invalid. Why would this happen?  

A: This warning may occur because an invalid patient admission was entered, and the record was deleted from the hospital database – but not before it was sent to NUMI. The stay can be deleted from NUMI using the Patient Stay Admin option. However, before deleting anything in NUMI, check CPRS or VistA to verify that the admission or movement is no longer in VistA. The invalid stay message can also appear if NUMI cannot connect to VistA when a reviewer clicks the review link, even if the movement is still in VistA. (See Chapter 7 in the User Guide for more information about deleting patient stays). 

Q: I selected criteria from the CERMe screen, but when I clicked the Continue Primary Review button I got this message: “Unsupported review type. Please use another CERMe review”. What does this mean?

A: The review is not supported in NUMI. Certain InterQual subsets, such as Behavioral Health Procedure criteria, are not supported in NUMI. You will need to select another review. (See Chapter 4 [Table 7] in the User Guide to see the list of unsupported criteria). 

Working with the NUMI Screens:
Q: Sometimes clicking on the History page View link doesn’t cause the expected screen to pop up.

A: It is likely that the screen is already up but hidden in back of another screen.   You can use alt-tab to move between screens that are already up, or minimize each screen until you see the hidden screen.

Q: The “typing memory” feature seems to have disappeared.  Previously, when I typed in something, NUMI would often complete the text and save me from typing the whole thing.

A: This happens if your web browser is upgraded to a new version.  The auto-populate feature is wiped out when updates are applied, but will return gradually as you use the browser and NUMI. (If your local IRM policy controls the browser’s auto-complete function, this may never be available).
Working with Patient / Attending Information:
Q: I know a patient has been admitted to the hospital and they are in VistA, but I don’t see them listed on the Patient Selection screen in NUMI. How can I get them to display?

A: You can manually synchronize NUMI with what is in VistA. Select Sync With VistA from the Tools Menu. Choose the desired search options and click the Find Stays in VistA button. When the results display, click the checkboxes beside the stays you wish to synchronize and select the Synchronize Stays button. NUMI will now show what is in VistA. (See Chapter 7 in the User Guide for more information about using the Sync With VistA option).

Q: I have a patient on the list whose listed Attending Physician is different than the actual Attending. Is this supposed to be so?

A: When that happens, it is because it was entered inaccurately on the unit or in Admissions. When you put in your review, you can correct this by selecting the correct Attending from the drop-down box on the Primary Review screen. (See Chapter 5 in the User Guide for more information about how to change the Attending Physician).

Q: While waiting for a patient’s information to load after selecting a stay, if I click on another button, I get an error message and have to start over again.

A: Please be patient and wait until NUMI responds to a click or other command. Clicking multiple times before the system responds will produce an error.

Q: I changed the Attending on the Primary Review screen - so why doesn't my change show up on the Patient Selection screen?

A: That is because it is showing you the values from VistA.

Q:  On the patient list under Wards, there is no option to select surgical patients. I have various areas that are not showing up on that list (i.e., one of my CLC units; 3B Observation). How can I get this information?

A:  The Ward list will be populated as movements for those wards occur. It may be that no surgical patients had been picked up yet, and that existing patients hadn't been picked up by the overnight synchronizer because there weren't any qualifying movements.  This will be a common phenomenon when NUMI is first up and running. If you know you're missing someone, use the manual synchronizer (Sync With VistA) feature of NUMI, to get that patient’s information. If they are on the missing ward, that ward will also be added to the database. (See Chapter 7 in the User Guide for more information about using the Sync With VistA option).
This isn't a problem that you need to contact your Help Desk team about. It is just a one-time initial condition that can cause some confusion. It is very similar to the example of a long-term care patient who hasn't had a movement since NUMI started running, and doesn't show up in the database.

Q: Patient stays seem to be either disappearing from the Patient Selection screen or never appear.  What should I do?

A: You can always use the Sync with VistA option to restore them.  You might also want to check with other UM reviewers to find out what when and how they dismiss patient stays.  It is important to use filtering on the Patient Selection screen to make sure no one dismisses another reviewer’s stays.  It is also important to regularly dismiss stays that won’t be reviewed to clear up screen clutter and keep NUMI response time reasonable, so UM reviewers should have a procedure for regularly dismissing stays. If you aren’t seeing patients that you expect to see, check to see which filters are currently applied to your Patient Selection List. To see a complete list of the patient stays on the List, uncheck all of the filter boxes and click on the GO button at the top of the screen. This will generate a complete list of the patient stays at your facility. Another way to check for patient stays is to look at the Patient Stay Admin screen and see if the stay was invalidated because it [temporarily] couldn't be found in VistA. (Follow the instructions for restoring a stay, as described in Section 7.7.3 of the User Guide). 

Q: A patient was admitted and has been in the hospital for awhile, but does not appear on the Patient Selection screen. Why does this happen and what can I do?

A: The automatic midnight and hourly synchronization occasionally does not synchronize a patient movement, due to timing and network problems. Check CPRS, Gains and Losses (G&L) report, and ward rosters to identify any missing patients. Use the Sync With VistA feature to add a patient. Also, some patients may have been admitted prior to, and haven’t had a movement since, the inception of NUMI.
Q:  Does resynching with VistA overwrite NUMI data?

A: Resynching with VistA will always update the stay data, but review data will not be overwritten.
Q: A patient admission was on the G&L but does not appear in VistA as an inpatient.

A: The admission may have been removed from VistA or the hospital’s PIMS staff may be editing the movement record at the same time you are trying to access it.  Use the Synchronize with VistA option to select the patient and bring the data to NUMI.

Q: Is there a way to pull up data for Admitting Physician?

A: VistA patient movement data does not include Admitting Physician. In NUMI, you can enter the Admitting’s name in the Custom field on the Primary Review screen. (A source outside of NUMI will need to be consulted if you wish to find out who the Admitting Physician is).   
Working with Patient Stays:
Q: How can I tell who dismissed a patient?

A: The information will come up on the Dismissed Patient Select screen. You can get to this screen by selecting Dismissed Patient Select from the Tools Menu. (See Chapter 7 in the User Guide for more information about using the Dismissed Patient Selection option).

Q: Do you have any suggestions for how to go about finding and dismissing Discharged, Nursing Home, and Domiciliary patients?

A: Use the movement filter and only select Discharge to find patients that have been discharged. Before dismissing these patients, be sure they are up-to-date in their reviews. Filter by Domiciliary, Nursing Home, Observation, Rehabilitation, and Spinal Cord Injury wards to find patients that can be dismissed immediately. It is best to dismiss these patients every morning to keep the selection list small and improve response time.
Q: Physicians report receiving several notifications on the same stay for patients admitted Friday night.

A: It isn’t that the patient is showing up multiple times, it’s a notification for each day.  Every review that doesn’t meet criteria will go on the physician’s list.  It should be explained to the physicians that they do have to review them.

Q: I need to take over reviewing a patient stay that another reviewer had been working on, and this involves changing a review previously saved.

A: If it is appropriate to change a saved review, you can ask your site NUMI POC/Administrator to unlock it.  Any reviewer can unlock their own saved reviews, but not a review saved by another reviewer.

Working with Reviews:
Q: If one of my reviews is locked and I need to edit it, do I need to delete and restart everything?

A: No. You can unlock the review by selecting the Review Select option from the Tools Menu. Click the Reviewer dropdown and your name will appear in the list, by default.  Click the Find button and a list of your reviews will display. Click the VIEW hyperlink beside the review you wish to edit to open the review summary. Click the Unlock button. You can now edit the review. Remember to select the Final Save button when you are finished with the review. (See Chapter 9 in the User Guide for more information about Unlocking reviews).

Q: Is there a way to complete more than one review at a time in NUMI?

A: No. Only 1 review can be completed at a time. However, you can create consecutive reviews by using the Copy Review feature to copy a completed review multiple times [vs creating a new one from scratch each time]. (See Chapter 10 in the User Guide for more information about copying a Review).

Q: Can you clarify the Reason Codes?  What are my options?  

A: You will find the list of Admission and Continued Stay Reason Codes in Appendices D and E of the User guide, respectively.
Q: Do we need to review Observation Admissions?  If we remove them, will it negatively impact our report stats?

A: Observation Admissions do not need to be reviewed in NUMI at this time.  Your reports will not be impacted.
Q: I’m having trouble when trying to do a retrospective review because it’s hard to remember which days have been reviewed and which is next to be reviewed.

A: On the Primary Review screen, use the gold “Show Reviews” bar that you can click to show the reviews already done for that patient/stay. You can also click on the “View” link for each completed review to see its details in a pop-up window.
Q: Physician reviewers are saying they are spending too much time finding the review information.

A: The more descriptive the UM reviewer can be in their Reviewer Comment field, the easier it is for the physician.  You can enter up to 4000 characters that will appear on the physician review screen, and then the physician only needs to agree or disagree and do a final save to remove the patient from the worklist. (Physicians may find it useful to look at the CERMe criteria decision tree at the bottom of the screen).
Q: What can I do to decrease the time I spend entering reviews into NUMI?

A: First, stays that do not need reviews should always be dismissed each morning, if they have not been automatically dismissed by the system. Reviewers can use the Reviewer filter,  whenever possible.   When doing multiple reviews for the same patient, when not copying an existing review, go back to the History page rather than the Patient Selection page to save some of the longer load times in NUMI. You may prefer to use filters versus sorting. One recommendation is that you first check to see that you have all your patients on the Patient Selection list. If you are missing a patient or two, go to the Tools Menu, select Synch with VistA, and synchronize any missing patients before beginning your reviews for that day. This will cut down on the disruption of your workflow and ensure that you have all of your assigned patient stays.
Working with Reports:
Q:  On those reviews not meeting criteria AND not needing to be sent to a Physician UM Advisor (e.g., :  patient is in ICU, awaiting an acute care bed; or a placement problem), do they ultimately get recorded as “approved” or “not approved” if the box is checked?  For reporting purposes, how will they break out?

 A:  In NUMI, there is no “approved” or “not approved” category. All reviews that go to the physician UM advisor are returned as “Agree with the current level of care” OR “Disagree with the current level of care.” A patient review can be exempted from the physician review process through formal hospital policy. All patient reviews not meeting criteria that are automatically exempt are recorded in the NUMI database as Agree with the current level of care. These reviews will be included in all NUMI reports. 
Q: If data, such as Attending Physician, is corrected within NUMI, will the corrected value be used on NUMI reports?

A:  Yes. The next time you generate the reports they will reflect the correct Attending Physician’s name. These changes are NOT reflected in VistA, because NUMI has READ-ONLY access to VistA.

Working with Text Boxes:
Q:  How many characters can I type in the various text boxes in the NUMI application?

A: The maximum characters that can be typed into the various text boxes are listed below.

· Primary Review Screen

· If "Other" is selected from the Current Level of Care dropdown, users will be required to enter a description. The maximum # of characters allowed = 1,000

· If "Other" is selected from the Recommended Level of Care dropdown, users will be required to enter a description. The maximum # of characters allowed = 1,000

· The maximum # of characters allowed in the Comments field = 4,000

· The maximum # of characters allowed in the Custom field = 25

· Physician UM Advisor Worklist Screen

· If "Other" is selected from the Agree (with Current Level Of Care) dropdown, users will be required to enter a description. The maximum # of characters allowed = 1,999

· If "Other" is selected from the Disagree (with Current Level of Care) dropdown, users will be required to enter a description. The maximum # of characters allowed = 1,999

· Miscellaneous

If "Other" is selected from any other dropdowns (e.g.,  Stay Reasons), users will be required to enter an explanation. The maximum # of characters allowed = 500
Appendix G   - NUMI Review – Screens Encountered XE "NUMI Review – Screens Encountered" 
Figure 187 illustrates the major screens that are encountered when doing a review in NUMI.
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Figure 187: Screens Encountered during NUMI Reviews
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� A hyperlink is is a reference to a document or object that the reader can directly access by clicking on it.


� The NUMI Checkin ID (or “Stay” field on the History screen) is the internal record number in the VistA Patient Movement file #405, which is not visible to end users.
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